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PROGRAM LICENSE AGREEMENT 

 
IMPORTANT NOTICE: Please read the terms of the 

following license agreement carefully. You signify acceptance 

of the terms of this Agreement by using the product. 

 

 

This software is licensed only to the user (company or 

individual) whose name is registered with ENSOFT, INC., or to 

users at the registered location, on only one computer at a time.  

Additional installations of the software may be made by the 

user, as long as the number of installations is equal to the 

number of purchased and registered licenses. 

 

Users that purchased a network version of this software product 

are entitled to install the software on all computers in the 

network at their registered location.  However, the software can 

only be used simultaneously by as many users as the total 

number of purchased and registered licenses. 

 

The user is not entitled to copy this software unless copying for 

backup purposes.  The user may not loan, rent, lease, or transfer 

this software to any other person, company, or location. This 

software and documentation are copyrighted materials and 

should be treated like any other copyrighted material (e.g. a 

book or musical recording).  This software is protected by 

United States copyright law and the International Copyright 

Treaty. 
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Copyright ® 1987, 1994, 1996, 2000, 2003, 2006, 2010, 2012, 

2013, 2014, 2015, 2016, 2018, 2019, 2022 by ENSOFT, INC.  

All rights reserved. 

 

Printed in the Unites States of America.  Except as permitted 

under the United States Copyright Act of 1976, no part of this 

publication may be reproduced, translated, or distributed 

without the prior written approval of ENSOFT, INC. 

 

Although the program has been used with apparent success in 

many analyses, new information is developed continuously and 

new or updated versions may be written from time to time.  All 

users are requested to inform ENSOFT, INC.  immediately of 

any possible errors that are found in the coding.  As errors are 

detected, revised versions will be available for all who have 

purchased the program on the ENSOFT, INC website as a 

download. 

 

No warranty, expressed or implied, is offered on the accuracy 

of the results from the program.  The user relies on the program 

at his or her own risk.  The program should not be used for 

design unless caution is exercised in interpreting the results and 

independent calculations are available to verify the general 

correctness of the results.  The user is assumed to be 

knowledgeable of the information that is distributed with the 

digital media.  The user is assumed to recognize that the input 

parameters, e.g., soil properties, increment length, tolerance on 

solution convergence, and many others, can have a significant 

effect on the solution and must be chosen carefully.  The user 

should have a thorough understanding of the relevant 

theoretical criteria (appropriate references are suggested in the 

software documentation).  The information presented herein is 

not intended or represented to be suitable for direct use in 

engineering design without additional engineering evaluation. 
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FOREWORD 

 
 Analyzing a group of piles that support a cap or a structure in a system 

subjected to axial and lateral loading is an important problem in soil-structure 

interaction.  The piles may be of different sizes and may be installed vertically or 

on a batter.  The piles are assumed to be far enough apart so that there is no 

significant pile-soil-pile interaction or, if the piles are spaced closely together, such 

interaction is reflected by an appropriate modification of soil resistance curves. 

 Computer program GROUP allows the user to analyze the behavior of pile 

groups using either a 2-dimensional model or a 3-dimensional model.   

 The procedures for analyzing a single pile subjected to lateral loading are 

included in GROUP and the user should be familiar with that technology.  A 

complete discussion of the method of analysis of a single pile under lateral loading 

is given in the documentation for LPILE, another program distributed by ENSOFT, 

Inc. 
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1.1 General Description 
 

 GROUP has been well-received as a useful tool for analyzing the behavior of piles in a group 

subjected to both axial and lateral loadings.  The program was developed to compute the distribution of 

loads (vertical, lateral, and overturning moment) from the pile cap to individual piles in the group.  

GROUP v8.0 allows the user to analyze the behavior of pile groups using either a 2-dimensional model 

for piles in a symmetric layout or a 3-dimensional model for a group of piles that is not symmetrically 

arranged. 

 The piles may be installed vertically or on a batter, and their heads may be fixed, pinned, or 

elastically restrained by the pile cap.  The cap is assumed to act as a rigid body, and may settle, translate, 

and rotate. 

 The program will internally generate the nonlinear response of the soil, in the form of t-z and q-

w curves for axial loading, t-r curves for torsional loading, and p-y curves for lateral loading.  An iterative 

solution accommodates the nonlinear response of each of the piles, and will satisfy the equations of 

equilibrium.  This achieves compatibility between pile movement and soil response, and between cap 

and pile-head movement. 

 For the lateral analysis of piles, second order effects due to the axial load are included in the 

formulation, so the P-delta effects are considered automatically by the program. 

 

1.2 Program Features and Version History 

1.2.1 GROUP 1.0 (1987) 

 

 The first version of GROUP internally generated the nonlinear response of the soil in the form of 

p-y curves for soft clay, stiff clay with or without free water, and sand.  The user was also allowed to 

input externally generated p-y curves.  The relationship between vertical load and pile settlement (or 

uplift) had to be externally specified by the user. 

 

1.2.2 GROUP 2.0 (1990) 

 

 The second version of GROUP included a number of additional, user-friendly features.  The main 

improvements were on the input and graphics modules.  The input module introduced the use of pull-

down menus and grid cells for data entry.  The graphics module provided enhanced plots for pile 

deflection, bending moment, shear, and soil resistance. 
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 A subroutine was added to the main program to allow the implementation of the t-z method to 

solve for the settlement (or uplift) of a pile, based on soil properties and pile geometry.  The user was 

able to specify that the program internally generate the settlement of a pile as a function of axial load 

based on nonlinear load transfer in skin friction and end bearing, which in turn may vary as a function of 

distance below the ground surface. 

 

1.2.3 GROUP 3.0 (1994) 

 

 The third version of GROUP featured more computational options. 

• The user was provided with updated technical information on group-reduction factors for piles 

under lateral loads.  If the user wished to account for pile-soil-pile interaction, the program 

could optionally generate p-multipliers to automatically reduce soil resistance. 

• The new version provided data for evaluating pile-cap stiffness levels, which are often used in 

structural engineering models.  Under this new option, the program created curves of 

incremental loading versus pile-cap movements and rotations.  A conceptual modeling 

application for the analysis of the behavior of a bridge is shown in Figure 1.1.  With curves 

similar to the one shown in Figure 1.1c, the user was able to specify pile-cap stiffness levels 

corresponding to a given range of loading for their models of structural analyses. 

• GROUP 3.0 could accommodate up to 50 rows of piles in each group analysis, compared to only 

20 rows in previous versions of the program.   

• Also, the input-editing module was improved to handle more data points and soil layers.   

• New example problems were presented, including one for the special case where the pile cap is 

installed below the ground surface. 
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Figure 1.1  Example of modeling a bridge on piles 
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1.2.4 GROUP 4.0 (1996) 

  

 The fourth version of GROUP featured a major upgrade for compatibility with new operating-

systems, enhancements in ease of use, and new technical and computational features.   

• Standard Windows operations, such as dialog boxes, grid cells, clickable buttons, drop-down list 

of options, and pull-down submenus were all incorporated to ease data entry. 

• Improved file-management features were included to help the user during program execution.  

A standard single-program module was introduced for data input, program execution, graphical 

observation of output-data curves, and optional direct viewing of input or output text files.   

• The online help file was also enhanced and could be loaded during preparation of input data for 

quick consultation of main operational features and basic technical recommendations. 

• The graphical observation of output curves featured a new interface that allowed the user to 

zoom into areas of particular interest.  The user may thus observe the detailed behavioral 

measurements of any portion of the depth of each pile group. 

• Three additional p-y criteria were added to the previously existing four soil types.  New soil 

criteria are available for c- soils, the sand model recommended by the American Petroleum 

Institute (API), and rock. 

• A new option that takes into account the lateral soil resistance against embedded pile caps was 

introduced.  The theory and specific assumptions utilized for the computation of lateral soil 

resistance on embedded pile caps were included in the new Technical Manual. 

• The user was also provided with the option to specify a reduction factor on the axial capacity of 

closely-spaced piles. 

 

1.2.5 GROUP 5.0 (2000) 

 

 The fifth version of GROUP was introduced in October, 2000, and included a new computation 

module for 3-dimensional pile-group analyses.   

• GROUP v5.0 allowed the user to analyze the behavior of pile groups using either a 2 or 3-

dimensional model.  The 2-dimensional model is sufficient and convenient if the piles are 

arranged symmetrically to the applied load.  Otherwise, a 3-dimensional model is recommended 

for analyzing the nonlinear behavior of pile groups.   

• GROUP v5.0 solves the nonlinear response of each pile under six components of loadings and 

assures compatibility of geometry and equilibrium of forces between the applied external loads 

and the reactions of each pile head. 

• Torsional resistance curves could be generated by the program. 
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1.2.6 GROUP 6.0 (2003) 

 

 The sixth version of GROUP was introduced in January, 2003.  The new features for the sixth 

version are summarized below: 

• The program allowed for up to 500 piles in a group, and each pile could have different EI values 

in orthogonal directions. 

• GROUP v6.0 considered the nonlinear bending stiffness (EI) of each pile during computation.  

The user can enter nonlinear moment-curvature curves under different axial loads for each pile. 

• For closely-spaced piles, the pile-soil-pile interaction can be taken into account by introducing 

reduction factors for the p-y curves used for each single pile.  These factors were modified based 

on a study by Reese and Van Impe (2001).   

GROUP v6.0 included advanced 3-dimensional graphics to represent the response of each pile in 

the group.  The user has options that allow for the display of the deformed/undeformed shape 

of pile groups, stress contours, soil layers, and many others.   

 

1.2.7 GROUP 7.0 (2006)  

 

 The seventh version of GROUP was introduced in February, 2006.  The new features for the 

seventh version are summarized below: 

• The p-y criteria for liquefiable sand developed by Rollins, et al.  (2003), and p-y criteria for stiff 

clay with user-specified initial k values, recommended by Brown (2002), were added in Version 

7.0. 

• The program requires data for unit side friction at the top and bottom of each layer as well as 

the unit tip resistance for generating the axial stiffness (axial load-displacement relationship) at 

the pile head.  Version 7.0 internally provided the estimated unit side friction and tip resistance 

based on the strength data of soil layers and commonly accepted empirical equations.  

However, the program still allowed those data specified externally for the user to control the 

axial capacity of piles based on the local recommendations. 

• Version 7.0 generated more types of graphs than previous versions.  More importantly, the 

program plots the force and displacement on the pile cap, such as the axial force (tension and 

compression) of each pile on the pile cap, the lateral forces (shear and moment) of each pile on 

the pile cap, and the displacement of the pile cap in different directions. 

• The program provided a summary table of output data, which is convenient when the size of the 

output file becomes very large due to a large number of piles in the application. 

• The program implemented a new algorithm that significantly improved the nonlinear iterations 

and accuracy of the solution. 
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1.2.8 GROUP 8.0 (2010) 

 

 This is the eight version of GROUP.  The new features are summarized below: 

• The program allows for a maximum of 2000 piles in a group. 

• A New from Template option has been added, so the program can easily generate basic 

rectangular or circular pile group layouts. 

• The program includes various additional options for loading.   

o The program allows the user to perform analyses under various load cases.  Each load 

case may be due to concentrated loads at the pile cap and/or distributed lateral loads at 

the piles. 

o Concentrated loads at the pile cap may be defined for any position; the program will 

compute the equivalent concentrated load at the origin for analyses. 

o  Distributed lateral loads at the piles can be defined relative to the local axes as well as 

the global axes.  For loads oriented at the global axes in batter piles, the axial 

component may be included as a concentrated load at the pile head. 

o The program allows the user to perform analyses under various load combinations.  

Load combinations are set by load factors applied at the load cases previously defined 

by the user. 

o Maximum and minimum envelopes may be computed for both load cases and load 

combinations. 

o The program includes the option to compute both the Flexibility and Stiffness Matrix for 

different levels of loading. 

• A Cross Section dialog was included to allow the user the option to define circular, rectangular 

and I sections. However, for noncircular sections the equivalent diameter must be defined by 

the user. 

• The program will be able to transform a 2D pile layout into a 3D layout.  The program can also 

convert a 3D pile layout into a 2D layout; however, this conversion may not be accurate for non-

symmetrical configurations. 

• Inputs for soil properties have been rearranged to allow the user enter the information by soil 

type. 

• The program allows a mix of input defined curves (p-y curves, axial load-displacement curves 

and torque-rotation curves) and automatically generated curves in the same model. 

• The program provides a summary table of output data, which includes maximum and minimum 

effects for pile heads over the pile length. 

• User can select the information to be printed, which is convenient when the size of the output 

file becomes very large due to a large number of piles and load cases. 
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1.2.9 GROUP 2013 (2013) 

 

 Group is now released under maintenance contract. All users with active maintenance contracts 

can download all program updates and revisions from the Ensoft website (www.ensoftinc.com) without 

additional charges. Thus, users are no longer purchasing version updates to the program. Instead, they 

are purchasing extensions to their maintenance contracts. This make using traditional version numbers 

no longer necessary. 

 The version numbers now used for GROUP has three parts that indicate the year of the release, 

the data file format version number, and the revision number. The meaning of the versions numbers is 

described below. 

• The first number refers to the year of the program that indicates the features of the program. 

• The second number is the data file version number that is changed whenever there is a change 

in the data file format. 

• The third number indicates the revision number. The revision number is incremented for every 

update of the program or documentation. 

 

 The new features for release GROUP are summarized below: 

• Estimation of an equivalent elastic stiffness matrix.  

• Include analysis due to lateral soil movement. 

• Include option to define reduction factors for lateral loading along depth. 

• Estimate the axial displacement and axial forces along piles. This option is not available when 

user defined axial load displacement curve is used. 

• Compute the displacements in global directions. 

• Option to define a tapered section along depth 

• Option to change the modulus of elasticity along depth 

 

 

1.2.10 GROUP 2014 (2014) 

 

 The new features for release GROUP are summarized below: 

• Import moment curvature generated for LPILE program. 

• Import p-y curves generated for LPILE program. 

• Add two soil models, API Soft Clay with variable J and Elastic Subgrade. 

• Revise input units for various parameters, i.e., depth, specific weight, section dimensions. 

• Help the user to estimate some soil parameters, i.e., e50, k. 
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• Add an option to analyze a case specifying displacements at the pile cap level. The user may 

combine specifying displacements and applied forces in different degree of freedoms. 

• Add tool buttons to navigate through load cases and combinations. 

• Use of parallel processing, so the program can perform the analysis using more than one 

processor that may reduce the analysis time. 

 

 

 

1.2.11 GROUP 2016 (2016) 

 

 The new features for release GROUP are summarized below: 

• Compute Nonlinear Bending Stiffness for various sections. 

• Enhance program to use negative vertical coordinates for pile heads. 

• Enhance program so the ground line can start at any soil layer. 

• Add an option to use vertical projection while using batter piles. 

• Add an option to calculate reduction factors for lateral loading based on average diameter. 

• Allow the rotation of the section respect to the x axis. 

• Add option to draw pile caps of irregular shape. 

• Add option to shift piles and soil layers in vertical direction. 

• Add option to color piles based on pile properties and cross sections 

• Add option to export plots to Excel 

• Add option to import/export pile group layout and loading to Excel 

 

 

 

 

1.2.12 GROUP 2019 (2019) 

 

 The new features for release GROUP are summarized below: 

• Add option to perform incremental/pushover analysis for a load case. 

• Add option to compute or not layering correction. 

• Add option for the analysis of embedded pile caps using nonlinear springs. 

• Add option to consider non-symmetric sections for the estimation of nonlinear bending 

stiffness. 

• Add option to import soil layers generated by EnCPT. 

• Enhance estimation of load displacement curves. 

• Enhance program so the pile head can start at any soil layer. 
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1.2.13 GROUP 2022 (2022) 

 

 The new features for release GROUP are summarized below: 

• Add soil model: Liquified Sand Hybrid, Piedmont Residual, Massive Rock, Loess. 

• Add option to consider a flexible pile cap. The flexible pile cap is modeled using plate elements 

and/or beam elements. 

 

 

1.3 Technical Support 
 

 Although GROUP was designed to be distinguished by its ease of use, some users may still have 

questions.  The ENSOFT technical staff strongly encourages users to utilize electronic means of support 

via email or fax: 

• electronic mail to: support@ensoftinc.com 

• fax to: (512) 244-6067 

 

In any support request, please include the following information: 

• Software version (obtained from the Help/About menu) 

• Description of the problem 

• Copy, file attachment, or printout of the input-data file 

• Name, fax, and telephone number of the contact person and of the registered user (or name 

and office location of the registered company) 

Although immediate answers are offered on most technical support requests, please allow up to two 

business days for a response in case of difficulties or scheduling conflicts. 

 

1.3.1 Support by Telephone 

 

 Technical help by means of direct calls to our local telephone number (512-244-6464) is 

available, but limited.  The current policy of ENSOFT is that all telephone calls for software support will 

be answered free of charge for the first 10 minutes of each call if the user has a current maintenance for 

mailto:support@ensoftinc.com
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the latest version of GROUP.  A charge of $1.50 per minute comes into effect for every additional minute 

after the initial 10 minutes.  Applicable charges will be billed to the user.   

 Telephone support will be provided free of charge for a period of three months after the first 

software-support call has been made.  The charge of $1.50 per minute comes into effect after the free 

support period. 

 Software support by any of the preferred methods (email or fax) is free for all users that have 

licenses with current maintenance for the latest version of GROUP. 

 

 

1.3.2 Upgrade Notifications and Internet Site 

 

 All registered users who keep their address current at ENSOFT will receive notifications by 

regular mail when new versions become available.  Users may also consult our internet site 

(www.ensoftinc.com) for additional information on software updates, demos, new applications, 

technical news, and company information. 

 Many times, software updates are placed at our internet site and available for free to all 

registered users.  New software updates are notified by electronic mail to users that voluntarily 

subscribe to our users email list. Please note that users must have a current maintenance in order to run 

the latest update available. 

1.3.3 Software Customization Services 

 

 Customized versions of GROUP may also be designed with a contractual agreement for the costs 

of additional programming.  ENSOFT uses modern computational techniques and broad experience to 

obtain fast and reliable results to engineering problems. 

 

1.3.4 Changes to Support Policy 

 

 The software support policy and associated expenses are subject to change at ENSOFT’s 

discretion and without specific mailed notices to the users.  However, any change of rules will be 

verbally provided during telephone calls for software support. 

 

http://www.ensoftinc.com/
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2.1 Installation Procedures 
 

 GROUP 2022 is distributed with a hardware lock.  The hardware lock is a device (USB dongle) 

that is attached to the USB port of the computer in use.  This method of distribution is compatible with 

existing operating systems, has better stability than other alternatives, and allows users to obtain 

software updates or replacements via internet download. 

 Before installing, your computer should be equipped with the following: 

• An open USB port 

• At least 200 MB of free space 

• At least 4GB of memory 

• Windows 7 or later 

 

 

Figure 2.1  Selection of Type of License during installation of the program 

 

 To install GROUP 2022: 

• Insert the installation CD.  If Autoplay is enabled, Windows will ask if the user wants to run 

setup.exe.  If the user does not have that feature enabled, then from My Computer double 

click the drive into which the installation CD is inserted.   

• Select to install GROUP 2022, and then click on the “Install Standard” button at the bottom 

of the window. 

• Follow the on screen instructions until the window shown above is reached. 
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2.1.1 Single User License 

 

 If your license is for a single-user, select the "Single-User License" option and click Next.  Follow 

the dialog boxes until the installation finishes.  After the installation is completed, insert the black USB 

dongle into any USB port and follow USB driver installation if it shows up.  In some cases, the user may 

be requested to restart Windows before executing the program. 

 

2.1.2 Network License 

 

 If a network license is being installed, select the "Network License" option and click Next.  At the 

following window, select the type of network installation that is being installed.   

 

Figure 2.2  Selection of Type of Network Installation 

 

2.1.2.1 Installation to a Server 

 

 The "Software Server" is known as the computer that will be carrying the network lock provided 

by ENSOFT, INC.  The software server is not necessarily the same as the existing network server.  Any 

computer in the existing Windows network may be designated "Software Server" for GROUP, as long as 

the network lock is attached to the USB port and the “server” version is installed in its hard drive.   
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 To install, select the "Software Server" option and click Next.  Follow the dialog boxes until the 

installation finishes.  Be sure to point to the Unique Company File provided by ENSOFT, INC when 

requested. 

 After the installation is completed, insert the black USB dongle into any USB port and follow the 

Windows automatic USB driver installation if it appears.  In general, this installation should be 

performed by the network administrator. 

 

2.1.2.2 Installation to Clients 

 

 "Client Computers" may be all other computers on the network that have the program installed 

as clients.  Client Computers do not need a USB dongle.  "Client" installations will be allowed to run as 

long as the IP address of the client is within the IP range defined for the company network and the 

network service is running on the "server". 

 To install, select the "Client Computer" option and click Next.  Follow the dialog boxes until the 

installation finishes.  Be sure to set the IP address of the "server" when requested.  In some cases, the 

user may be requested to restart Windows after installation is complete. 

 

2.2 Software Updates 
 

 Occasionally, ENSOFT will produce software improvements and/or fixes.  Software users may 

freely download the latest updates from the following site (Please note that users must have a current 

maintenance in order to run the latest update available): 

http://www.ensoftinc.com 

 Download the update files to an appropriate local directory, then run the executable.  Follow 

the on-screen instructions until installation is complete. 

 

2.3 Versions Available 
 

 GROUP 2022 has two versions the Standard Version and the Flexible Cap Version. The Flexible 

Cap Version includes all the options available in the Standard Version plus the option to model the Pile 

Cap as a Flexible Cap using Plate Elements and/or Beam Elements.  

 

http://www.ensoftinc.com/
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2.4 Getting Started 
 

 A general diagram showing the menu choices and operational flow chart of program GROUP 

2022 is presented in Figure 2.3.  The following paragraphs provide a short description on the operational 

features of GROUP 2022 and should quickly enable the user to get started with the program. 
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Figure 2.3  Sample organizational and operational flow chart 

Double click the icon 

GROUP 2022 

in the GROUP folder. 
 

File Menu 
Open an existing data file or 

begin a new blank file. 

Data Menu 
Input required data of soil and pile 

properties, loading, and pile geometry.  

Start from the top submenu and continue 

with each immediately inferior option. 

Help Menu 
References to most program 

parameters can be directly 

accessed through the online 

help menu. 

View Menu 
Observe general plan and 

three-dimensional views of 

the foundation model and 

surrounding soil. 

Options Menu 
Select various parametric variables that will be used in 

the run, such as system of units, generation of curves, 

load-reduction factors, printing of p-y curves, limits of 

tolerances, and iterations. 

Computation Menu 
Once finished with the data input, the Run 

Analysis submenu performs the necessary 

computations.  Several other choices of submenus 

become available upon the completion of a 

successful run.  This menu also contains options 

for observing the plain text input, output and 

processing run files created by the program 

Graphics Menu 
Select plot to be displayed. 

Plot Menu 
Set parameters to plot being 

displayed. 

3D View Menu 
Display results graphically 
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2.4.1 Program Start 

 Double click the GROUP 2022 icon to start: .  When the program runs for the first time, 

users have the opportunity to personalize the program.  This information is printed in all the output files 

generated by the program.   

 

 

        

Figure 2.4  Window to personalize the program 

 

 

When the program runs for the first time, the program shows the Check for Updates Window 

      

Figure 2.5  Check for Updates Window 
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 This window also shows up when the user checks the item: Checks for Updates as the Program 

Starts under the Options Menu, or the Option Check for Updates as the program starts is still checked 

in the Check for Updates Window. By clicking on yes, the program will open an internet website window 

to check in the ENSOFT website if there is a new update available. After closing this window, the GROUP 

2022 Window will show up 

 

 A blank workspace with a toolbar at the top will appear.  As a standard Windows feature, 

pressing Alt displays the menu operations with underlined letters.  Pressing the underlined letter after 

pressing Alt is the same as clicking the operation.  For example, to open a New File, the user could press 

Alt, F, N, in sequence, Ctrl+N, or click File then New.  Additionally, holding the mouse cursor over an icon 

displays the function of the icon. 

 

 

 

Figure 2.6  Starting window 
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2.4.2 File  

 

 This menu contains the following submenus.  The choices are listed below, along with a general 

description of their use. 

 

 

Figure 2.7  Options contained in the File Menu (includes 3D View options) 

 

• New : Create a new data file. This opens up a blank workspace and closes the current project. 

• New from Template...  : Create a new data file for a rectangular or circular pile group configuration. 

• Open… : Open an existing data file. Closes the current project.  

• Save : Save input data under the current file name.   

• Save As… : Save input data under a different file name.  This option allows the user to save any 

opened or new input data file under a different file name or in a different directory.  Any input data 

file saved under an existing file name will replace the contents of the existing file. 

• Exit : Exit the program.  This is selected to exit GROUP 2022.  Any input data file that was modified 

and not yet saved to disk will produce a confirmation window before exiting the program. 

• A list of recently opened files is displayed in between Save As… and Exit.  By clicking on the menu 

item, the program will open the file. 

If the 3D View window is active three additional options appear. 

o Save Bitmap (3D View)...  : Save the current view as a .bmp file. 

o Page Setup (3D View)...  : Printing options. 

o Print (3D View)...  :Print the current view. 
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Several additional files are created in every new GROUP 2022 project.  A general description of 

these files is presented in Table 2.1.  These files will be created in the same folder as the input file.  

Any of these files may be opened with standard text editors or word-processing programs. 

 

File Name 
Extension 

File 
Description 

Example 
File 

*.gp12d Input Data file example.gp12d 

*.gp12e Echo Print Data file example.gp12e 

*.gp12o Output Results file example.gp12o 

*.gp12p Plot Results file example.gp12p 

*.gp12r Processor Notes file example.gp12r 

*.gp12t Summary Results file example.gp12t 

 

Table 2.1  Files created in GROUP 2022 runs 

 

 

2.4.3 Data 

 

 This menu contains several submenu choices as shown in Figure 2.8. The data menu for the 

Flexible Cap Version is shown in Figure 2.9. The choices are listed below, along with a general 

description of their use. 
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Figure 2.8  Options contained in the Data Menu 
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Figure 2.9  Options contained in the Data Menu – Flexible Cap Version 

 

• Title : Input a single line of text with a general description of the project. 

• Pile Cross Sections : Define the cross sections of the piles. 

• Pile Properties : Specify material and dimensions for each pile type included in the different 

subgroups. 

• Pile Group Properties : Specify attributes for pile subgroups. 
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• Pile Head Coordinates : Specify coordinates for the pile heads, as well as batter angles for the pile 

subgroups. 

• Loading : Define load cases. 

• Pile-Cap Options : Input the dimensions of the pile cap (Not available for the Flexible Cap Version). 

• Soil Layers : Input the soil layers and associated soil properties. 

• Sets of Soil-Resistance (p-y) Curves : An optional input that is disabled, as a default, for all new runs.  

It becomes available if the user chooses to input p-y curves to describe lateral behavior of soils (to 

do this, the user must check the item Enter User-Defined Soil Resistance (p-y) curves under the 

Options menu).  Then the user can input data for specific p-y curves that represent the lateral 

behavior of the soil. 

• Sets of Axial Load-Displacement Curves : An optional input that is disabled by default.  Available if 

the user chooses to input specific curves that describe the axial behavior of all pile subgroups (to do 

this the user must check the item Enter User-Defined Load Displacement Curves under the Options 

menu).   

• Sets of Torque-Rotation Curves : An optional input that is disabled by default for all new runs.  

Available if the user chooses to input curves to describe the torsional behavior of all pile subgroups 

(to do this the user must check the item Enter User-Defined Torque Rotation curves under the 

Options menu).   

• Sets of Red. Fact. Lateral Load along Depth : An optional input that is disabled by default.  Available 

if the user chooses to input reduction factors for lateral load along depth (to do this the user must 

check the item Reduction Factors for Lateral Load Along Depth under the Options menu).   

• Sets of Nonlinear EI : This submenu is used to input specific curves that describe the nonlinear 

bending behavior of pile sections, i.e. moment curvature. This submenu is enabled if user defined 

moment curvature is assigned to any load case. 

• Sets Lateral Soil Movements Data : This submenu is used to input the data for soil movement as a 

function of depth. This submenu is enabled if soil movement data is assigned to any load case. 

• Sets of Distributed Lateral Loads : This submenu is used to input the data for distributed lateral 

loads in piles as a function of depth.  The unit of the distributed load is force per unit length.  The 

effect of the width of each pile should be taken into account in the data. This submenu is enabled if 

distributed lateral load is assigned to any load case. 

• Sets of Data to Print generated p-y Curves : An optional input that is disabled by default.  Available 

if the user chooses to print p-y curves for different pile subgroups and soil depths (to do this the 

user must check the item Print Generated p-y Curves under the Options menu).   

• Import Soil Layers from EnCPT Soil File : This submenu is used to import soil layering data generated 

by the EnCPT program. 

• Import Soil and Section Data from LPILE Model : This submenu is used to import soil layering data 

and/or cross sections data from a LPILE model (v2015/2016/2018/2019). 

• Import p-y Curves Generated by LPILE : An optional input that is disabled, as a default, for all new 

runs. It becomes available if the user chooses to input p-y curves to describe lateral behavior of soils 

(to do this, the user must check the item Enter User-Defined Soil Resistance (p-y) curves under the 
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Options menu). Then the user can import specific p-y curves that represent the lateral behavior of 

the soil that were generated by the program LPILE (v2012/2013/2015/2016/2018/2019). 

• Import Nonlinear EI Data Generated by LPILE : This submenu is used to import specific curves that 

describe the nonlinear bending behavior of pile sections, i.e. moment curvature, that were 

generated by the program LPILE (v2012/2013/2015/2016/2018/2019). 

• Import Group Layout from Excel File : This submenu is used to import a group layout from an Excel 

File. User should prepare the Excel File following the template to avoid problems while importing 

the file. 

• Import Loading from Excel File : This submenu is used to import loading from an Excel File. User 

should prepare the Excel File following the template to avoid problems while importing the file. 

• Export Group Layout to Excel File : This submenu is used to export the group layout to an Excel File. 

User may use this option to create a basic template in order to define more complicated group 

layouts. 

• Export Loading to Excel File : This submenu is used to export loading to an Excel File. User may use 

this option to create a basic template in order to define more complicated loading. 

 

 For the Flexible Cap Version the following options are included: 

• Node Data (Pile-Cap) : This submenu is used to define node data for the nodes that belong to the 

flexible cap. It includes the Node Coordinates option. 

• Node Coordinates : This submenu is used to define and or edit the node coordinates that belong to 

the flexible cap. 

• Plate Data (Pile-Cap) : This submenu is used to define plate data for the plates that belong to the 

flexible cap. It includes the Plate Connectivity, Plate Offsets and Plate Sections options. 

• Plate Connectivity : This submenu is used to define and or edit the element connectivity for the 

plate elements that belong to the flexible cap. 

• Plate Offsets: This submenu is used to define and or edit plate offsets of plate elements that belong 

to the flexible cap. 

• Plate Sections: This submenu is used to define and or edit the geometric and material properties of 

the plates that belong to the flexible cap. 

• Beam Data (Pile-Cap) : This submenu is used to define beam data for the beams that belong to the 

flexible cap. It includes the Beam Connectivity, Beam Offsets, Beam End Rigid Zones and Beam 

Section Rotation options. 

• Beam Connectivity : This submenu is used to define and or edit the element connectivity for the 

beam elements that belong to the flexible cap. 

• Beam Offsets : This submenu is used to define and or edit plate offsets of beam elements that 

belong to the flexible cap. 

• Beam End Rigid Zones : This submenu is used to define and or end rigid zones of beam elements 

that belong to the flexible cap. 

• Beam Section Rotation: This submenu is used to define and or edit section rotation angles of beam 

elements that belong to the flexible cap. 
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• Springs (Pile-Cap) : This submenu is used to define springs for the elememts that belong to the 

flexible cap. It includes the Concentrated Spring at Nodes, Distributed Springs at Plates and 

Distributed Springs at Beams options. 

• Concentrated Springs at Nodes: This submenu is used to define and or edit concentrated springs 

applied at the nodes. 

• Distributed Springs at Plates : This submenu is used to define and or edituniform distributed springs 

applied at plates. 

• Distributed Springs at Beams : This submenu is used to define and or edit uniform distributed 

springs applied at beams. 

 

 

2.4.4 Edit  

 

 This menu is used to graphically edit the pile group layout. 

 

  

Figure 2.10  Options contained in the Edit Menu (3D View Active) 
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• Figure 2.11  Options contained in the Edit Menu (3D View Active) – Flexible Cap Version 

 

• Check Duplicate Piles : By clicking on this option the program will check to see if two or more piles 

have the same coordinates and properties.  If a duplicate pile(s) is found, the program will ask if the 

user wants to delete the duplicate pile(s). This is the only option active in 2D mode. 

• Select Piles : In this mode piles can be selected graphically. 

• Pause Select : This option is to pause the selection, in order to change the view by translating, 

zooming and/or rotating.  

• Add Pile : Add a new pile into the model. 

• Pile Layout :  Review or edit existing pile information. 

• Delete Pile(s) : Delete the selected pile. 

• Move Pile(s) :Translate the selected piles. 

• Copy Pile(s) : Copy the selected pile's information to the clipboard. 

• Paste: Paste the piles already in the clipboard. 

• Paste Array : Paste selected piles in the clipboard using a rectangular or circular pattern. 

• Pile Sets : This option is useful to define pile sets than can be used later to apply loads and/or 

boundary conditions. 

 

 For the Flexible Cap Version the following options are included: 

• Select mode : In this option all the objects (piles, plates, beams and/or nodes) that belong to the 

model can be selected graphically.  

• Select Plates : In this mode the plates that belong to the flexible cap can be selected graphically.  

• Select Beams : In this mode the beams that belong to the flexible cap can be selected graphically.  

• Select Nodes : In this mode the nodes that belong to the flexible cap can be selected graphically.  

• Add Plate : Add a new plate into the model. 

• Edit Plate(s) : Edit the connectivity, offsets and material properties index of a plate or plates. 

• Delete Plate(s) : Delete selected plate(s). 

• Divide Plate(s) : Divide selected plate(s). 

• Add Beam : Add a new beam into the model. 

• Edit Beam(s) : Edit the connectivity, offsets, rigid end zones and section index of a beam or beams. 

• Delete Beam(s) : Delete selected beam(s). 

• Divide Beam(s) : Divide selected beam(s). 

• Add Node : Add a new node into the model. 

• Edit Node(s) : Edit the coordinates of a node or nodes. 

• Delete Node(s) : Delete selected node(s). 

• Delete Unconnected Node(s) : Delete the nodes that are not connected to a plate and/or beam. 

• Move All Selected : Move all objects selected: piles, plates, beams and/or nodes. 

• Copy All Selected : Copy all objects selected: piles, plates, beams and/or nodes. 

• Delete All Selected : Delete all objects selected: piles, plates, beams and/or nodes. 
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• Plate Sets : This option is useful to define plate sets than can be used later to apply loads and/or 

boundary conditions. 

• Beam Sets : This option is useful to define beam sets than can be used later to apply loads and/or 

boundary conditions. 

• Node Sets : This option is useful to define node sets than can be used later to apply loads and/or 

boundary conditions. 
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2.4.5 Options 

 

 This menu controls several program variables and preferences and is shown below.   

 

   

     

Figure 2.12  Options contained in the Options Menu 
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Figure 2.13  Options contained in the Options Menu – Flexible Cap Version 
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• Units : This option allows the user to select either English Units, using pounds(lbs), and inches(in) or 

SI Units, using kilonewtons (kN), and meters (m).  English units are enabled by default.  Whenever 

the user changes the units of measurement, previously inputted values will be automatically 

converted to the new units. 

• Use Kips as Unit of Force : This option allows the user to define Kips instead of pounds for units of 

loading while using English Units.  Whenever the user changes the units of measurement, previously 

inputted values will be automatically converted to the new units. 

• Analysis Mode : This option is used to specify analysis based on either a two-dimensional (2D) or 

three-dimensional model (3D).  

• Adjust Depth for Batter Piles : By selecting this option the program will adjust the depth for 

estimation of p-y curves, t-z and Q-w curves in batter piles. If the option if not selected, the program 

will use the length (as previous versions of GROUP). 

• Generate Axial L-D (and T-R) curves on Soil Profile : By selecting this option the program will 

generate the axial load versus displacement curves (as well as the torque versus rotation curves) 

considering the soil profile and the batter angle. If the option if not selected, the program will 

generate one curve per pile property (as previous versions of GROUP). 

• Extend Interpolation for L-D (and T-R) curves : By selecting this option the program will extend the 

interpolation of the L-D (and T-R curves) towards the maximum defined. The program will use the 

value of load (torque) corresponding the to the maximum displacement (rotation) if the 

displacement (rotation) is larger than the maximum defined. The program will use the value of load 

(torque) corresponding the to the minimum displacement (rotation) if the displacement (rotation) is 

smaller than the minimum defined. If this option is not checked the program will use a value of zero 

in those events (as previous versions of GROUP). 

• Use Layering Correction (Method of Georgiadis) : By selecting this option the program will use 

layering correction. By unchecking this option, the program will not use a layering correction, so the 

equivalent depth of each layer will be equal to actual depth of the layer. 

• Do not Compute Layering Correction if Soil Above is of Same Type : By selecting this option the 

program will not estimate layering correction if soil above of current layer is of same material. 

• Modify Group Layout using Template : Create a new pile configuration for rectangular or circular 

pile groups. 

• Shift Piles and Soil Elevations : This option allows the user to move vertically the piles and/or the 

soil layers. 

• Enter User-Defined Soil-Resistance (p-y) Curves : By selecting this option, the user is able to enter 

curves that define the lateral behavior of soils in the item Sets of Soil-Resistance (p-y) Curves under 

the Data menu. 

• Enter User-Defined Load-Displacement Curves :  By selecting this option, the user is able to enter 

curves that define the axial behavior of piles in the item Sets of Axial Load-Displacement Curves 

under the Data menu. 

• Enter User-Defined Torque-Rotation Curves : By selecting this option, the user is able to enter 

curves that define the torsional behavior of piles in the item Sets of Torque-Rotation Curves under 

the Data menu.   
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• Consider Non-Symmetric Sections for Nonlinear EI : By selecting this option, the program will be 

able to estimate nonlinear bending stiffness for non-symmetric sections. By unchecking this option, 

the program will be able to consider only symmetric sections for the estimation of nonlinear 

bending stiffness.   

• Reduction Factors for Lateral Loads : This option controls the method to be used for computing 

lateral-load reduction factors to account for closely-spaced piles.  The submenu options are: 

o Automatically Generate : Reduction factors will be internally generated by the program 

based on data input.   

o Specify : Reduction factors will be specified by the user in the Pile Properties Window. 

o Ignore Effects : The effect due to closely-spaced piles will be ignored. 

• Reduction Factors for Lateral Load Along Depth : By selecting this option, the user is able to enter 

the curves that define the reduction factors for lateral load along depth in the item Sets of Red. 

Fact. Lateral Load along Depth under the Data menu.   

• Reduction Factors for Axial Loads : This option allows the user to input a reduction factor for pile 

axial capacity in order to account for closely-spaced piles. 

• Print Generated p-y Curves : Activates Sets of Data to Print p-y Curves under the Data menu. 

• Default Control Options…: This option allows the user to set the default values for analysis 

parameters. 

• Default Output Variables…: This option allows the user to set default variables along the pile to be 

printed in the output file. 

• Text Editor Options…: This option allows the user to set the preferred text editor or word processor.  

As a default, the "c:\windows\notepad.exe" is used to set Microsoft Notepad as the default text 

editor.   

• Check for Updates as the Program Starts : Instructs GROUP to check the Ensoft website for software 

updates when the program starts.  An active internet connection is required. 

• Include Load Case/Comb.  Number on Graphs : This option allows the user to include the load case 

or combination number in the result graphs. 

• Limit Active Curves on Graphs (20) : This option allows the user to limit the number of curves 

displayed in the graphs to 20. 

 

 For the Flexible Cap Version, the following options are included: 

• Pile-Cap Type : This option allows the user to select the model for the pile cap either rigid or flexible.  

• Modify Flexible Cap Layout using Template : Create a new flexible cap configuration for rectangular 

pile-cap geometry. 
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2.4.6 View 

 

 This menu is used to graphically review the geometric configuration of the modeled pile group.  

It also allows the user to activate or deactivate the different toolbars.  The View menu is shown in Figure 

2.14 and the different submenu choices are described below. 

• Model Summary: Provides a list of the parameters for the current model.  

• Pile Top: Activates a view of the group model from above.  

• 3D View: Provides a 3D view of the group model and activates several different preset viewing 

angles, as well as transformation options that allow the user to customize the viewing angle. 

• View Options: These options allow the user to switch the viewing angle to one of the presets. 

• Transform Options: These options allow the user to pan, zoom in or out, and rotate the viewing 

angle. 

• Toolbar Options: These options activate or deactivate the various toolbars at the top of the screen.   
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Figure 2.14  Options contained in the View Menu (3D View Active) 
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2.4.7 Computation Options 

 

 The Computation menu is provided to run the analytical computations after all data is entered 

and saved.  After the computations are executed, this menu also provides options for the review of 

plain-text input and output data.  The listing of the Computation menu is shown in Figure 2.15 and the 

different submenu choices are described below. 

  

   

Figure 2.15  Options contained in the Computation Menu 
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Figure 2.16  Options contained in the Computation Menu – Flexible Cap Version 

 

 

• Run Analysis: This option runs the analytical computations.  Only use this after all data has been 

entered and saved. 

• Run Analysis: This option runs the moment curvature calculations only if a nonlinear section if at 

least one nonlinear section is defined. 

• Select Load Case or Combination: This option opens the Select Load Case or Combination window.  

There the user can select the load case or load combination that will be active for displaying the 

graphical results.   

• View Input File: This submenu is used to view the input data file in text mode.  This command 

becomes active after new data files have been saved to disk or when opening existing data files. 

• View Echo Print File: This submenu is used to view the echo print data file in text mode that is 

automatically produced during each analytical run.  This command becomes active after an 

analytical run, or when opening previously executed data files 

• View Processor Run Notes: This submenu is used to view the notes provided during processing.  The 

command becomes active after an analytical run, or when opening previously executed data files.  

Reviewing the notes is essential for debugging unsuccessful runs.   

• View Output Results File: This submenu is used to view the output file that is automatically 

produced during each analytical run.  This command becomes active after an analytical run, or when 

opening previously executed data files.   
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• View Summary Results File: This submenu is used to view the summary file that is automatically 

produced during each analytical run.  This command becomes active after new data files have been 

saved to disk and executed, or when opening previously-executed data files. 

• View Moment Curvature File: This submenu is used to view the moment curvature file that is 

produced after using the run moment curvature calculations option.  This command becomes active 

after new data files have been saved to disk and executed, or when opening previously-executed 

data files. 

• Special Plots: This submenu is used to open the Special Plots Windows that allows the user to 

produce various plots.  This command becomes active after new data files have been saved to disk 

and executed, or when opening previously-executed data files. 

• Incremental/PushOver Results Plots: This submenu is used to open the Incremental/PushOver Plots 

Windows that allows the user to produce various plots.  This command becomes active after new 

data files have been saved to disk and executed, or when opening previously-executed data files if at 

least one load case includes Incremental/PushOver analysis. 
 

 For the Flexible Cap Version the following options are included: 

• View Echo File (Flexible Cap): This submenu is used to view the echo print data file of the flexible 

cap in text mode that is automatically produced during each analytical run.  This command becomes 

active after an analytical run, or when opening previously executed data files when a flexible cap is 

defined. 

• View Output Results File (Flexible Cap): This submenu is used to view the output file of the flexible 

cap that is automatically produced during each analytical run.  This command becomes active after 

an analytical run, or when opening previously executed data files when a flexible cap is defined.   

• View Summary Results File (Flexible Cap): This submenu is used to view the summary file of the 

flexible cap that is automatically produced during each analytical run.  This command becomes 

active after new data files have been saved to disk and executed, or when opening previously-

executed data files when a flexible cap is defined. 
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2.4.8 Graphs Menu 

 

 The Graphs menu is provided to display the plots available after the analysis has been 

completed.  Most of the graphs are based on the current load case or load combination.  The current 

Load Case is displayed in the second box of the status line.  The listing of the Graphs menu is shown in 

Figure 2.17 and Figure 2.18 and the different submenu choices are described below. 

 

 

 

Figure 2.17  Options contained in the Graphs Menu.  2D Model 
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Figure 2.18  Options contained in the Graphs Menu.  3D Model 
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• Generated p-y Curves: Plots internally generated p-y curves at user defined depths. 

• Generated Axial Load vs.  Displacement: Plots internally generated axial load versus pile-head 

displacements.   

• Generated Torque vs.  Rotation:  Plots internally generated torque versus pile-head rotations.  (3D 

only)   

• User Defined p-y Curves:  Plots user defined p-y curves. 

• User Defined Axial Load vs.  Displacement:  Plots user-defined axial load versus pile-head 

displacements.   

• User Defined Torque vs.  Rotation: Provides a plot of user-defined torque versus pile-head 

rotations.  (3D Only) 

• Moment Curvature:  Plots moment curvature for all sections, for both internally generated and 

user-defined.  

• Deflection vs.  Distance:  Plots lateral pile deflection versus distance from pile top on each individual 

pile. (2D Only)  

• Bending Moment vs.  Distance: Plots the bending moment versus distance from pile top on each 

individual pile.   

• Shear vs. Distance:  Plots the shear versus distance from pile top on each individual pile. (2D Only) 

• Soil Reaction vs.  Distance:  Plots of soil reaction versus distance from pile top on each individual 

pile.  (2D Only) 

• Bending Stiffness vs.  Distance:  Plots of bending stiffness versus distance from pile top on each 

individual pile.  (2D Only) 

• Def., Mom., Shear vs.  Distance:  Plots in one graph the lateral pile deflection, bending moment and 

shear versus distance from pile top on each individual pile.  (2D Only) 

• Deflection y dir vs.  Distance:  Plots lateral pile deflection in the local y-direction versus distance 

from pile top on each individual pile.  (3D Only) 

• Deflection z dir vs.  Distance:  Plots lateral pile deflection in the local z-direction versus distance 

from pile top on each individual pile.  (3D Only) 

• Moment z dir vs.  Distance:  Plots bending moment about the local z-axis versus distance from pile 

top on each individual pile.  (3D Only) 

• Moment y dir vs.  Distance: Plots bending moment about the local y-axis versus distance from pile 

top on each individual pile. (3D Only) 

• Shear y dir vs.  Distance: Plots lateral shear in the local y-direction versus distance from pile top on 

each individual pile.  (3D Only) 

• Shear z dir vs.  Distance: Plots lateral shear in the local z- direction versus distance from pile top on 

each individual pile.  (3D Only) 

• Soil Reaction y dir vs.  Distance: Plots lateral soil reaction the local y- direction versus distance from 

pile top on each individual pile.  (3D Only).   

• Soil Reaction z dir vs.  Distance: Plots lateral soil reaction the local z- direction versus distance from 

pile top on each individual pile.  (3D Only) 
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• Bending Stiffness z dir vs.  Distance:  Plots of bending stiffness in the local z-direction versus 

distance from pile top on each individual pile.  (3D Only) 

• Bending Stiffness y dir vs.  Distance:  Plots of bending stiffness in the local y direction versus 

distance from pile top on each individual pile.  (3D Only) 

• Resultant Deflection vs.  Distance: Plots lateral pile resultant deflection versus distance from pile 

top on each individual pile.  (3D Only) 

• Def. y, Mom. z, Shear y vs.  Distance:  Plots in one graph the lateral pile deflection y, bending 

moment z and shear y versus distance from pile top on each individual pile.  (3D Only). 

• Def. z, Mom. y, Shear z vs.  Distance:  Plots in one graph the lateral pile deflection z, bending 

moment y and shear z versus distance from pile top on each individual pile.  (3D Only). 

• Resultant Moment vs.  Distance: Plots the resultant moment versus distance from pile top on each 

individual pile.  (3D Only) 

• Resultant Shear vs.  Distance: Plots the resultant shear versus distance from pile top on each 

individual pile.  (3D Only) 

• Resultant Soil Reaction vs. Distance: Plots resultant soil reaction versus distance from pile top on 

each individual pile.  (3D Only) 

• Res. Def., Mom., Shear vs.  Distance:  Plots in one graph the resultant lateral pile deflection, 

resultant bending moment and resultant shear versus distance from pile top on each individual pile.  

(3D Only) 

 

The following are only available if Generate Data for Foundation Stiffness is specified in the input 

for the current load case. 

 

• Pile Cap Vertical Load vs.  Deflection: Plots incremental vertical load versus vertical deflection at the 

pile cap.  (2D Only)   

• Pile Cap Load vs.  Lateral Deflection: Plots incremental lateral load versus lateral deflection at the 

pile cap.  (2D Only) 

• Pile Cap Load vs.  Rotation Plots incremental lateral load versus rotation at the pile cap.  (2D Only) 

• Pile Cap Moment vs.  Deflection: Plots incremental bending moment versus lateral deflection at the 

pile cap.  (2D Only) 

• Pile Cap Moment vs. Rotation: Plots incremental bending moment versus rotation at the pile cap.  

(2D Only) 

• Pile Cap Vertical Load vs.  Deflection X/Y/Z: Plots incremental vertical load versus vertical deflection 

at the pile cap.  (3D Only) 

• Pile Cap Moment vs.  Rotation X/Y/Z: Plots incremental moment versus rotation about the X/Y/Z-

axis at the pile cap.  (3D Only) 

• Pile Cap K11 vs.  Deflection X: Plots the stiffness coefficient K11 (Kxx) versus vertical deflection at 

the pile cap.   

• Pile Cap K22 vs.  Deflection Y: Plots the stiffness coefficient K22 (Kyy) versus lateral deflection in the 

Y-direction at the pile cap.   
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• Pile Cap K33 vs.  Rotation Z: Plots the stiffness coefficient K33 (Krzrz) versus rotation along the Z-

axis at the pile cap.   

• Pile Cap K33 vs.  Deflection Z: Plots the stiffness coefficient K33 (Kzz) versus lateral deflection in the 

Z-direction at the pile cap.   (3D Only) 

• Pile Cap K44 vs.  Rotation X: Plots the stiffness coefficient K44 (Krxrx) versus rotation about the X-

axis at the pile cap.  (3D Only) 

• Pile Cap K55 vs.  Rotation Y: Plots the stiffness coefficient K55 (Kryry) versus rotation about the Y-

axis at the pile cap.  (3D Only) 

• Pile Cap K66 vs.  Rotation Z: Plots the stiffness coefficient K66 (Krzrz) versus rotation about the Z-

axis at the pile cap.  (3D Only) 

 

The following are only available if Perform Incremental PushOver/Analysis is specified in the input 

for the current load case. 

 

• Pile Cap Vertical Load vs.  Deflection: Plots incremental vertical load versus vertical deflection at the 

pile cap.  (2D Only)   

• Pile Cap Load vs.  Lateral Deflection: Plots incremental lateral load versus lateral deflection at the 

pile cap.  (2D Only) 

• Pile Cap Load vs.  Rotation Plots incremental lateral load versus rotation at the pile cap.  (2D Only) 

• Pile Cap Moment vs.  Deflection: Plots incremental bending moment versus lateral deflection at the 

pile cap.  (2D Only) 

• Pile Cap Moment vs. Rotation: Plots incremental bending moment versus rotation at the pile cap.  

(2D Only) 

• Pile Cap Vertical Load vs.  Deflection X/Y/Z: Plots incremental vertical load versus vertical deflection 

at the pile cap.  (3D Only) 

• Pile Cap Moment vs.  Rotation X/Y/Z: Plots incremental moment versus rotation about the X/Y/Z-

axis at the pile cap.  (3D Only) 
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2.4.9 Plot Menu 

 

The Plot menu is available when a graph is displayed.  The listing of the Plot menu is shown in 

Figure 2.19 and the different submenu choices are briefly described below 

  

Figure 2.19  Options contained in the Plot Menu 

 

 

 

 

 

 

• Show Legend: Display the legend in the current plot. 

• Show Markers: Change the increment for displaying the curve markers.  The submenu options are: 

o Never: Use this option to not include markers at each curve.   

o Every Increment: Show markers every increment (default). 

o Every 2/3/5/10 Increments: Show markers every 2/3/5/10 increments. 

• Font Size: Change the font size.  The submenu options are: 

o Default: Use this option to use the default size estimated by the program.   

o 1.5*Default: Uses a font size equal to 1.5 times the default size. 

o 2*Default: Uses a font size equal to 2 times the default size.  

o 2.5*Default: Uses a font size equal to 2.5 times the default size. 

o 3*Default: Uses a font size equal to 3 times the default size. 

o 4*Default: Uses a font size equal to 4 times the default size. 
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• Line Width: Change the line width.  The submenu options are: 

o Default: Use this option to use the default width estimated by the program.   

o 2*Default: Uses a line width equal to 2 times the default width. 

o 4*Default: Uses a line width equal to 4 times the default width. 

o 6*Default: Uses a line width equal to 6 times the default width. 

o 10*Default: Uses a line width equal to 10 times the default width. 

• Print... : Print the current graph.   

• Page Setup: Set parameters (margins, orientation) for printing the current graph.   

• Save To Disk.. : Save the current graph as a bitmap file. 

• Graph Title: Include a title for the current graph. 

• Edit Legend: Edit the default legend. 

• Active Graphs: Hide or show selected curves.  Very useful if the graph contains a lot of curves.  

• Curve # n: If this option is selected (default), the curve #n will be shown.  The number of curves 

listed will be equal to the number of the active curves. 

 



CHAPTER 2    Installation and Getting Started     2-35 

 

GROUP 2022 for Windows User's Manual 
 

 

2.4.10 Show 3D View Menu 

 

 The Show 3D View menu is available when the 3D View window is displayed.  

 

      

 

Figure 2.20  Options contained in the Show 3D View Menu 
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Figure 2.21  Options contained in the Show 3D View Menu – Flexible Cap Version 

 

• Piles: Show/Hide the piles. 

• Show Only One Row: Show only one row of piles (only for 2D models) 

• Pile Numbers: Toggles the pile numbers at each pile head. 

• Pile Wire/Shade: Toggle between showing the piles as lines, or as based on cross section 

dimensions, respectively. 

• Pile Local Axes: Show/ Hide the local axes at the top of each pile head.  This option is very useful for 

checking the direction of local axes in the piles. 

• Pile Head Connections: Show/ Hide the pile head connections at the top of each pile head.  This 

option is very useful for checking the pile head connection defined for the piles. 

• Pile Properties: Toggles the pile properties at each pile head. 

• Pile Cap: Show/ Hide the pile cap. 

• Soil Layers: Show/ Hide the soil layers. 

• Layer Labels: Toggle the soil labels.  Only available if the Soil Layers option is selected. 

• Layer Depths Labels: Toggle the depth labels.  Only available if the Soil Layers option is selected. 

• Concent. Loads at Pile Cap: Show the concentrated loads at the pile cap for the current load case. 

• Onlt Equiv. Conc. Load at Origin: Show onlt the equivalent concentrated load applied at the origin 

of coordinates for the current load case. 

• Distributed Loads at Piles:  Show/Hide the distributed loads at piles for the current load case. 

• Global Axes: Show/ Hide the global axes. 

• Vertical Lines at Piles: Show/ Hide vertical lines that start from the top of each pile head.  This 

option is very useful in the case of batter piles. 

• Show Loading Options: Open the Loading Options Window. There the user can change the default 

drawing for concentrated and distributed loads. 

• Display Values Options: Open the Display Values Window. There the user can change the default 

format for values displayed in the 3D View. 

• Show Grid: Show/Hide a three-dimensional grid.  This option is very useful for checking the extent 

of the model. 

• Grid Options: Change the increment values for the 3D grid. 

• Pile Color: This option is useful to color the piles for a specific property.  The options available are: 

o Default: All the piles have the same color. 

o By Pile Properties: Piles with same pile property have the same color. 

o By Cross Sections: Pile increments with same pile cross section have the same color. 

o By Pile Numbers: Each pile has a different color. It may be repeated every 15 piles. 

• Highlight Piles: Navigate through the pile numbers, showing the current pile with a different color. 

• Select Piles: Open a dialog box for various ways to select piles. 

• Hide/Show Piles: This option is useful when a user wants to review a specific section of the pile 

group.  Here the user can: 

o Hide Selected Piles: Hide the selected piles.  (Use Edit→ Select Mode) 
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o Hide Except Selected Piles: Hide the piles that are not currently selected. 

o Reverse Hiding: Hide piles that are shown and show piles that are hidden. 

o Show All Piles: Show all the piles.   

 

 For the Flexible Cap Version the following options are included: 

• FEM Nodes: Show/Hide the nodes of the finite element nodes that dbelong to the flexible pile cap. 

• Node Numbers: Toggles the node numbers. 

• FEM Edges: Show/Hide the edges of the plates that belong to the flexible pile cap. 

• FEM Plates: Show/Hide the plates that belong to the flexible pile cap. 

• Plate Thickenss: Toggle between showing the plates as 2D planes, or showing them as 3D solids. 

• Plate Numbers: Toggles the plate numbers. 

• FEM Plates: Show/Hide the plates that belong to the flexible pile cap. 

• Plate Thickenss: Toggle between showing the plates as 2D planes, or showing them as 3D solids. 

• Plate Numbers: Toggles the plate numbers. 

• Select Plates: Open a dialog box for various ways to highlight plates. 

• Select Plates: Open a dialog box for various ways to select plates. 

• Select Nodes: Open a dialog box for various ways to highlight nodes. 

• Select Nodes: Open a dialog box for various ways to select nodes. 

• Hide/Show Piles, Plates: This option is useful when a user want to review a specific section of the 

pile group.  Here the user can: 

o Hide Selected Piles, Plates: Hide the selected piles and or plates.  (Use Edit→ Select Mode) 

o Hide Except Selected Piles, Plates: Hide the piles and or plates that are not currently 

selected. 

o Reverse Hiding: Hide piles and or plates that are shown and show piles that are hidden. 

o Show All Piles, Plates: Show all the piles and or plates.   

 

 

2.4.11 3D View Results 

 

 The 3D View Results menu is available when the 3D View window is displayed and after running 

analysis under the Computation menu.  
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Figure 2.22  Options contained in the 3D View Results Menu 

 

     

 

Figure 2.23  Options contained in the 3D View Results Menu – Flexible Cap Version 

 

• Deformed Shape: Display the deflected shape for the current load case or combination. 

• Pile Contour Plot: Display a contour plot on piles for the current load case or combination.   

• Pile Diagrams: Display the diagrams along the piles for the current load case or combination.   

• Pile Heads Response:  Display the results of the pile heads for the current load case or combination.   

• Pile Top Effects: Display the results of the pile heads for the current load case or combination.   

• Lateral Effects in Piles: Display the lateral results along the piles for the current load case or 

combination.   

 

 For the Flexible Cap Version the following options are included: 
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• Flexible Cap Contour Plot: Display a contour plot on the flexible pile-cap for the current load case or 

combination.   

• Flexible Cap Section Cut: Open a window to display a distribution of the results available at the 

flexible pile-cap at a section cut.   

• Flexible Cap Beam Diagrams: Open a window to display the diagrams along the beams for the 

current load case or combination.   

• Flexible Cap Node Results: Open a window to display the values of the results available calculated 

or interpolated at the nodes.   

• Flexible Cap Plate Results: Open a window to display the values of the results available calculated at 

the beams.   

• Flexible Cap Node Results: Open a window to display the values of the results available calculated 

the beams.   
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2.4.12 Window Menu 

 

 The Window menu provides standard functions for organizing open-screen windows. 

 

  

Figure 2.24  Options contained in the Windows Menu 

• Cascade: This option organizes all open windows so that they are all visible.  See above for an 

example. 

• Arrange Icons: Any minimized windows will be aligned at the bottom left of the screen. 

• After the options Cascade and Arrange Icons, the windows opened are listed in order of depth.  

Clicking on a window name through the menu brings it to the top 

• Group – 3D View: This option switches the view to the 3D View window. 

 

 

 

 

2.4.13 Help Menu 

 

 The Help menu provides an online help reference. 

 

  

Figure 2.25  Options contained in the Help Menu 

 

 

• Documentation: Access to the digital versions of the Manuals for the Program. 
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o User's Manual: Open the User's Manual of the Program (pdf version). 

o Examples Manual: Open the Examples Manual of the Program (pdf version). 

o Technical Manual: Open the Technical Version of the Program (pdf version). 

• About: This option provides a screen describing the program version, date, license user and 

methods for accessing technical support. 

• Check for Updates: This opens the user’s default internet browser to an Ensoft webpage with 

specific update information for GROUP 2022. 

 



 

 

 

 

 

 

 

 

 

 

 

 

CHAPTER 3. References for Data Input 



CHAPTER 3    References for Data Input     3-2 

 

GROUP 2022 for Windows User's Manual 
 

 

3.1 Numeric Data Entries  
 

 Cells that require numeric data may accept mathematical expressions as entries.  Entering a 

mathematical expression works similarly to entering normal numeric data—the user simply types the 

expression then presses the “Enter” key.  The following table shows a list of supported operations and 

constants, with the order of operations following the order listed.  Implicit multiplications using 

constants is not supported (use 2*e instead of 2e).  Negation of the constants PI or e is not allowed.  For 

instance, instead of entering -PI the user must enter -(PI).  Scientific notation (i.e.  1.65e8 or 1.65e-8) 

may be used to input very large or very small numbers.  After an expression is calculated, very large or 

very small numbers will be displayed using scientific notation. 

 

Symbol Description 

() Parenthesis (may be nested) 

^ Exponentiation 

* Multiplication 

/ Division 

+ Addition 

- Subtraction/Negation 

 

Table 3.1  Supported mathematical operations 

 

 

Symbol Value 

PI (or pi) 3.1415927 

e (or E) 2.7182818 

 

Table 3.2  Supported mathematical constants 
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3.2 File Menu 
 

 This menu contains options related to the management of input-data files and also for exiting 

the program.  Input-data files created for GROUP 2022 are provided with a standard file-name extension 

in the form of *.gp12d (where * represents any allowable file name).  Input files created from previous 

versions have an extension *.gp11d ,*.gp10d, *.gp9d, *.gp8d or *.gpd .  All input data files are standard 

text files and may be edited with any text editor or word-processing program. 

If the 3D View window is active 3 additional options appear. 

 

 

Figure 3.1  Options contained in the File Menu 
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3.2.1 File - New 

 

 Once the program is started, default values are used for certain operating parameters, and a 

blank input-data file is created.  Selecting this menu item resets all GROUP 2022 variables to either 

default or blank values, as appropriate.  This option should be selected when a new data file is desired 

to be created.  This menu option may also be accessed using the [Ctrl]+[N] keyboard combination. 

 

 

 

Figure 3.2  Window shown after File - New is selected 

 

 

3.2.2 File - New from Template 
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 Create a new data file for a regular rectangular or circular pile group configuration.  After 

selecting this option, the New from Template Window will appear. 

 Three pile group templates are included: 

 

• 2D Rectangular: Generates a rectangular 2D pile group layout (Figure 3.3) 

• 3D Rectangular: Generates a rectangular 3D pile group layout. (Figure 3.4) 

• 3D Circular: Generates a circular 3D pile group layout (Figure 3.5) 

 

  

Figure 3.3  New from Template Window, 2D rectangular option 
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Figure 3.4  New from Template Window, 3D rectangular option 
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Figure 3.5  New from Template Window, 3D circular option 

 

 The following parameters can be defined in the New from Template window: 

• Layout: Select the pile group configuration to generate.  Various entries may show up or hide based 

on the layout selected. 

• Units: Select either English or SI units. 

• Space increment: Enter the space increment for model generation.  For rectangular layouts, enter 

Space Increment for Y and Z directions.  For Circular layouts enter Space Increment in the radial 

direction.  Refer to Figure 3.6 and Figure 3.7. 

• Number of Rows: Enter the Number of Rows for model generation.  For rectangular layouts, enter 

number of rows for Y and Z directions.  For Circular layouts enter Number of Rows in the radial 

direction.  Refer to Figure 3.6 and Figure 3.7. 

• Center of Pile Group: Enter the coordinates for the center of the pile group (Y and Z coordinates) 

and the coordinate of the pile heads (X coordinate).  Refer to Figure 3.6 and Figure 3.7. 
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• Pile Cap Dimensions: Enter the dimensions of the pile cap for drawing purposes in the 3D window. If 

these values ar left as zero, the dimensions for 3D drawing will be estimated. For rectangular 

layouts, enter dimensions in Y and Z directions.  For Circular layouts enter the diameter.  Refer to 

Figure 3.6 and Figure 3.7. 

• Pile Properties: Enter the Pile Length, Pile Diameter, Modulus of Elasticity and Poisson Ratio for all 

the piles to be generated.  Refer to Figure 3.6 and Figure 3.7. 

An example of a rectangular layout generated is displayed in Figure 3.8, while a circular layout is shown 

in Figure 3.9. 

 

 

 

Figure 3.6  Input parameters for pile group generation, rectangular option 
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Figure 3.7  Input parameters for pile group generation, circular option 
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Figure 3.8  Pile Group Layout using New from Template, 3D rectangular option 
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Figure 3.9  Pile Group Layout using New from Template, 3D circular option 

 

 

3.2.3 File - New from Template – Flexible Cap Version 

 

 The New from Template Window for the Flexible Cap Version has two options for pile cap type: 

Rigid and Flexible. The rigid option is similar to the Standard Version, and it is described in detail in the 

previous item (3.2.2). The options related to the flexible cap type will be described below. 

 Two pile group templates that also included flexible cap are included: 

• 3D Rectangular: Generates a rectangular 3D pile group layout and flexible cap. (Figure 3.10) 

• 3D Circular: Generates a circular 3D pile group layout and flexible cap (Figure 3.11) 
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Figure 3.10  New from Template Window, 3D rectangular option – Flexible Cap Version 

  

 

    

 

Figure 3.11  New from Template Window, 3D circular option – Flexible Cap Version 

 

 



CHAPTER 3    References for Data Input     3-13 

 

GROUP 2022 for Windows User's Manual 
 

The flexible cap can be defined as a combination of plate and beam elements (Figure 3.10) , or only 

plate elements (Figure 3.12), or only beam elements (Figure 3.13). 

 

  

Figure 3.12  New from Template Window, 3D rectangular option, Add Plate Elements – Flexible Cap 
Version 

 

 

  

Figure 3.13  New from Template Window, 3D rectangular option, Add Beam elements – Flexible Cap 
Version 
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 In addition to the parameters in the previous item (3.2.2), the following parameters can be 

defined in the New from Template window for the Flexible Cap Version: 

• Plate Elements Between Piles : Enter the number of plates to be defined between piles.  For 

rectangular layouts, enter number of plates for Y and Z directions.  For Circular layouts enter 

number of plates in the radial and tangential direction.  Refer to Figure 3.14 and Figure 3.15. 

• Beam Elements Between Piles : Enter the number of beams to be defined between piles.  For 

rectangular layouts, enter number of plates for Y and Z directions.  For Circular layouts enter 

number of plates in the radial and tangential direction.  Refer to Figure 3.18 and Figure 3.19. 

• Extra Elements at Ends : Enter the number of plates or beams to be defined from the outer pile to 

the boundary of plate pile cap.  For rectangular layouts, enter number of plates or beams for Y and Z 

directions.  For Circular layouts enter number of plates or beams in the radial direction.  Refer to 

Figure 3.14 and Figure 3.15 for plate elements and Figure 3.18 and Figure 3.19 for beam elements. 

• Generate Internal Beams : This option is available while defining only beams for a rectangular 

sahape pile cap. By clicking this option the program will add the internal beams, otherwise the 

program will include only the principal beams.  Refer to Figure 3.18. 

• Plate Material Properties: Enter the Modulus of Elasticity, Poisson Ration and Thickness of the 

flexible pile cap. Check the option is the pile cap is to be considered as thin. 

• Beam Material Properties: Enter the properties to define the cross section and material properties 

of the beam. Enter Modulus of Elasticity, Poisson Ratio and Width and Depth or Diameter for 

circular sections.. 

• Plate-Pile Head Alignment (Vertical): Select the alignment between the pile head and the plates. If 

selected other than middle or the D.Axis value is different from zero, a rigid element will be used to 

connect each pile head with a vertical projected node that belongs to the finite element mesh 

defining the flexible pile-cap (vertical offset). 

• Beam-Pile Head Alignment (Vertical): Select the alignment between the pile head and the beams. If 

selected other than middle or the D.Axis value is different from zero, a rigid element will be used to 

connect each pile head with a vertical projected node that belongs to the finite element mesh 

defining the flexible pile-cap (vertical offset). 

• Plate-Beam Head Alignment (Vertical): Select the alignment between the beams and plates. If 

selected other than middle or the D.Axis value is different from zero, a rigid element will be used to 

connect each pile head with a vertical projected node that belongs to the finite element mesh 

defining the flexible pile-cap (vertical offset). 

An example of a rectangular layout generated is displayed in Figure 3.16 and Figure 3.20, while a circular 

layout is shown in Figure 3.17 and Figure 3.21. 
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Figure 3.14  Input parameters for mesh generation, rectangular option, plate elements – Flexible Cap 
Version 
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Figure 3.15  Input parameters for mesh generation, circular option, plate elements – Flexible Cap 
Version 

 

 

Figure 3.16  Pile Group Layout using New from Template, 3D rectangular option, plate elements – 
Flexible Cap Version 
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Figure 3.17  Pile Group Layout using New from Template, 3D circular option, plate elements – 
Flexible Cap Version 
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Figure 3.18  Input parameters for mesh generation, rectangular option, beam elements – Flexible 
Cap Version 
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Figure 3.19  Input parameters for mesh generation, circular option, beam elements – Flexible Cap 
Version 
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Figure 3.20  Pile Group Layout using New from Template, 3D rectangular option, beam elements – 
Flexible Cap Version 
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Figure 3.21  Pile Group Layout using New from Template, 3D circular option, beam elements – 
Flexible Cap Version 

 

 

 

3.2.4 File - Open 

 

  This is used to open a file that has been previously prepared and saved to disk.  The Open File 

window dialog, shown in Figure 3.22, is used to search for an existing input data file.  The default 

directory is the GROUP 2022 install directory.  Standard Windows navigation procedures may be used to 

locate the name and directory of the desired project file.  This menu option may also be accessed with 

the [Ctrl]+[O] keyboard combination. 

 Every analytical run of GROUP 2022 produces several additional files (listed on Table 4.1 of this 

manual).  The name of the input data file indicates the names of all related files (output, graphics and 

processor-text files) produced by a successful program run.  All the additional files will be created in the 

same directory as the input file.   
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 Opening some partially-completed GROUP 2022 input files or invalid data files may produce an 

information window reporting that an "invalid or incomplete" file is being opened.  The user should click 

the OK button and all partial-input data that was previously prepared should become available. 

 The program allows users to read input data files created from previous versions of GROUP by 

selecting the drop-down arrow under the Files of Type option at the bottom of the Open window 

screen.  The program will automatically convert the open GROUP file to GROUP 12.0 Data when the user 

saves the opened file. 

 

 

 

Figure 3.22  Open File Dialog 

 

 Please note that the Flexible Cap Version will be able open input files generated by the Standard 

Version. The Standard version will be able to open files generated by the Flexible Cap Version; however, 

if the model in the Flexible Cap Version was defined using a flexible pile cap, the program will display a 

warning message indicating that all the flexible cap definitions will be lost if the file is saved (Figure 

3.23). 
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Figure 3.23  Warning message for possible data loss. 

 

3.2.5 File - Save 

 

 This option is used to save input data under the current file name.  Any input data that was 

previously saved with the same file name is replaced by the current one.  Input data files should be 

saved every time before proceeding with analytical runs.  This menu option is accessed using the 

[Ctrl]+[S] keyboard combination. 

 

3.2.6 File - Save As 

 

 This option allows the user to save any opened or new input data file under a different file name 

or different directory.  The Save As window dialog, shown in Figure 3.24, is used to navigate between 

folders and specify a file name.  If a file with the same name already exists, a confirmation message 

indicating so will appear.  By clicking OK in the confirmation window, the input data file under the 

existing file name will be replaced with the current one. 
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Figure 3.24  Save As Dialog 
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3.2.7 File - Exit 

 

 This is selected to exit GROUP 2022.  Any input data file that was modified but not yet saved to 

disk will produce a confirmation window before exiting the program. 

  

Figure 3.25  Message window advising that changes were not saved to disk 

 

3.2.8 File - Recent Files 

 

 A list of recently opened files is displayed in between Save As… and Exit.  By clicking on the 

menu item, the program will open the file. 

 

3.2.9 File - Save Bitmap (3D View) 

 

 This option is available when the 3D View window is active.  This option allows the user to save 

the model displayed in the 3D View window as bitmap picture file.  The Save As window dialog, shown 

in Figure 3.26, is used to navigate between folders and provide a name for saving the file.  If a file with 

the same name already exists, a confirmation message indicating so will appear.  By clicking OK in the 

confirmation window, the graphics file under the existing file name will be replaced with the current 

model view. 
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Figure 3.26  Save Bitmap Dialog 

 

3.2.10 File - Page Setup (3D View) 

 

 This option is available when the 3D View window is active.  This option allows the user to set 

the margins for printing.  The Page Setup window dialog, shown in Figure 3.27, is used to define the 

margins for printing. 
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Figure 3.27  Page Setup Dialog 

 

3.2.11 File - Print (3D View) 

 

 This option is available when the 3D View window is active.  This option allows the user to print 

the model displayed in the 3D View window.  The Print window dialog, shown in Figure 3.28, is used to 

select the printer and other parameters. 
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Figure 3.28  Print Dialog 

 

3.3 Data Menu 
 

 The input of specific parameters for an application is controlled by options in the Data menu.  It 

is recommended that the user choose each submenu and enter parameters in a consecutive manner, 

starting with the top option.  Some input windows may optionally be left open on the screen.  The 

selection of other menu options will then produce new windows on top of those that were left open.  

Many of the submenus will have Add Row, Insert Row, and Delete Row buttons.  Add Row always adds 

a new row to the end of all existing rows, Insert Row inserts a new row above the currently selected 

row, and Delete Row deletes the row where the mouse cursor is currently at. 

 

Selecting or clicking any of the submenu choices contained in the Data menu produces various types 

of windows.  As a reminder of standard commands of Microsoft Windows®, open windows may be 

closed by all or some of the following methods: 

• Clicking the "OK" button (if available). 

• Clicking the X box on the upper-right corner of the window. 

• Double-clicking the GROUP 2022 icon on the upper left corner of the window. 

• Using the [Ctrl]+[F4] keyboard combination. 

• Clicking once the GROUP 2022 icon on the upper left corner of the window and then choosing Close. 



CHAPTER 3    References for Data Input     3-29 

 

GROUP 2022 for Windows User's Manual 
 

 

     

 

Figure 3.29  Options contained in the Data Menu 
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Figure 3.30  Options contained in the Data Menu – Flexible Cap Version 
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3.3.1 Data - Title 

 

 This option activates the Project Title window, shown in Figure 3.31, where the user can enter a 

line of text containing a general description of the application problem.  Any combination of characters 

may be entered in the text box in order to describe a particular application.  The user input will be 

restrained automatically once the maximum length of text is reached.   

  

Figure 3.31  Project Title Window 
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3.3.2 Data - Pile Cross Sections 

 

 This submenu option is needed to define the cross sections on the piles and to enter the cross-

section dimensions. 

 By selecting this option, the Cross Sections Definition window will appear 

 

3.3.2.1 Cross Sections Definition Window 

 

 In this window the cross sections definition is carried out.  A sample of this window is shown in 

Figure 3.32 

 

  

 

Figure 3.32  Cross Sections Definition Window 
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Cross Sections Definition 

• Add Section.  Add a new row at the end of the list. 

• Insert Section.  Add a new row above the current row. 

• Delete Section.  Delete the current row.   

• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a section. 

 For each cross section (row) the following columns are available: 

•  Edit Section.  Click on the Edit Section button to open the Edit Cross Section window for 

defining the cross-section dimensions. 

• Section Name.  In the second column enter the name associated with the cross section being 

defined.  

• Section Type.  In the third column select the type of section. It could elastic or nonlinear. 

 

 

Close Button 

 Click on the Close button to close the window and go back to the GROUP window. 
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3.3.2.2 Edit Cross Section Window (Elastic Section) 

 

 In this window the user can define each cross section (elastic). Bending stiffness, axial stiffness 

and torsional stiffness of the pile section are considered elastic while selecting this option. The section 

number and section name are displayed at the top of the window.  A sample of this window is shown in 

Figure 3.33 

 

   

Figure 3.33  Edit Cross Section Window 

 

Select Section 

While using the Select Section feature, the user can choose from 5 different pile section types which will 

be graphically displayed in the middle of the window.  On the right, the Section Dimensions will adjust 

depending on the section type selected.  The five sections available are: 

• General Section.  Use for a general shape section.  This section will be assigned automatically to 

models created from previous versions of GROUP.  See Figure 3.34. 
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• Circular Pipe Section.  Also used to define a solid circular section.  See Figure 3.34. 

• Rectangular Pipe Section.  Also used to define a solid rectangular section.  See Figure 3.35. 

• I Section.  See Figure 3.36. 

• H Section.  See Figure 3.37. 

• AISC Section.  See Figure 3.38. 

 

 

  

Figure 3.34  Edit Cross Section Window.  Circular Pipe Section 
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Figure 3.35  Edit Cross Section Window.  Rectangular Pipe Section 

    

Figure 3.36  Edit Cross Section Window.  I Section 
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Figure 3.37  Edit Cross Section Window.  H Section 

   

Figure 3.38  Edit Cross Section Window.  AISC Section 
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Copy Section 

 The option is helpful for when there are cross sections that only have a few differences.  In this 

case, the user can simply copy the section and make the desired changes.  Select the cross section that is 

going to be the source (already defined), and then click on the Copy button to duplicate the data from 

the source.  This option is available if at least two elastic cross sections have been defined. 
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Section along Depth 

While using the Section along Depth feature, the user can define a constant section or a tapered section 

along the depth of the pile. For a constant section only one set of input parameters are required; 

however, for a tapered section property both top and bottom are required. 

If a tapered section is defined the Button Copy Top to Bottom is available. While clicking on this button, 

all the parameters defined for the top are copied to the bottom. 

Please note that if a tapered section is defined the program will use a linear interpolation for all the 

variables to estimate values between top and bottom of the section. 

 

  

Figure 3.39  Edit Cross Section Window for a Tapered Section 
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Section Specifications/Section Draw 

 In the Section Specifications tab, a picture showing the cross section with labels will appear.  

When the user clicks on a label, the corresponding field will be selected. This is an alternate method for 

entering section dimensions. 

 By selecting the Section Draw tab, a scale drawing of the current section will be shown. 

     

Figure 3.40  Toggle between Section Specifications and Section Draw.  H section 

 

If a tapered section is defined the user can choose to draw both sections (top and bottom), only top or 

only bottom one. 
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Section Dimensions 

 Input dimensions parameters will depend on the cross-section type selected.  The following 

parameters are needed 

• General Section. 

o Equivalent Diameter.  Diameter for circular sections or an equivalent diameter for 

noncircular sections. Program uses this value to estimate the contribution of soil 

resistance (p-y curve) for lateral analysis. Program does not use this value for sections of 

beam elements (flexible cap version). 

 

• Circular Pipe Section.   

o  Diameter.  External diameter of the pile. Program uses this value to estimate the 

contribution of soil resistance (p-y curve) for lateral analysis. 

o Internal Diameter.  Internal diameter of the pile.  Leave as zero for a solid pile. 

 

• Rectangular Pipe Section. 

o Equivalent Diameter.  For non-circular sections user must enter the value for equivalent 

diameter. Program uses this value to estimate the contribution of soil resistance (p-y 

curve) for lateral analysis. Program does not use this value for sections of beam 

elements (flexible cap version). 

o Width.  Width of the cross section. 

o Depth.  Depth of the cross section. 

o Internal Width.  Internal width of the cross section.  Leave as zero for a solid pile. 

o Internal Depth.  Internal depth of the cross section.  Leave as zero for a solid pile. 

 

• I or H Section. 

o Equivalent Diameter.  For non-circular sections user must enter the value for equivalent 

diameter. Program uses this value to estimate the contribution of soil resistance (p-y 

curve) for lateral analysis. Program does not use this value for sections of beam 

elements (flexible cap version). 

o Width.  Width of the cross section. 

o Depth.  Depth of the cross section. 

o Flange Thickness.  Flange thickness of the cross section. 

o Web Thickness.  Web thickness of the cross section. 
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• AISC Section. 

o Equivalent Diameter.  For non-circular sections user must enter the value for equivalent 

diameter. Program uses this value to estimate the contribution of soil resistance (p-y 

curve) for lateral analysis. Program does not use this value for sections of beam 

elements (flexible cap version). 

o Other parameters will be populated based on the section selected.  

 

 
Select AISC Section 

 These options are available if the AISC Section has been selected. While selecting a section, 

section parameters will be populated. For non-circular sections, user must enter the value for equivalent 

diameter. 

• Section Type. 

Select the section type required. The following sections are available: 

o W. 

o M 

o S 

o HP 

o HSS 

o PIPE 

 

• Section Name. 

Select the name of the section required: 

 

• Rotate Section. 

Check this option to rotate the section 90 degrees. Useful for 2D models for loading along the 

weak axes of the section. 
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Section Properties 

 The user can input section properties, or let the computer estimate those properties. For AISC 

sections the properties are populated after selecting the section 

• Perimeter.  Perimeter of the section being defined. Program uses this value to estimate the side 

resistance contribution for axial analysis. 

• Area.  Cross sectional area (A) of the section being defined. Program uses this value to estimate 

the tip resistance contribution for axial analysis, to estimate the contribution to the axial 

stiffness of the pile for axial analysis and to estimate the maximum stress on the section. 

• Inertia zz.  Moment of inertia referred to the local axis z (Izz). Program uses this value to 

estimate the bending stiffness in the zz direction. 

• Inertia yy.  Moment of inertia referred to the local axis y (Iyy).  This value is needed for three-

dimensional models. Program uses this value to estimate the bending stiffness in the zz 

direction. 

• Polar Inertia xx.  Polar moment of inertia referred to the local axis x (Ixx=J).  This value is used 

only to estimate the value of torsional stiffness (GJ) for three-dimensional models. 

 

Material Properties 

 User should input material properties. 

• Young Modulus.  Young Modulus (Modulus of elasticity) of element material. Program uses this 

value to estimate the contribution to the axial stiffness of the element for axial analysis and to 

estimate the bending stiffness for lateral analysis. 

• Poisson Patio.  Poisson (Modulus of elasticity) of the pile material. Program uses this value to 

estimate the contribution to the axial stiffness of the pile for axial analysis and to estimate the 

bending stiffness for lateral analysis. 

• Shear Modulus.  Shear modulus of the pile material.  This value is used only to estimate the 

value of torsional stiffness (GJ) for three-dimensional models. 

• GJ (Torsional Stiffness).  This number correspond to the torsional stiffness of the section (GJ).  

This value is needed for three-dimensional models. 



CHAPTER 3    References for Data Input     3-44 

 

GROUP 2022 for Windows User's Manual 
 

 

Calculate 

 These options are available for sections other than the general section. 

• Calculate Section Properties.  Click on this button to calculate the section properties based on 

the section dimensions.  For three-dimensional models it also estimates the torsional stiffness 

based on the polar moment of inertia and the shear modulus. 

• Calculate Section Properties Automatically.  By selecting this option, the program will 

automatically compute the section properties.  Any change in the section dimensions will be 

reflected automatically in the section properties.  

Note: For the Torsional Constant (J) the program will assume the value of Polar Moment of Inertia 

(Ixx=Iyy+Izz). 

 

Design Parameters 

 By entering these parameters, GROUP will compute the demand/capacity ratio for bending 

moment and shear capacity for the load combinations.  This ratio is useful for checking the level of 

stresses in the pile.  This ratio is not intended to replace a design procedure. 

• Bending Moment Capacity.  Capacity in bending moment of the cross section.   

• Shear Capacity.  Capacity in shear of the cross section. 

If the capacity values are left as zero, no ratio is computed. 

 

Considered Section as Spec. w/Moment Capacity 

 By checking this option, the section will be assumed to have an elastoplastic behavior. If the 

demanded moment is smaller than the moment capacity, the section will behave elastic. If the 

demanded moment reaches the moment capacity, a plastic hinge will be formed. 

 

 

Close Button 

Click on the Close button to close the window and go back to the Cross Section Definition window. 
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Note about estimation of Total Stress: 

The program will output the maximum total normal stress along the pile depth. For elastic sections, the 

total stress is estimated as the stress at the outer fiber per section. The normal stress includes the 

contribution due to the axial force and the contribution due to the bending moment. Please disregard 

the total stress values printed by the program for nonlinear sections. 

 

For general and circular sections, the total stress is computed as: 
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For other sections the total stress is computed as: 
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where: 

, is the total stress at specified depth 

A, is the area of the cross section 

Iz, is the moment of inertia along the z axis 

Iy, is the moment of inertia along the y axis (not considered for 2D analysis) 

d, is the diameter of the section 

wd, is the width of the section 

dp, is the depth of the section 

P, is the axial force 

Mz, is the bending moment along the z axis 

My, is the bending moment along the y axis (not considered for 2D analysis) 
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3.3.2.3 Edit Cross Section Window (NonLinear Section) 

 

 In this window the user can define each cross section (nonlinear). Program will use parameters 

to estimate the nonlinear bending stiffness (moment curvature diagram) of the pile section. Axial 

stiffness and torsional stiffness of the pile section are still considered elastic. The section number and 

section name are displayed at the top of the window.  A sample of this window is shown in Figure 3.41  

 

 

 

 

 

 

Figure 3.41  Edit Cross Section Window (Nonlinear Section) 

Section Selection Drawing Area 

Section Parameters Copy Section 

Section Items 

Embedded Steel Section 
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Section Selection 

While using the Section Selection feature, the user can choose from 10 different pile section types 

which will be graphically displayed in drawing area of the window.  On the right, the Section Items will 

adjust depending on the section type selected.  The ten sections available are: 

• Rectangular Concrete Pile.  See Figure 3.42. 

• Round Concrete Shaft.  See Figure 3.43. 

• Round Concrete Shaft with Casing (and Steel Section).  See Figure 3.44. 

• Round Prestressed Pile.  See Figure 3.45. 

• Square Prestressed Pile.  See Figure 3.46. 

• Octagonal Prestressed Pile.  See Figure 3.47. 

• Steel Pipe Pile.  See Figure 3.48. 

• Steel I, H Section Pile.  See Figure 3.49. 

• Steel AISC Section Pile.  See Figure 3.50. 

• User Defined EI.  See Figure 3.51. 

 

Also, the user can select the thrust forces option to define the forces at which the moment 

curvature curves will be computed. 

• Thrust Forces.  See Figure 3.52. 
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Figure 3.42  Edit Cross Section Window.  Rectangular Concrete Pile 

 

  

Figure 3.43  Edit Cross Section Window.  Round Concrete Shaft 
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Figure 3.44  Edit Cross Section Window.  Round Concrete Shaft with Casing (and Steel Section) 

 

   

Figure 3.45  Edit Cross Section Window.  Round Prestressed Pile 
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Figure 3.46  Edit Cross Section Window.  Square Prestressed Pile 

 

   

Figure 3.47  Edit Cross Section Window.  Octagonal Prestressed Pile 
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Figure 3.48  Edit Cross Section Window.  Steel Pipe Pile 

 

   

Figure 3.49  Edit Cross Section Window.  Steel I, H Section Pile 
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Figure 3.50  Edit Cross Section Window.  Steel AISC Section Pile 

 

    

Figure 3.51  Edit Cross Section Window.  User Defined EI 
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Figure 3.52  Edit Cross Section Window.  Thrust Forces 

 

Section Items 

Each section has different section items available.  On the right, the Section Parameters will adjust 

depending on the section item selected.  The following items are available: 

• Section.  Available to all sections except User Define EI. Input parameters are the section 

dimensions and concrete compressive strength for concrete sections or yield strength and 

Young modulus for steel sections. 

• Reinforcement. Available for all reinforced concrete sections. Input parameters are the 

reinforcement properties and reinforcement layout. 

• Trans. Reinf.  Available for both rectangular and round reinforced concrete sections. Input 

parameters are the transverse reinforcement properties needed to estimate the concrete 

confinement following Mander equations. 

• Prestressing Strands.  Available for all prestressed concrete sections. Input parameters are the 

strands properties and strands layout. 

• Casing.  Available only for the round concrete shaft with casing section. Input parameters are 

the casing dimensions and yield strength and Young modulus for the casing. 

• Steel Section.  Available only for the round concrete shaft with casing section. While selecting 

this option the Embedded Steel Section will appear. The input required will depend on the 

embedded section selected. 
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• Add. Properties.  Available to all sections. Input parameters are the additional parameters 

needed to complete the analyses and will depend on the section selected. 

• Properties.  Available only to the User Define EI. Input parameters are the indices of the user 

defined EI set associated with the section. 

 

Embedded Steel Section 

This option is available only for the round concrete shaft with casing section if the Steel Section was 

selected under Section Items On the right, the Section Parameters will adjust depending on the section 

selected.  The following items are available: 

• None.  

• Steel Pipe Pile.   

• Steel I, H Section Pile.   

• Steel AISC Section Pile.  

 

 

 

 

 

Section Parameters 

 Input dimensions parameters will depend on the cross-section type and section item selected.  

The input parameters, per section item, are: 

• Section. 

o Width.  Width of the cross section. 

o Height.  Height of the cross section. 

o Diameter.  External diameter of the section. In addition to estimate the bending 

stiffness of the section, the program uses this value to estimate the contribution of soil 

resistance (p-y curve) for lateral analysis. 

o Void Diam.  Internal diameter of the section for prestressed sections. Leave as zero for a 

solid section. 

o Corner Chamf..  Length of the corner chamfer. Used for square prestressed section. 

o Thickness.  Thickness of the steel pipe section. 

o Web Thick.  Thickness of the web for I or H steel section. 
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o Flange Thick.  Thickness of the flange for I or H steel section. 

o Section Type.  Select the AISC section type. The following sections are available: 

▪ W. 

▪ M 

▪ S 

▪ HP 

▪ HSS 

▪ PIPE 

o Section Name.  Select the AISC section name. The properties table will be populated. 

o f’c.  Concrete compressive strength. 

o fy.  Steel yield strength. 

o Es.  Steel Young’s modulus. 

o H Section.  Check this option to assign an H section. 

o Rotate Section.  Available for AISC Sections. By check this option the section is rotated 

90 degrees. Useful for 2D models for loading along the weak axes of the section. 

o EIzz set.  Select the nonlinear EI set in the zz direction. Select 0 por an elastic section in 

the zz direction. 

o EIyy set.  Select the nonlinear EI set in the yy direction. Select 0 por an elastic section in 

the yy direction.  

o Izz.  Moment of Inertia in the zz direction. Available only if 0 was selected for the EI zz 

set. 

o Iyy.  Moment of Inertia in the yy direction. Available only if 0 was selected for the EI yy 

set. 

 

• Reinforcement. 

o Bar Size.  Select rebar from table or User Defined to enter the area. 

o Area.  Enter area of rebar for user defined rebar, otherwise the program estimates it 

based on selected bar size. 

o fy.  Reinforcement yield strength. 

o Es.  Reinforcement Young’s modulus. 

o Number of Bars.  Number of reinforcement rebars in the cross section. Used for circular 

layout or manual layout. 

o Number Bars Y.  Number of reinforcement rebars in the Y direction. Used for rectangular 

layout. 

o Number Bars Z.  Number of reinforcement rebars in the Z direction. Used for rectangular 

layout. 
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o Circ.  By checking this option, the program will automatically compute the rebar 

coordinates based on a circular layout. 

o Rect.  By checking this option, the program will automatically compute the rebar 

coordinates based on a rectangular layout. 

o Man.  By checking this option, the user should enter the rebar coordinates. 

o Cover.  Distance from edge of section to edge of rebar. Used for circular or rectangular 

layout. 

o Y, Z.  Rebar coordinates. The program will automatically compute these values if circular 

or rectangular layout are selected. Otherwise, user should enter these values. 

 

 

 

• Trans. Reinf. 

o Confined Section.  Check on this option to let the program estimate the concrete 

confinement due to the transverse reinforcement. 

o Spiral.  Available for circular sections. Select this option for spiral transverse 

reinforcement. 

o Hoop.  Available for circular sections. Select this option if the transverse reinforcement 

is made up of hoops. 

o Bar Size.  Select transverse rebar from table or User Defined to enter the area. 

o As.  Enter area of transverse rebar for user defined rebar, otherwise the program 

estimates it based on selected bar size. 

o Number Bars.  Number of transverse reinforcement rebars along the spacing. 

o Set Legs from Long. Reinforcement.  Available for rectangular sections. Select this option 

to assign automatically the transverse rebars based on the longitudinal reinforcement. 

o Number Legs Y.  Available for rectangular sections. Number of legs along the Y direction. 

o Number Legs Z.  Available for rectangular sections. Number of legs along the Z direction. 

o Spacing.  Distance between transverse reinforcement along the pile, from center to 

center. 

o fys.  Transverse reinforcement yield strength. 

o Use Strain Hardening Model.  Check on this option to let the program use the strain 

hardening model for longitudinal reinforcement. 

o fu/fy.  Enter the ratio of ultimate stress (fu) over yield stress (fy). To be used for a 

hardening model. 

o esh.  Enter the strain at which the hardening start. To be used for a hardening model. 

o esu.  Enter the ultimate strain. To be used for a hardening model. 
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• Prestressing Strands. 

o Strand Type.  Select strand type from table or User Defined to enter the ultimate 

strength. 

o fu.  Enter the ultimate strength of the strand for user defined strand, otherwise the 

program estimates it based on selected strand type. 

o Bar Size.  Select rebar from table or User Defined to enter the area. 

o Area.  Enter area of strand for user defined strand, otherwise the program estimates it 

based on selected bar size. 

o Number of Bars.  Number of prestressing strands in the cross section. Used for circular 

layout or manual layout. 

o Number Bars Side.  Number of prestressing strands in each side. Used for square layout. 

o Circ.  By checking this option, the program will automatically compute the prestressing 

strand coordinates based on a circular layout. 

o Sqr.  By checking this option, the program will automatically compute the prestressing 

strand coordinates based on a square layout. 

o Man.  By checking this option, the user should enter the prestressing strand 

coordinates. 

o Cover.  Distance from edge of section to edge of rebar. Used for circular or rectangular 

layout. 

o Init. Force.  Enter the initial force in the section after losses. 

o Y, Z.  Strand coordinates. The program will automatically compute these values if 

circular or rectangular layout are selected. Otherwise, user should enter these values. 

 

• Casing. 

o Diameter.  External diameter of the steel casing. In addition to estimate the bending 

stiffness of the section, the program uses this value to estimate the contribution of soil 

resistance (p-y curve) for lateral analysis and to estimate the side friction contribution 

for axial analysis. 

o Thickness.  Thickness of the steel casing. 

o fy.  Steel casing yield strength. 

o Es.  Steel casing Young’s modulus. 
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• Steel Section. 

The input parameters will depend on the embedded steel section selected  

o Diameter.  External diameter of the section. In addition to estimate the bending 

stiffness of the section, the program uses this value to estimate the contribution of soil 

resistance (p-y curve) for lateral analysis and to estimate the side friction contribution 

for axial analysis. 

o Thickness.  Thickness of the steel pipe section. 

o Web Thick.  Thickness of the web for I or H steel section. 

o Flange Thick.  Thickness of the flange for I or H steel section. 

o Section Type.  Select the AISC section type. The following sections are available: 

▪ W. 

▪ M 

▪ S 

▪ HP 

▪ HSS 

▪ PIPE 

o Section Name.  Select the AISC section name. The properties table will be populated. 

o fy.  Steel yield strength. 

o Es.  Steel Young’s modulus. 

o H Section.  Check this option to assign an H section. 

o Rotate Shape.  Check this option to rotate AISC sections 90 degrees. Useful to assign 

loading into weak axis for 2D models. 

 

 

• Add. Properties. 

o Eq. Diameter.  Enter the equivalent diameter for non-circular sections. The program 

uses this value to estimate the contribution of soil resistance (p-y curve) for lateral 

analysis. 

o Perimeter.  Enter the perimeter of the section. The program uses this value to estimate 

the side friction contribution for axial analysis. 

o Area. Enter the area of the section. Click on Auto (if available) to let the program 

estimate de area based on the input parameters. Program uses this value to estimate 

the tip resistance contribution for axial analysis and to estimate the contribution to the 

axial stiffness of the pile for axial analysis. 
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o GJ. Enter the product of Shear Modulus and Polar Moment of Inertia of the section (GJ). 

Click on Auto (if available) to let the program estimate the value of GJ based on the 

input parameters. 

o E eq. Enter the equivalent Young’s of the section. Click on Auto (if available) to let the 

program estimate the value of equivalent Young’s Modulus based on the input 

parameters. Program uses this value only to estimate the contribution to the axial 

stiffness of the pile for axial analysis. 

o Mom. Cap.  Capacity in bending moment of the cross section. Used for LRFD Analysis. 

o Shear Cap.  Capacity in shear of the cross section. Used for LRFD Analysis. 

 

• Properties. 

o EIzz set.  Select the nonlinear EI set in the zz direction. Select 0 por an elastic section in 

the zz direction. 

o EIyy set.  Select the nonlinear EI set in the yy direction. Select 0 por an elastic section in 

the yy direction.  

o Izz.  Moment of Inertia in the zz direction. Available only if 0 was selected for the EI zz 

set. 

o Iyy.  Moment of Inertia in the yy direction. Available only if 0 was selected for the EI yy 

set. 

 

 

• Thrust Forces 

o Number Forces.  Number of thrust forces used to compute the moment curvature 

curves. 

o Set values based on Capacity.  Check this option to let the program generate the values 

of axial loads based on the capacity on tension and compression. 

o Set values from max and min.  Check this option to let the program generate the values 

of axial loads based on the maximum and minimum values entered. 

o Enter values manually.  Check this option if the user will enter the values of axial loads.  

o Compression.  Value estimated by the program for the compression capacity of the 

section. To avoid numerical errors the program uses a smaller value (about 5% smaller) 

to generate the axial loads. 

o Tension.  Value estimated by the program for the tensile capacity of the section. To 

avoid numerical errors the program uses a larger value (about 5% larger) to generate 

the axial loads 
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o Maximum.  Maximum value to be used to generate the axial loads if Set values from 

max and min is selected. 

o Minimum.  Minimum value to be used to generate the axial loads if Set values from max 

and min is selected. 

o Include 0 value.  Check this option to include the zero value in the list of axial loads 

generated by the program.  

o Axial Thrust.  The program will automatically compute these values if one of the Set 

values option was selected. Otherwise, user should enter these values. 
 

 

Show Stress Curve 

Click on the Show Stress Curve button to open a window displaying the stress curve used for the 

material which properties are being defined. It could show the stress curve for concrete, steel 

reinforcement or prestressing strand. See Figure 3.53 for an example displaying a concrete curve 

 

      

Figure 3.53  Show Stress Curve Window. 
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Copy Section 

 The option is helpful for when there are cross sections that only have a few differences.  In this 

case, the user can simply copy the section and make the desired changes.  Select the cross section that is 

going to be the source (already defined), and then click on the Copy button to duplicate the data from 

the source.  This option is available if at least two non-linear cross sections have been defined. 

 

Show Diagrams 

Click on the Show Diagrams button to display the nonlinear EI curves for the current section. See Figure 

3.54 for an example displaying a concrete curve.  

 

 

 

Figure 3.54  Show Diagrams Window. 
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Adjust Softening 

Click on the Adjust Softening button to adjust the moment curvature when the moment decreases 

mainly due to initial cracking of the section. See Figure 3.55 for a comparison of the effect of this 

parameter in the moment curvature computed. 

 

  

a) Without Adjust softening   b) With Adjust Softening 

Figure 3.55  Adjust Softening Parameter. 

 

Compute Elastoplastic M-phi (CALTRANS) 

Click on the Compute Elastoplastic M-phi (CALTRANS) button to estimate the equivalent elastoplastic 

moment curvature based on CALTRANS criteria. 

By checking this option, GROUP will use the estimated elastoplastic moment curvature for analysis. 
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Figure 3.56  Compute Elastoplastic Moment Curvature. 

Close Window Button 

Click on the Close Window button to close the window and go back to the Cross Section Definition 

window. 

 

 

 

 

3.3.3 Data - Pile Properties 

 
 This submenu option allows the user to input pile dimensions and section properties 

corresponding to each pile type used in the group analysis.  For each type of pile, the user may enter up 

to 50 sections with different properties.   
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Figure 3.57  Pile Properties Window 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row above the current row. 

• Delete Row.  Delete the current row.   

 

For each pile property (row) the following columns are available: 

 

• Prop.  Type.  This is a sequential number that is provided to each type of pile used in the group 

analysis.  This number is automatically assigned by the program as new types of piles are added.  

The maximum number of pile properties that may be used in a group analysis is limited to 50. 

• Sections.  Clicking the button under Sections in the Pile Properties window brings up the Pile 

Sections window.   

• Increments.  The number of increments in which each pile will be discretized. The maximum 

number of increments that can be defined is 200. 

• Total Length.  The total length specifies the length between the pile head and the pile tip.  This 

number should not include the thickness of the pile cap. 

• Method of Installation.  The user should specify either Driven Piles or Drilled Shafts from the 

pull-down menu. 

 

Pile Sections Window 

      
 

Figure 3.58  Pile Sections Window 
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• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row above the current row. 

• Delete Row.  Delete the current row.   

 

For each pile section (row) the following columns are available: 

 

• Section: This is a sequential number that is provided to each pile section.  This number is 

automatically assigned by the program as new rows are added.  The maximum number of pile 

sections that may be used is limited to 20. 

• Top: This number defines the top coordinate of each pile section being defined.  Local x 

coordinate should be used, so the first pile section of each pile type must always start at level 

zero. 

• Bottom: This number defines the bottom coordinate (local x) of each section of pile being 

defined. 

• Cross Section Index: This column is used to assign a number corresponding to the type of cross 

section used for the current section.  This number must be an integer. Input is limited to a 

maximum of 1000 types of cross sections.  The types of cross sections are defined in the Pile 

Cross Sections submenu under Data. 

 

3.3.4 Data - Pile Group Properties 

 

 This submenu option is used to input the pile group properties.  The input parameters will be 

based on the model whether it is a 2D or 3D 

3.3.4.1 2D Layout 

 

 

 

Figure 3.59  Pile Group Properties Window.  2D Model 
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Depending on the options checked, relevant forms will be available for the user to fill out in this 

window.  Here, the window is shown with all options selected.  Note that a minimum of two subgroups 

of piles is necessary for running analysis; GROUP 2022 will not analyze single piles. 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row above the current row. 

• Delete Row.  Delete the current row.   

 

For each pile subgroup (row) the following columns are available: 

 

• Subgroup.  This is a sequential number that is provided to each pile subgroup.  This number is 

automatically assigned by the program as new pile subgroups are added.  The maximum 

number of pile subgroups that may be used in a group analysis is 2000. 

• Pile-Head Connection.  Clicking on the selection box provides the user with an option for using 

one of three types of pile-head fixities between the pile and the pile-cap (See Figure 3.60) for all 

the piles in a particular subgroup (i.e. for each input row): 

o Pinned.  Provides restraints against translational but not rotational movement.   

o Fixed.  Provides restraint against all movement. 

o Elastically-Restrained.  Provides restraint against translational movement but includes a 

rotational spring.  When the user selects this option as a pile-head fixity, the rotational-

spring stiffness must be entered in the “Rotational Spring” column.  This value must be 

in units of torque (force times length per unit radian of rotation). 

• Number of Piles.  Used to assign the number of piles that form each pile subgroup.  At least one 

pile must be present in each pile subgroup.  The maximum number of piles in each subgroup is 

limited to 100. 

• Pile Prop.  Type.  Used to assign a number corresponding to the type of pile that forms each pile 

subgroup.  The type of pile generally changes with variations in cross-sectional dimensions 

and/or materials.  Only one type of pile may be used in each subgroup.  The maximum number 

of pile types in a group run is limited to 50.  The types of pile properties are defined in 

Data→Pile Properties. 

• Soil Resistance (p-y) Curve Set.  In this column, the user types a number that corresponds to the 

set of curves of lateral-load versus deflection that will be used for the piles in each subgroup 

row.  This number must be an integer. Input is limited to a maximum of 50 sets of soil-resistance 

curves.  The points defining these curves should be specified in the Data→Sets of Soil-

Resistance (p-y) Curves) menu.  This column is available if the user selects Options→Enter User 

Defined Soil Resistance (p-y) curves.  Leave the number as 0 if the user wants to use an 

internally generated p-y curve based on the soil layer properties for the current pile.  Enter a 

negative value if the set is intended to be used only for the layer assigned as a User Defined p-y 

curve under the Soil Layer Data. 
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• Axial Load-Settle. Curve Set.  In this column, the user types a number that corresponds to the 

set of curves of axial load versus displacement that will be used for the piles of  each subgroup 

row.  This number must be an integer and is limited to a maximum of 50 sets of load-

displacement curves.  The points defining these curves should be specified in Data→Sets of 

Axial Load-Displacement Curves.  This column is available if the user selects Options→Enter 

User Defined Load-Displacements curves.  Program GROUP 2022 allows internally generated 

load-displacement curves to be mixed with external (user-input) curves in different pile 

subgroups.  Leave the number as 0 if the user wants to use an internally generated load 

displacement curve based on the soil layer properties for the current pile. 

• Rotational Spring.  This input depends on the type of restraint selected for the pile-head 

connections to the pile cap in each subgroup.  It will only be taken into account if the user 

selects an elastically-restrained type of pile-head connection.  In all other cases (i.e.  fixed and 

pinned connections), the values on this column are ignored and may be left as the default of 

zero.  The values for spring stiffness must be in units of torque (force times length per unit 

radian of rotation). 

• Pile-to-Pile Space.  The values in this column should reflect the common center-to-center 

distance between piles of the same subgroup.  The program requires that all piles of the same 

subgroup are separated by equal distances to their center lines.  It is not necessary to specify 

the spacing of the piles in the same subgroup if users input their own p-y modification factors or 

if the user chooses to ignore group effects. 

• P-Multiplier.  The p-multiplier values may be larger or smaller than one.  However, in most cases 

these values are smaller than one to account for the group effect of closely-spaced piles.  

Chapter 6 in the Technical Manual, “Reduction Factor for Soil Resistance in a Closely-Spaced Pile 

Group,” addresses this issue.  This column is available if the user selects the Specify option in 

Options→Reduction Factors for Lateral Loads. 

• Y-Multiplier.  The y-multiplier values may be larger or smaller than one.  However, in most cases 

these values are larger than one to account for the group effect of closely-spaced piles.  Chapter 

6 in the Technical Manual, “Reduction Factor for Soil Resistance in a Closely-Spaced Pile Group,” 

addresses this issue.  This column is available if the user selects the Specify option in 

Options→Reduction Factors for Lateral Loads. 

• Red.  Factor Axial Load.  Under default conditions, group-reduction factors will not be 

considered for axial loading.  This column is available if the user selects Options→Reduction 

Factors for Axial Loads.  The user may enter a different reduction factor for each pile subgroup.  

Information regarding "Reduction Factor for Piles Under Axial Loading in a Closely-Spaced Pile 

Group" is included in Chapter 7 of the Technical Manual. 

• Set of Lateral Red.  Factor Along Depth.  Under default conditions, lateral reduction factors 

along depth will not be considered.  This column is available if the user selects 

Options→Reduction Factors for Lateral Loads Along Depth.  The user may enter a different set 

for each pile subgroup.  
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Figure 3.60  Pile Head Connections 
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3.3.4.2 3D Layout 

 

 

   

 

 

Figure 3.61  Pile Group Properties Window.  3D Model 

 



CHAPTER 3    References for Data Input     3-70 

 

GROUP 2022 for Windows User's Manual 
 

 The Pile Group Properties window is shown above with all options activated and split into two 

for size reasons.  Aside from the inclusion of input parameters for the y and z-axis for the Pile Head 

Connection, Rotational Spring, P-Multiplier, and Y-Multiplier, and the inclusion of the Torque-Rotation 

Curve Set, this window is identical to the one for the 2D layout. 

• Torque-Rotation Curve Set: In this column, the user types a number that corresponds to the set 

of curves of torque-rotation that will be used for each individual pile.  This number must be an 

integer and is limited to a maximum of 50 sets of torque-rotation curves.  The points defining 

these curves should be later specified in Data→Sets of Torque-Rotation Curves.  This column is 

available if the user selects Options→Enter User Defined Torque-Rotation.  Program GROUP 

2022 allows internally generated torque-rotation curves to be mixed with external (user-input) 

curves in different pile subgroups.  Leave the number as 0 if the user wants to use internally 

generated torque-rotation curves based on the soil layer properties. 

 

3.3.5 Data - Pile-Head Coordinates 

 

 This submenu option is used to input the pile head coordinates.  The input parameters will be 

based on whether the model is 2D or 3D.  A review of the theory used by this program is included in 

Chapter 6 of the Technical Manual.   
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3.3.5.1 2D Layout 

 

  

Figure 3.62  Pile Head Coordinates Window.  2D Model 

 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row above the current row. 

Delete Row.  Delete the current row.   

 

For each pile (row) the following columns are available: 

 

• Pile-Top Vertical X-Coordinate.  Determines the vertical position of a typical pile head for each 

subgroup.  The sign convention is established as positive being downwards from the global 

origin of coordinates.  The user must determine the global origin of coordinates based on the 

points of load application to the pile group.  In most applications, as shown in Figure 3.63, the 

loads will be applied at the top-middle location of the pile cap.  The global origin of coordinates 

is thus established at that point.  Figure 3.63 also describes the local coordinates of pile 
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subgroups. Please note that if the pile head is embedded in the soil, the pile top vertical X 

coordinate should be located within the first soil layer. This is necessary in order to properly 

evaluate the possibility of wedge failure in the top layer. 

• Pile-Top Horizontal Y-Coordinate.  Determines the horizontal position of a typical pile head for 

each subgroup.  The sign convention is established as positive to the right of the global origin of 

coordinates (X-axis in Figure 3.63).  The example shown in Figure 3.63 thus indicates that pile 

subgroups 1 and 2 would have negative numbers for their Pile-Top Horizontal Y-Coordinate 

values.  In the same example, pile subgroups 3 and 4 would have positive values. 

• Batter Angle.  Determines the batter angle of piles in each subgroup.  The batter angle is 

defined as positive if the pile axis is counterclockwise from the downward vertical direction.  

Thus, the pile tip for a pile with positive batter will be to the right of the pile head.  The batter 

angle must be entered in degrees.   

 
 For reference, some commonly-used batter angles are listed below. 
 
  

Batter Ratio Batter Angle 
(radians) 

Batter Angle 
(degrees) 

12:1 0.0831 4.764 

10:1 0.0997 5.711 

8:1 0.1244 7.125 

7:1 0.1419 8.130 

6:1 0.1651 9.462 

5:1 0.1974 11.310 

4:1 0.2450 14.036 

3:1 0.3218 18.435 

    
Table 3.3  Commonly used batter angles 

 

• Vertical Distance from Pile Top to Ground Line.  This number defines the vertical distance (in 

the global X direction) to the ground line from the top of the typical pile of each subgroup.  The 

sign conventions are established as positive downward.  A negative value indicates that the pile 

head is below ground level.  A value of zero indicates that the top of the pile is aligned with the 

ground surface.  All pile subgroups of the example shown in Figure 3.63 would thus need 

positive entries in this column. 

This distance is also used to simulate a group of piles on sloped ground.  An illustration for this 

case is shown in Figure 3.64.  GROUP allows this option only if the distance from pile top to 

ground surface for all the piles are located within the top soil layer.   
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Figure 3.63  Example of a 2D model 

 For the example in Figure 3.63, the following signs would apply for the general location of their 

pile heads and batter angle: 

 
 
 
 
 
 
 
 
 

Pile Subgroup Vertical 
Coordinate 

Horizontal 
Coordinate 

Batter 
Angle 

Distance from Pile 
Top to Ground Line 

1 (+) (-) (-) (+) 

2 (+) (-) 0 (+) 

3 (+) (+) 0 (+) 

4 (+) (+) (+) (+) 

 
Table 3.4  Signs for coordinates and batter angles for an example of a 2D model 
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Figure 3.64  Distance from pile top to ground line to simulate slopping ground 
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3.3.5.2 3D Layout 

 

   

Figure 3.65  Pile Head Coordinates Window.  3D Model 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row above the current row. 

• Delete Row.  Delete the current row.   

 

 For each pile (row) the following columns are available: 

 

• Pile-Top Vertical X- Coordinate.  Determines the vertical position of a typical pile head for each 

pile.  The sign convention is established as positive downwards from the global origin of 

coordinates.  The user must determine the global origin of coordinates. 
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• Pile-Top Horizontal Y-Coordinate.  Determines the horizontal position along Y direction of a 

typical pile head for each pile.   

• Pile-Top Horizontal Z-Coordinate.  Determines the horizontal position along the Z-direction of a 

typical pile-head for each pile.   

• Angle 𝜶.  Determines the angle between the Y-axis and the projection of each pile on the Y-Z 

plane.  The angle must be entered in degrees.  Enter zero for vertical piles. 

• Angle 𝜷.  Determines the batter angle between the projection of piles on the Y-Z plane and the 

pile axis of each pile.  The batter angle must be entered in degrees.  Enter 90 for vertical piles. 

• Angle 𝜽.  Define the rotation angle of the section respect to the local x axis.  Enter 0 if no 

rotation is needed. 

• Vertical Distance from Pile Top to Ground Line.  Defines the vertical distance (in the global X 

direction) to the ground line from the top of the typical pile of each subgroup.  The sign 

conventions are established as positive downwards.  A negative value indicates that the pile 

head is below ground level.  A value of zero indicates that the top of the pile is aligned with the 

ground surface.   

 
Note on local axes 
 

 The local axes for each pile are defined as follow: 

- Local x-axis is along the pile.  Positive direction is defined from the top of the pile to the pile tip. 

- Local y and z-axis are perpendicular to the pile axis.   

 

 
 

Figure 3.66  Local Axes Definition 

 
 The orientation of the local axes depends on the batter angle (2D model) or the α and β angles 

for 3D modes.  For 2D models the local z-axis is always in the direction of the Global Z-axis.  So, the local 
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x and y-axes will be always in the plane XY.  Two examples showing the orientation of the local axes (x, 

y) in terms of the global axes (X, Y) are presented in Figure 3.67.  For 2D models, general equations to 

estimate the orientation of the local axes (x, y, z) in terms of the global axes (X, Y, Z) are presented in 

Figure 3.68. 

 

 
 

Figure 3.67  Local Axes for 2D models 

 
 

   Tx 0)sin()cos( =  

 

   Ty 0)cos()sin( −=  

 

   Tz 100=  

 
Figure 3.68  Equations to estimate orientation for local axes.  2D Model 

 
 Examples showing the orientation of the local axes (x, y, z) in terms of the global axes (X, Y, Z) 

are presented from Figure 3.69 to Figure 3.73 (section rotation angle is defined as zero).  For 3D models, 

general equations to estimate the orientation of the local axes (x, y, z) in terms of the global axes (X, Y, 

Z) are presented in Figure 3.74  
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Figure 3.69  Local Axes for Horizontal Piles.  3D model 

 
 

 
 

Figure 3.70  Local Axes for Vertical Piles.  3D model 
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Figure 3.71  Local Axes for Batter Piles in the XY plane.  3D model 

 
 

 
 

Figure 3.72  Local Axes for Batter Piles in the XZ plane.  3D model 
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Figure 3.73  Local Axes for Batter Piles.  General Orientation.  3D model 

 
 
 

   Tx )sin()cos()cos()cos()sin( =  

 

   Ty )sin()sin()cos()sin()cos( −=  

 

   Tz )cos()sin(0 −=  

 
Figure 3.74  Equations to estimate orientation for local axes, no section rotation.  3D Model 
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   Tx )sin()cos()cos()cos()sin( =  

 

   T
y )sin()cos()cos()sin()sin()sin()sin()cos()cos()sin()cos()cos(  +−−=

 
 

   T
z )cos()cos()sin()sin()sin()cos()sin()sin()cos()sin()sin()cos(  +−−−=

 
 

Figure 3.75  Equations to estimate orientation for local axes, including section rotation.  3D Model 

 
 

3.3.6 Data - Pile-Cap Options 

 

 This submenu option is used to input the pile-cap dimensions.  It is also used to check the option 

for embedment of the pile-cap. 
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Figure 3.76  Pile-Cap Options Window 

 

 Check on the Regular option to draw the pile cap as a rectangular or circular shape. If this entry 

is selected, the user may enter the values for dimensions in the Y direction, Z direction and thickness for 

a rectangular shape, or the diameter and thickness for a circular shape (Only 3D models).  

 Check on the General Shape option to draw the pile cap as a general shape. The program will 

draw the pile cap as a combination of concave regions. If this entry the selected the program will show 

the values in the Y direction, Z direction and thickness based on the coordinates entered.  

 Check on the Circular Shape option if the user wants to draw the pile cap as circular.  
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 Check on the Pile-Cap Embedded option only if the user intends to take into account the 

passive-earth resistance of the soil existing in front of the pile cap.  If the pile cap is not embedded into a 

permanent-soil stratum, or if the user does not want to include the passive-earth pressure because of 

erosion or other consideration, this option should not be checked.  

 When using embedded pile caps, GROUP automatically modifies the internally generated p-y 

curves according to the soil overburden pressure.  The GROUP program cannot use a user-input p-y 

curve to account for the passive resistance against embedded pile caps.  Note that the additional axial 

loading on top of the pile cap due to the weight of soil above is not computed by the GROUP program.  If 

necessary, users must complete and add this load to their axial compression loads on top of the pile cap. 

 For embedded pile caps, in 3-D analyses the “length” dimension of an embedded pile cap 

corresponds to the Y-direction.  The “width” dimension thus corresponds to the Z-direction. The user 

may enter an equivalent diameter for the pile cap under the Eq. Diameter field. If this value is left as 

zero, the program will use the dimension in Z direction for 2D models, the diagonal of dimensions in Y 

and Z directions for 3D rectangular models and the diameter for 3D circular models.  

 If the option Reduction Factor for Lateral Loads Alond Depth (under the Options Menu Item) is 

checked, the user may enter the set under under Set. Red. Fact. Along Depth that can be used also for 

soil resistance in the embedded cap..  

 

 

Method of Analysis 

 A description of the method of computation for the passive-earth pressure is presented in 

Chapter 8 of the Technical Manual.   

The program can consider the passive pressure either as a concentrated lateral force (equivalent 

lateral load) or using equivalent lateral spring along the thickness of the cap. Click on Applying an 

equivalent lateral load to use a concentrated lateral force or on Applying equivalent lateral springs to 

use lateral springs along the thickness. For the second option, the user should enter a number on 

increments to apply the lateral springs, the default value is 10, being the maximum 20. The second 

option may be used to improve the convergence, particularly in cases of small lateral deformations. 

 

 The program will use the dimensions for the tridimensional representation of the model.  If the 

user does not include these values, the program will assume those dimensions based on the pile group 

configuration 
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General Shape 

 After selecting General Shape and Clicking on Geometry Coordinates, the program will show the 

Cap Surface Window. This window is used to define the number of concave surfaces needed to define 

the Pile Cap Geometry. Then click under Pile Cap Coordinates to open the Pile Cap Coordinates Window. 

In the Pile Cap Coordinates Window, the specific surface is defined. For each node, enter the Y and Z 

coordinates and the vertical coordinates (X) for the top and bottom of the pile cap. The pile cap shown 

in Figure 3.77 was drawn by defining 5 cap surfaces (presented in Figure 3.78).  

 

 

  

 

Figure 3.77  Pile-Cap Options. General Shape  

 
 

 

1 
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Figure 3.78  Pile-Cap Options. General Shape  

 

3.3.7 Data – Node Data (Pile-Cap)– Flexible Cap Version 

 

 This submenu option is used to enter and/or edit the Node Data that belongs to the flexible cap.  

 

 

1 

2 3 

4 
5 
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3.3.7.1 Data – Node Data (Pile-Cap) - Node Coordinates – Flexible Cap Version 

 

 This submenu option is used to open the Node Coordinates Window that allows to input and or 

edit the node coordinates of the finite element mesh that defines the flexible cap.  

 

   

Figure 3.79  Node Coordinates Window – Flexible Cap Version 

 

 For each row the following columns are available: 

• Node Number.  Enter the node number assigned to the defined node. 

• X Coord. Enter the value of the coordinate X for the defined node. 

• Y Coord. Enter the value of the coordinate Y for the defined node. 

• Z Coord. Enter the value of the coordinate Y for the defined node. 
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The maximum number of rows defining nodes is limited to 10000. 

 The following options are available: 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the currently selected one. 

• Delete Row.  Delete the selected row. 

Enter the path of the file name under File Name: entry, if user wants to paste the values from a 

text file. Click on the Browse button to browse for the file containing the data. After selecting the file 

the program will filled the File Name entry with the selected file. Click on the View/Edit button to view 

the text file using the default word processor, usually Notepad. Click on the Read values from File 

button to paste the values from the selected file. By using this option, the program will replace all the 

values already defined. If the number of columns (per row) in the selected file is not equal to the 

columns needed (4), the program will not paste any values 

By clicking on the Paste values from Clipboard (text) button, the program will paste the values 

from the clipboard. By using this option, the program will replace all the values already defined. If the 

number of columns (per row) in the clipboard is not equal to the columns needed (4), the program will 

not paste any values. 

By clicking on the Copy values to Clipboard (comma separated) button, the program will copy 

the specified data to the clipboard.  

 

 

3.3.8 Data – Plate Data (Pile-Cap) – Flexible Cap Version 

 

 This submenu option is used to enter and/or edit the Plate Data that belomgs to the flexible cap.  

 

3.3.8.1 Data – Plate Data (Pile-Cap) – Plate Connectivity – Flexible Cap Version 

 

 This submenu option is used to open the Plate Connectivity Window that allows to input and or 

edit the material index property and the plate connectivity of the finite element mesh that defines the 

flexible cap.  
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Figure 3.80  Plate Connectivity Window – Flexible Cap Version 

 

For each row the following columns are available: 

• Plate Number.  Enter the plate number assigned to the defined plate. 

• Plate Section Number.  Enter the section number of the plate properties to be used for the 

defined plate. The section properties are defined under Data->Plate Data->Plate Sections. 

• Node 1. Enter the node number for Node 1 for the defined plate. 

• Node 2. Enter the node number for Node 2 for the defined plate. 

• Node 3. Enter the node number for Node 3 for the defined plate. 

• Node 4. Enter the node number for Node 4 for the defined plate. 

 

The maximum number of rows defining plates is limited to 10000. 

 The following options are available: 
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• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the currently selected one. 

• Delete Row.  Delete the selected row. 

 

Enter the path of the file name under File Name: entry, if user wants to paste the values from a 

text file. Click on the Browse button to browse for the file containing the data. After selecting the file 

the program will filled the File Name entry with the selected file. Click on the View/Edit button to view 

the text file using the default word processor, usually Notepad. Click on the Read values from File 

button to paste the values from the selected file. By using this option, the program will replace all the 

values already defined. If the number of columns (per row) in the selected file is not equal to the 

columns needed (6), the program will not paste any values 

By clicking on the Paste values from Clipboard (text) button, the program will paste the values 

from the clipboard. By using this option, the program will replace all the values already defined. If the 

number of columns in the clipboard (per row) is not equal to the columns needed (6), the program will 

not paste any values. 

By clicking on the Copy values to Clipboard (comma separated) button, the program will copy 

the specified data to the clipboard.  

 

The program uses a 4-node element for plates, which is displayed in the figure below. 

 

 

Figure 3.81  Plate Connectivity Numbering 



CHAPTER 3    References for Data Input     3-90 

 

GROUP 2022 for Windows User's Manual 
 

 

3.3.8.2 Data – Plate Data (Pile-Cap) – Plate Offsets – Flexible Cap Version 

 

 This submenu option is used to open the Plate Offsets Window that allows to input and or edit 

the element offsets in the X, Y and Z directions. Please note that the program will add a rigid element at 

each node in order to model the offsets. 

 

     

Figure 3.82  Plate Offsets Window – Flexible Cap Version 

 

For each row the following columns are available: 

• Offset X. Enter the value for offset of the plate in the X direction. 

• Offset Y. Enter the value for offset of the plate in the Y direction. 

• Offset Z. Enter the value for offset of the plate in the Y direction. 
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Similarly to plate connectivity, the maximum number of rows defining plate offsets is limited to 10000. 

 The following options are available: 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the currently selected one. 

• Delete Row.  Delete the selected row. 

 

Enter the path of the file name under File Name: entry, if user wants to paste the values from a 

text file. Click on the Browse button to browse for the file containing the data. After selecting the file 

the program will filled the File Name entry with the selected file. Click on the View/Edit button to view 

the text file using the default word processor, usually Notepad. Click on the Read values from File 

button to paste the values from the selected file. By using this option, the program will replace all the 

values already defined. If the number of columns (per row) in the selected file is not equal to the 

columns needed (3), the program will not paste any values 

By clicking on the Paste values from Clipboard (text) button, the program will paste the values 

from the clipboard. By using this option, the program will replace all the values already defined. If the 

number of columns in the clipboard (per row) is not equal to the columns needed (3), the program will 

not paste any values. 

By clicking on the Copy values to Clipboard (comma separated) button, the program will copy 

the specified data to the clipboard.  

 

 

Offsets is an option for the user to define the axis of the element is not in the same position of 

the node. An example of the use of offsets is presented in the next figure. 
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Figure 3.83  Example Plate Offsets – Flexible Cap Version 

 

 
 

3.3.8.3 Data – Plate Data (Pile-Cap) – Plate Sections – Flexible Cap Version 

 

 This submenu option is used to open the Plate Section Properties Window that allows to input 

and or edit the material and geometric properties of the plates that defines the flexible cap.  

 

       

Figure 3.84  Plate Section Properties Window – Flexible Cap Version 

 

For each row the following columns are available: 
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• Young Modulus. Enter the value for the modulus of elasticity of the plate material. 

• Poisson Ratio. Enter the value for the poisson ratio of the plate material. 

• Plate Thickness. Enter the value for plate thickness. 

• Thin Plate?. Select whether is a thick or thin plate. For a thin plate, shear deformation of the 

plate will not be taken into account. 

 

The maximum number of rows defining plate sections is limited to 20. 

 The following options are available: 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the currently selected one. 

• Delete Row.  Delete the selected row. 

 

Enter the path of the file name under File Name: entry, if user wants to paste the values from a 

text file. Click on the Browse button to browse for the file containing the data. After selecting the file 

the program will filled the File Name entry with the selected file. Click on the View/Edit button to view 

the text file using the default word processor, usually Notepad. Click on the Read values from File 

button to paste the values from the selected file. By using this option, the program will replace all the 

values already defined. If the number of columns (per row) in the selected file is not equal to the 

columns needed (4), the program will not paste any values 

By clicking on the Paste values from Clipboard (text) button, the program will paste the values 

from the clipboard. By using this option, the program will replace all the values already defined. If the 

number of columns in the clipboard (per row) is not equal to the columns needed (4), the program will 

not paste any values. 

By clicking on the Copy values to Clipboard (comma separated) button, the program will copy 

the specified data to the clipboard.  

 

 

3.3.9 Data – Beam Data (Pile-Cap) – Flexible Cap Version 

 

 This submenu option is used to enter and/or edit the Plate Data that belomgs to the flexible cap.  
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3.3.9.1 Data – Beam Data (Pile-Cap) – Beam Connectivity – Flexible Cap Version 

 

 This submenu option is used to open the Beam Connectivity Window that allows to input and or 

edit the beam section number and the beam connectivity of the beam elements that belongs to the 

flexible cap.  

 

     

Figure 3.85  Beam Connectivity Window – Flexible Cap Version 

 

For each row the following columns are available: 

• Beam Number.  Enter the beam number assigned to the defined plate. 

• Beam Section Number.  Enter the section number of the cross section properties to be used for 

the defined beam. The section properties are defined under Data->Pile/Beam Cross Sections. 

The beam section number must be elastic. 

• Node 1. Enter the node number for Node 1 for the defined beam. 

• Node 2. Enter the node number for Node 2 for the defined beam. 

 

The maximum number of rows defining plates is limited to 10000. 
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 The following options are available: 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the currently selected one. 

• Delete Row.  Delete the selected row. 

 

Enter the path of the file name under File Name: entry, if user wants to paste the values from a 

text file. Click on the Browse button to browse for the file containing the data. After selecting the file 

the program will filled the File Name entry with the selected file. Click on the View/Edit button to view 

the text file using the default word processor, usually Notepad. Click on the Read values from File 

button to paste the values from the selected file. By using this option, the program will replace all the 

values already defined. If the number of columns (per row) in the selected file is not equal to the 

columns needed (4), the program will not paste any values 

By clicking on the Paste values from Clipboard (text) button, the program will paste the values 

from the clipboard. By using this option, the program will replace all the values already defined. If the 

number of columns in the clipboard (per row) is not equal to the columns needed (4), the program will 

not paste any values. 

By clicking on the Copy values to Clipboard (comma separated) button, the program will copy 

the specified data to the clipboard.  

 

The program uses the 2-node beam element which is displayed in the figure below. 

 

  

Figure 3.86  Beam Connectivity Numbering 
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3.3.9.2 Data – Beam Data (Pile-Cap) – Beam Offsets – Flexible Cap Version 

 

 

 This submenu option is used to open the Beam Offsets Window that allows to input and or edit 

the beam offsets in the X, Y and Z directions. Please note that the program will add a rigid element at 

each node in order to model the offsets. 

 

      

Figure 3.87  Beam Offsets Window – Flexible Cap Version 

 

For each row the following columns are available: 

• Offset X. Enter the value for offset of the beam in the X direction. 

• Offset Y. Enter the value for offset of the beam in the Y direction. 

• Offset Z. Enter the value for offset of the beam in the Y direction. 

 

Similarly to beam connectivity, the maximum number of rows defining beam offsets is limited to 10000. 

 The following options are available: 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the currently selected one. 

• Delete Row.  Delete the selected row. 
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Enter the path of the file name under File Name: entry, if user wants to paste the values from a 

text file. Click on the Browse button to browse for the file containing the data. After selecting the file 

the program will filled the File Name entry with the selected file. Click on the View/Edit button to view 

the text file using the default word processor, usually Notepad. Click on the Read values from File 

button to paste the values from the selected file. By using this option, the program will replace all the 

values already defined. If the number of columns (per row) in the selected file is not equal to the 

columns needed (3), the program will not paste any values 

By clicking on the Paste values from Clipboard (text) button, the program will paste the values 

from the clipboard. By using this option, the program will replace all the values already defined. If the 

number of columns in the clipboard (per row) is not equal to the columns needed (3), the program will 

not paste any values. 

By clicking on the Copy values to Clipboard (comma separated) button, the program will copy 

the specified data to the clipboard.  

 

 

Offsets is an option for the user to define the axis of the element is not in the same position of 

the node. An example of the use of offsets is presented in the next figure. 

 

 

  

Figure 3.88  Example Beam Offsets – Flexible Cap Version 
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3.3.9.3 Data – Beam Data (Pile-Cap) – Beam End Zones – Flexible Cap Version 

 

 This submenu option is used to open the Beam Offsets Window that allows to input and or edit 

the beam End Zones at Node1 and Node 2 . Please note that the program will add a flexural rigid 

element to model the end zones.  

 

       

Figure 3.89  Beam End Zones Window – Flexible Cap Version 

 
For each row the following columns are available: 

• Node 1 End Zone. Enter the value for end zone of the beam at node 1. 

• Node 2 End Zone. Enter the value for end zone of the beam at node 2. 

 

Similarly to beam connectivity, the maximum number of rows defining beam end zones is limited to 

10000. 

 The following options are available: 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the currently selected one. 
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• Delete Row.  Delete the selected row. 

 

Enter the path of the file name under File Name: entry, if user wants to paste the values from a 

text file. Click on the Browse button to browse for the file containing the data. After selecting the file 

the program will filled the File Name entry with the selected file. Click on the View/Edit button to view 

the text file using the default word processor, usually Notepad. Click on the Read values from File 

button to paste the values from the selected file. By using this option, the program will replace all the 

values already defined. If the number of columns (per row) in the selected file is not equal to the 

columns needed (2), the program will not paste any values 

By clicking on the Paste values from Clipboard (text) button, the program will paste the values 

from the clipboard. By using this option, the program will replace all the values already defined. If the 

number of columns in the clipboard (per row) is not equal to the columns needed (2), the program will 

not paste any values. 

By clicking on the Copy values to Clipboard (comma separated) button, the program will copy 

the specified data to the clipboard.  

 
 

 An example of the behavior of beam end zones is presented in the next figure. 

 

 

    

Figure 3.90  Beam End Zones – Flexible Cap Version 
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3.3.9.4 Data – Beam Data (Pile-Cap) – Beam Section Rotation – Flexible Cap Version 

 

 This submenu option is used to open the Beam Section Rotation Window that allows to input 

and or edit the beam section rotation .  

 

       

Figure 3.91  Plate Offsets Window – Flexible Cap Version 

 

 
For each row the following columns are available: 

• Section Rotation. Enter the value for section rottaion of the beam. 

 

Similarly to beam connectivity, the maximum number of rows defining beam section rotation is limited 

to 10000. 

 The following options are available: 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the currently selected one. 

• Delete Row.  Delete the selected row. 
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Enter the path of the file name under File Name: entry, if user wants to paste the values from a 

text file. Click on the Browse button to browse for the file containing the data. After selecting the file 

the program will filled the File Name entry with the selected file. Click on the View/Edit button to view 

the text file using the default word processor, usually Notepad. Click on the Read values from File 

button to paste the values from the selected file. By using this option, the program will replace all the 

values already defined. If the number of columns (per row) in the selected file is not equal to the 

columns needed (1), the program will not paste any values 

By clicking on the Paste values from Clipboard (text) button, the program will paste the values 

from the clipboard. By using this option, the program will replace all the values already defined. If the 

number of columns in the clipboard (per row) is not equal to the columns needed (1), the program will 

not paste any values. 

By clicking on the Copy values to Clipboard (comma separated) button, the program will copy 

the specified data to the clipboard.  

 
 

 

 An example of the use of section rotation is presented in the next figure. 

 

 

    

Figure 3.92  Beam Section Rotation – Flexible Cap Version 
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3.3.10 Data – Springs (Pile-Cap) – Flexible Cap Version 

 

 This submenu option is used to enter and/or edit the Plate Data that belomgs to the flexible cap.  

 

3.3.10.1 Data – Springs (Pile-Cap) – Concentrated Springs at Nodes – Flexible Cap Version 

 

This submenu option is used to open the Concentrated Springs at Nodes Window.  

 In this window the user can define concentrated springs applied at nodes which belong to the 

finite element mesh defining the flexible pile cap.  The load case number and name are displayed at the 

top of the window.  A sample of this window is shown in Figure 3.93. 

 

            

 

Figure 3.93  Concentrated Springs at Nodes Window -Flexible Cap Version 

 

Concentrated Springs at Nodes 

 The maximum number of rows defining concentrated load at nodes for each load case is limited 

to 1000. 
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• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the currently selected one. 

• Delete Row.  Delete the selected row. 

• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a row. 

 

 For each row the following columns are available: 

• Node/Set.  Enter the node number or the Node Set to which the concentrated springs will be 

applied. If a Node Set is entered, the values for End and Incr. will be ignored. 

• End.  For a sequence of nodes, enter the highest node number to which the concentrated spring 

will be applied.  For a single node enter zero in this column.  

• Incr.  For a sequence of nodes, enter the increment on node number to get the intermediate 

node numbers on the sequence to which the concentrated springs will be applied.  For a single 

node enter zero in this column.  

• SPx.  Enter the value for the concentrated spring in the x direction. 

• SPy.  Enter the value for the concentrated spring in the y direction. 

• SPz.  Enter the value for the concentrated spring in the z direction. 

• SPxx.  Enter the value for the concentrated rotational spring in the x direction. 

• SPyy.  Enter the value for the concentrated rotational spring in the y direction. 

• SPzz.  Enter the value for the concentrated rotational spring in the z direction. 

 

By clicking on the Paste Values (From Clipboard) button, the program will paste the 

concentrated springs at nodes from the clipboard. By using this option, the program will replace all the 

values already defined. If the number of columns in the clipboard is not equal to the columns needed 

(9), the program will not paste any values. 

By clicking on the Copy Values (To Clipboard) button, the program will copy the concentrated 

springs data to the clipboard.  

 

Close Button 

 Click on the Close button to close the window and go back to the Edit Load Case window. 
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3.3.10.2 Data – Springs (Pile-Cap) – Distributed Springs on Plates – Flexible Cap Version 

 

This submenu option is used to open the Distributed Springs on Plates Window.  

 In this window the user can define distributed springs applied on plates which belong to the 

finite element mesh defining the flexible pile cap.  The load case number and name are displayed at the 

top of the window.  A sample of this window is shown in Figure 3.94. 

 

           

 

Figure 3.94  Distributed Springs on Plates Window - Flexible Cap Version 

 

Distributed Springs on Plates 

 The maximum number of rows defining distributed load on plates for each load case is limited to 

1000. 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the currently selected one. 

• Delete Row.  Delete the selected row. 

• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a row. 
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 For each row the following columns are available: 

• Plate/Set.  Enter the plate number or the Plate Set to which the distributed springs will be 

applied. If a Plate Set is entered, the values for End and Incr. will be ignored. 

• End.  For a sequence of plates, enter the highest plate number to which the distributed spring 

will be applied.  For a single plate enter zero in this column.  

• Incr.  For a sequence of plates, enter the increment on plate number to get the intermediate 

plate numbers on the sequence to which the distributed spring will be applied.  For a single 

plate enter zero in this column.  

• D.SPx.  Enter the value for the distributed spring in the x direction. 

• D.SPy.  Enter the value for the distributed spring in the y direction. 

• D.SPz.  Enter the value for the distributed spring in the z direction. 

• D.SPxx.  Enter the value for the distributed rotational spring in the x direction. 

• D.SPyy.  Enter the value for the distributed rotational spring in the y direction. 

• D.SPzz.  Enter the value for the distributed rotational spring in the z direction. 

 

By clicking on the Paste Values (Clipboard) button, the program will paste the distributed 

springs on plates from the clipboard. By using this option, the program will replace all the values already 

defined. If the number of columns in the clipboard is not equal to the columns needed (9), the program 

will not paste any values. 

By clicking on the Copy Values (To Clipboard) button, the program will copy the distributed 

springs data to the clipboard.  

 

Close Button 

 Click on the Close button to close the window and go back to the Edit Load Case window. 

 

 

 

3.3.10.3 Data – Springs (Pile-Cap) – Distributed Springs on Beams – Flexible Cap Version 

 

This submenu option is used to open the Distributed Springs on Beams Window.  
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 In this window the user can define distributed loads applied on beams which belong to the finite 

element mesh defining the flexible pile cap.  The load case number and name are displayed at the top of 

the window.  A sample of this window is shown in Figure 3.95. 

 

              

 

Figure 3.95  Distributed Springs on Beams Window - Flexible Cap Version 

 

Distributed Springs on Beams 

 The maximum number of rows defining distributed springs on beamss for each load case is 

limited to 1000. 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the currently selected one. 

• Delete Row.  Delete the selected row. 

• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a row. 

 

 For each row the following columns are available: 

• Direction.  Select the direction in which the distributed spring will be applied.  The user can 

select along the local or global axes. 
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• Beam/Set.  Enter the plate number or the Beam Set to which the distributed spings will be 

applied. If a Beam Set is entered, the values for End and Incr. will be ignored. 

• End.  For a sequence of beams, enter the highest beam number to which the distributed sping 

will be applied.  For a single beam enter zero in this column.  

• Incr.  For a sequence of beams, enter the increment on beam number to get the intermediate 

beam numbers on the sequence to which the distributed spring will be applied.  For a single 

beam enter zero in this column.  

• D.SPFx.  Enter the value for the distributed spring in the x direction. 

• D.SPy.  Enter the value for the distributed spring in the y direction. 

• D.SPz.  Enter the value for the distributed spring in the z direction. 

• D.SPxx.  Enter the value for the distributed rotational spring in the x direction. 

• D.SPyy.  Enter the value for the distributed rotational spring in the y direction. 

• D.SPzz.  Enter the value for the distributed rotational spring in the z direction. 

 

By clicking on the Paste Values (From Clipboard) button, the program will paste the distributed 

springs on plates from the clipboard. By using this option, the program will replace all the values already 

defined. If the number of columns in the clipboard is not equal to the columns needed (10), the program 

will not paste any values. 

By clicking on the Copy Values (To Clipboard) button, the program will copy the distributed 

springs data to the clipboard.  

 

Close Button 

 Click on the Close button to close the window and go back to the Edit Load Case window. 

 

 
 

 

 

3.3.11 Data - Loading 

 

 This submenu option is needed to input concentrated loading in the pile cap and distributed 

loading along the piles.  Also, this menu option allows the user to define different load cases and load 

combinations for analysis.  By selecting this option, the Loading Definition window will appear. 
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3.3.11.1 Loading Definition Window 

 

 In this window the user can define the load cases.  A sample is shown in Figure 3.96. 

 

   

 

Figure 3.96  Loading Definition Window 

 

 

Load Cases Definition 

 The maximum number of load cases that can be defined is limited to 100. 

• Add Load Case.  Add a new load case at the end of the list. 

• Insert Load Case.  Add a new load case after the selected one. 

• Delete Load Case.  Delete the current load case.   
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• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a load case. 

 

 For each load case (row) the following columns are available: 

•  Load Case.  Click on the Edit Load Case button to open the Edit Load Case window. 

• Load Case Type.  Select the load type consistent with the defined load case.  This is very useful 

for defining load combinations.  The following types can be selected in GROUP 2022 as a load 

case. 

o Dead, DL 

o Live, LL 

o Seismic, EQ 

o Impact, IM 

o Wind, WN 

o Water, WT 

o Ice, IC 

o Soils, Hsl 

o Roof Live, Lr 

o Rain, Rn 

o Snow, Sn 

o Temperature, Tm 

o Special, Sp 

•  Load Case Name.  Enter the name associated with the load case. 

• Scale Factor.  Enter the scale factor to be applied to the load case.  

• Scale Factor.  Check on this option to analyze the load case. 

 

 

 

 

 

 If two or more load cases are defined the program can compute the load case envelopes 

(maximum and minimum effects).  Check the Calculate Load Cases Envelopes option to calculate the 

envelopes.  Also, select the option for output of the calculated envelopes. 

• At pile cap.  Print the equivalent load and displacements of the pile cap at the origin. 

• At pile cap elements (Flexible Cap Version).  Print the displacements at the nodes that belong to 

the flexible pile cap. For plate elements prints the internal forces and stresses at each 

integration point. For beam elements, prints the forces and displacements at some points along 

the beam. 

• At pile heads.  Print for each pile the pile top displacement and reactions in both the pile (local 

axes) and global (global axes) coordinate systems. 
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• Along piles.  Print for each pile its deflection, moment, shear, soil reaction, stress and rigidity 

along the pile.  If this option is selected the user may define the increment in nodes to print the 

response along the piles. 

 Click on the Output Variables Along Piles button to open the Output Variables window for 

defining which variables for results along the pile would like to be printed in the output file for the load 

cases envelopes. 

 

 

 

Load Combinations Definition 

 Click on the Load Combinations button to open the Load Combinations window for defining 

load combinations.  A check mark will show up if at least one load combination has been already 

defined.  This button is disabled if no load cases have been defined. 

 

Close Button 

 Click on the Close button to close the window and go back to the GROUP window. 

 

 

 

 

 

 

 

3.3.11.2 Edit Load Case Window 

 

 In this window the user can define load cases.  The load case number and name are displayed at 

the top of the window.  A sample of this window is shown in Figure 3.97. For a model using a flexible pile 

cap (Flexible Cap Version), a sample window is shown in Figure 3.98.  
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Figure 3.97  Edit Load Case Window 
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Figure 3.98  Edit Load Case Window for a model with a flexible pile cap -Flexible Cap Version 

 

 

Concentrated Loads at Pile Cap 

 Click on the Concentrated Loads at Pile Cap button to open the Concentrated Loads at Pile Cap 

window for definition of concentrated loads acting at the piel cap.  A check mark will appear if at least 

one concentrated load has been already defined for the current load case. 

 

Displacement/Loads at Pile Cap 

 Select  Specify Displacements/Loads at Pile Cap to enable the option to define specified 

displacements at pile cap. Then, click on the Edit Displacements/Loads button to open the Specify 

Displacements/Loads window for definition of the displacements that may be combined with loads at 

the pile cap. When this option is selected the concentrated load at pile cap option becomes inactive. 

Please note that the load case with definition of specified displacement/loads can not be included in any 

load combination. This option is not available if a model is defined using a flexible pile cap (Flexible Cap 

Version) 
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Type of Loading 

 Select Use Cyclic Model por p-y curves if available and enter the Number of Cycles to consider a 

Cyclic Loading.  The type of loading is important to taking into account when analyzing piles under 

lateral loading.  Further reference about the "Influence of Nature of Loading" is included in the Chapter 

"Soil Response Under Natural Loading" of the Technical Manual. 

Cyclic loading is primarily used for storm, wave, or wind loading types.  The main effect from cyclic 

loading is to reduce the soil resistance based on the soil criteria for cyclic p- curves, as described in the 

Technical Manual. 

 

Analysis Options 

 Click on the Edit Analysis Options button to open the Analysis Options window for the 

definition of convergence parameters. 

 

Distributed Lateral Loads on Piles 

 Click on the Edit Distributed Lateral Loads button to open the Distributed Lateral Loads window 

for definition of distributed lateral loads along the pile length.  A check mark will appear if at least one 

distributed lateral load has been already defined for the current load case. 

 

Soil Movement 

 Click on the Edit Soil Movement Data button to open the Soil Movement window for definition 

of soil movement along the piles.  A check mark will appear if at least one soil movement data has been 

already defined for the current load case. 

 

Foundation Stiffness Options 

 Click on the Edit Foundation Stiffness Options button to open the Foundation Stiffness Options 

window, so the user may ask the program to compute the flexibility and/or stiffness matrices for the 

current load case.  A check mark will appear if a foundation flexibility and/or stiffness will be computed 

for the current load case. This option is not available for a load case if the Incremental/Pushover 

Analysis Option is defined. This option is not available if a model is defined using a flexible pile cap 

(Flexible Cap Version) 
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Incremental/PushOver Analysis Options 

 Click on the Edit Incremental/PushOver Options button to open the Incremental/PushOver 

Analysis Options window, so the user may ask the program to perform incremental/pushover analysis 

for the current load case.  A check mark will appear if the incremental/pushover analysis will be 

performed for the current load case. This option is not available for a load case if the Foundation 

Stiffness Option is defined. This option is not available if a model is defined using a flexible pile cap 

(Flexible Cap Version) 

Print Results Options 

 Select the option for outputting the results of the current load case. 

• At pile cap.  Print the equivalent load and displacements of the pile cap at the origin. 

• At pile cap elements (Flexible Cap Version).  Print the displacements at the nodes that belong to 

the flexible pile cap. For plate elements prints the internal forces and stresses at each 

integration point. For beam elements, prints the forces and displacements at some points along 

the beam. 

• At pile heads.  Print for each pile the pile top displacement and reactions in both the pile (local 

axes) and global (global axes) coordinate systems. 

• Along piles.  Print for each pile its deflection, moment, shear, soil reaction, stress and rigidity 

along the pile.  If this option is selected the user may define the increment in nodes to print the 

response along the piles. 

 Click on the Output Variables Along Piles button to open the Output Variables window for 

defining which variables for results along the pile would like to be printed in the output file for the 

current load case. 

 

Copy Load Case 

 The option is helpful when there are load cases with few differences.  So, the user may copy one 

into another and do the required changes as needed.  Select the load case that is going to be the source 

(already defined), and then click on the Copy button to proceed with copying all the load case data to 

the current case.  This option is available if at least two load cases have been defined. 

 

Close Button 

Click on the Close button to close the window and go back to the Loading Definition window. 
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The following options are available for a model using a flexible pile cap (Flexible Cap Version) 

 

Displacement at Nodes 

 Click on Edit Displacements at Nodes button to open the Displacements at Nodes window for 

definition of the displacements at the nodes that belong to the finite element mesh defining the flexible 

pile cap. Please note that the load case with definition of displacement at nodes can not be included in 

any load combination. 

 

Concentrated Loads at Nodes 

 Click on Edit Concentrated Loads at Nodes button to open the Concentrated Loads at Nodes 

window for definition of concentrated loads at the nodes that belong to the finite element mesh 

defining the flexible pile cap.  

 

Distributed Loads on Plates 

 Click on Edit Distributed Loads on Plates button to open the Distributed Loads on Plates 

window for definition of distributed loads on the plates that belong to the finite element mesh defining 

the flexible pile cap.  

 

Distributed Loads on Beams 

 Click on Edit Distributed Loads on Beams button to open the Distributed Loads on Beams 

window for definition of distributed loads on the beams that belong to the finite element mesh defining 

the flexible pile cap.  

 

Concentrated Loads on Beams 

 Click on Edit Concent. Loads on Beams button to open the Concentrated Loads on Beams 

window for definition of concentrated loads on the beams that belong to the finite element mesh 

defining the flexible pile cap.  
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3.3.11.3 Edit Concentrated Loads at Pile Cap Window 

 

 In this window the user can define the concentrated loads applied at the pile cap.  The load case 

number and name are displayed at the top of the window.  A sample of this window is shown in Figure 

3.97. 

 

        

 

Figure 3.99  Concentrated Loads at Pile Cap Window 

 

Concentrated Loads at Pile Cap 

 The maximum number of concentrated loads on a pile cap for each load case is limited to 100. 

• Add Load.  Add a new load at the end of the list. 

• Insert Load.  Add a new load below the currently selected one. 

• Delete Load.  Delete the selected load. 

• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a load. 

 

 For each concentrated load (row) the following columns are available: 
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•  Concentrated Load.  Click on the Edit Load button to open the Concentrated Load window to 

enter the concentrated load and location.  The concentrated load can also be entered in the 

next columns as described below. 

o Fx.  Enter the applied force in the X direction (vertical). 

o Fy.  Enter the applied force in the Y direction (horizontal). 

o Mz.  Enter the applied moment in the Z direction. 

o Fz.  Enter the applied force in the Y direction (horizontal).  Available for 3D analysis. 

o My.  Enter the applied moment in the Y direction.  Available for 3D analysis. 

o Mx.  Enter the applied moment in the X direction (torsional).  Available for 3D analysis. 

 By clicking on the Equiv.  Load button, the program will open the Concentrated Load window, 

which shows the equivalent concentrated load to be applied at the origin of coordinates.  For a model 

with a rigid pile cap, this is the load to be applied for the analysis of the current load case. For a model 

with a flexible pile cap (Flexible Cap Version) each concentrated load will be projected to a location in 

the pile cap for the analysis.  

By clicking on the Paste Values (From Clipboard) button, the program will paste the 

concentrated loads from the clipboard. By using this option, the program will replace all the values 

already defined. If the number of columns in the clipboard is not equal to the columns needed (5 for 2D 

models, and 9 for 3D models), the program will not paste any values. 

By clicking on the Copy Values (To Clipboard) button, the program will copy the concentrated 

loads to the clipboard.  

 

Close Button 

 Click on the Close button to close the window and go back to the Edit Load Case window. 

 

 

3.3.11.4 Concentrated Load Window 

 

 In this window the user may enter the concentrated load at the pile cap level.  Also, this window 

shows the equivalent load at the origin of coordinates for the current load case. 

 For a 3-dimensional model, the user may enter six load components (i.e. vertical load in the X-

direction, lateral load in the Y-direction, lateral load in the Z-direction, moment on the x-y plane,  

moment on the x-z plane, and torsional moment on the y-z plane).  In addition, the user may enter the 

X, Y and Z coordinates of the location of the load.  If the load is at the origin, X, Y and Z coordinates 

should be equal to zero.  A sample of this window is shown in Figure 3.100. 
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Figure 3.100  Concentrated Load Window.  Loading for 3D Analysis 

 

 For a 2-dimensional model, the user may enter three load components (i.e. vertical load in the 

X-direction, lateral load in the Y-direction, and moment on the x-y plane).  In addition, the user may 

enter the X and Y coordinates of the location of the load.  If the load is at the origin, X and Y coordinates 

should be equal to zero.  A sample of this window is shown in Figure 3.101. 
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Figure 3.101  Concentrated Load Window.  Loading for 2D Analysis 

 

 The right-handed Cartesian coordinate system as illustrated in the Concentrated Load window is 

used for both 2-D and 3-D models. 

 It should be noted that for 2-dimensional models, GROUP 2022 uses "positive" for moment 

acting counter-clockwise on the x-y plane in order to be consistent with the right-handed Cartesian 

coordinate system.  It is different from previous versions (v4.0 and earlier).  The user should check the 

sign convention if a data file created by previous versions of GROUP is loaded. 

 

Close Button 

 Click on the Close button to close the window and go back to the Edit Concentrated Loads on 

Pile Cap window. 

 

 

 



CHAPTER 3    References for Data Input     3-120 

 

GROUP 2022 for Windows User's Manual 
 

3.3.11.5 Specified Displacements/Loads Window 

 

 In this window the user may enter specified displacements or concentrated load at the pile cap 

level. This window is not available for a model with a flexible pile cap (Flexible Cap Version). 

 For a 3-dimensional model, the user may enter a combination of 6 boundary conditions 

between displacements or loads at the pile cap (i.e. vertical load or vertical displacement in the X-

direction, lateral load or lateral displacement in the Y-direction, lateral load or lateral displacement in 

the Z-direction, moment or rotation on the x-y plane,  moment or rotation on the x-z plane, and 

torsional moment or rotation on the y-z plane).  In addition, the user may enter the X, Y and Z 

coordinates of the location of the specified boundary condition (displacements and/or loads).  If the 

boundary condition is applied at the origin, X, Y and Z coordinates should be equal to zero.  A sample of 

this window is shown in Figure 3.102. 

 

  

 

Figure 3.102  Specified Displacements/Loads Window.  3D Analysis Case 
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 For a 2-dimensional model, the user may enter a combination of 3 boundary conditions 

between displacements or loads at the pile cap (i.e. vertical load or vertical displacement in the X-

direction, lateral load or lateral displacement in the Y-direction, and moment or rotation on the x-y 

plane).  In addition, the user may enter the X and Y coordinates of the location of the specified boundary 

condition (displacements and/or loads).  If the boundary condition is applied at the origin, X and Y 

coordinates should be equal to zero.  A sample of this window is shown in Figure 3.103. 

 

 

Figure 3.103  Specified Displacements/Loads Window.  2D Analysis Case 

 

 The right-handed Cartesian coordinate system as illustrated in the Specified 

Displacement/Loads window is used for both 2-D and 3-D models. 

 Please note that the load case that includes specified displacement/forces. It should be noted 

that for 2-dimensional models, GROUP 2022 uses "positive" for moment acting counter-clockwise on the 

x-y plane in order to be consistent with the right-handed Cartesian coordinate system.  It is different 

from previous versions (v4.0 and earlier).  The user should check the sign convention if a data file 

created by previous versions of GROUP is loaded. 
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Close Button 

 Click on the Close button to close the window and go back to the Edit Load Case window. 

 

3.3.11.6  Displacement at Nodes Window -Flexible Cap Version 

 

 In this window the user can define displacement at nodes which belong to the finite element 

mesh defining the flexible pile cap.  The load case number and name are displayed at the top of the 

window.  A sample of this window is shown in Figure 3.104. 

 

          

 

Figure 3.104  Displacements at Nodes Window - Flexible Cap Version 

 

Displacement at Nodes 

 The maximum number of rows defining displacement at nodes for each load case is limited to 

1000. 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the currently selected one. 

• Delete Row.  Delete the selected row. 
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• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a row. 

 

 For each row the following columns are available: 

• Node/Set.  Enter the node number or the Node Set to which the specified displacement will be 

applied. If a Node Set is entered, the values for End and Incr. will be ignored. 

• End.  For a sequence of nodes, enter the highest node number to which the specified 

displacement will be applied.  For a single node enter zero in this column.  

• Incr.  For a sequence of nodes, enter the increment on node number to get the intermediate 

node numbers on the sequence to which the specified displacement will be applied.  For a single 

node enter zero in this column.  

• Ux.  Check this column if a specified displacement in the x direction is defined. 

• Value Ux.  Enter the value for the specified displacement in the x direction. If Ux is not checked, 

this value will be ignored. 

• Uy.  Check this column if a specified displacement in the y direction is defined. 

• Value Uy.  Enter the value for the specified displacement in the y direction. If Uy is not checked, 

this value will be ignored. 

• Uz.  Check this column if a specified displacement in the z direction is defined. 

• Value Uz.  Enter the value for the specified displacement in the z direction. If Uz is not checked, 

this value will be ignored. 

• Rx.  Check this column if a specified rotation in the x direction is defined. 

• Value Rx.  Enter the value for the specified rotation in the x direction. If Rx is not checked, this 

value will be ignored. 

• Ry.  Check this column if a specified rotation in the y direction is defined. 

• Value Ry.  Enter the value for the specified rotation in the y direction. If Ry is not checked, this 

value will be ignored. 

• Rz.  Check this column if a specified rotation in the z direction is defined. 

• Value Rz.  Enter the value for the specified rotation in the z direction. If Rz is not checked, this 

value will be ignored. 

 

By clicking on the Paste Values (From Clipboard) button, the program will paste the 

displacement at nodes from the clipboard. By using this option, the program will replace all the values 

already defined. If the number of columns in the clipboard is not equal to the columns needed (15), the 

program will not paste any values. 

By clicking on the Copy Values (To Clipboard) button, the program will copy the specified 

displacements data to the clipboard.  
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Close Button 

 Click on the Close button to close the window and go back to the Edit Load Case window. 

 

 

3.3.11.7 Concentrated Loads at Nodes Window - Flexible Cap Version 

 

 In this window the user can define concentrated loads applied at nodes which belong to the 

finite element mesh defining the flexible pile cap.  The load case number and name are displayed at the 

top of the window.  A sample of this window is shown in Figure 3.105. 

 

           

 

Figure 3.105  Concentrated Loads at Nodes Window -Flexible Cap Version 

 

Concentrated Loads at Nodes 

 The maximum number of rows defining concentrated load at nodes for each load case is limited 

to 1000. 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the currently selected one. 
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• Delete Row.  Delete the selected row. 

• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a row. 

 

 For each row the following columns are available: 

• Node/Set.  Enter the node number or the Node Set to which the concentrated loads will be 

applied. If a Node Set is entered, the values for End and Incr. will be ignored. 

• End.  For a sequence of nodes, enter the highest node number to which the concentrated load 

will be applied.  For a single node enter zero in this column.  

• Incr.  For a sequence of nodes, enter the increment on node number to get the intermediate 

node numbers on the sequence to which the concentrated loads will be applied.  For a single 

node enter zero in this column.  

• Fx.  Enter the value for the concentrated load in the x direction. 

• Fy.  Enter the value for the concentrated load in the y direction. 

• Fz.  Enter the value for the concentrated load in the z direction. 

• Mx.  Enter the value for the concentrated moment in the x direction. 

• My.  Enter the value for the concentrated moment in the y direction. 

• Mz.  Enter the value for the concentrated moment in the z direction. 

 

By clicking on the Paste Values (From Clipboard) button, the program will paste the 

concentrated loads at nodes from the clipboard. By using this option, the program will replace all the 

values already defined. If the number of columns in the clipboard is not equal to the columns needed 

(9), the program will not paste any values. 

By clicking on the Copy Values (To Clipboard) button, the program will copy the concentrated 

loads data to the clipboard.  

 

Close Button 

 Click on the Close button to close the window and go back to the Edit Load Case window. 
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3.3.11.8 Distributed Loads on Plates Window - Flexible Cap Version 

 

 In this window the user can define distributed loads applied on plates which belong to the finite 

element mesh defining the flexible pile cap.  The load case number and name are displayed at the top of 

the window.  A sample of this window is shown in Figure 3.106. 

 

           

 

Figure 3.106  Distributed Loads on Plates Window - Flexible Cap Version 

 

Distributed Loads on Plates 

 The maximum number of rows defining distributed load on plates for each load case is limited to 

1000. 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the currently selected one. 

• Delete Row.  Delete the selected row. 

• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a row. 
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 For each row the following columns are available: 

• Plate/Set.  Enter the plate number or the Plate Set to which the distributed loads will be 

applied. If a Plate Set is entered, the values for End and Incr. will be ignored. 

• End.  For a sequence of plates, enter the highest plate number to which the distributed load will 

be applied.  For a single plate enter zero in this column.  

• Incr.  For a sequence of plates, enter the increment on plate number to get the intermediate 

plate numbers on the sequence to which the distributed load will be applied.  For a single plate 

enter zero in this column.  

• DL. Fx.  Enter the value for the distributed load in the x direction. 

• DL. Fy.  Enter the value for the distributed load in the y direction. 

• DL Fz.  Enter the value for the distributed load in the z direction. 

• DL. Mx.  Enter the value for the distributed moment in the x direction. 

• DL. My.  Enter the value for the distributed moment in the y direction. 

• DL. Mz.  Enter the value for the distributed moment in the z direction. 

 

By clicking on the Paste Values (Clipboard) button, the program will paste the distributed loads 

on plates from the clipboard. By using this option, the program will replace all the values already 

defined. If the number of columns in the clipboard is not equal to the columns needed (9), the program 

will not paste any values. 

By clicking on the Copy Values (To Clipboard) button, the program will copy the distributed 

loads data to the clipboard.  

 

Close Button 

 Click on the Close button to close the window and go back to the Edit Load Case window. 

 

 

 

3.3.11.9 Distributed Loads on Beams Window - Flexible Cap Version 

 

 In this window the user can define distributed loads applied on beams which belong to the finite 

element mesh defining the flexible pile cap.  The load case number and name are displayed at the top of 

the window.  A sample of this window is shown in Figure 3.107. 
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Figure 3.107  Distributed Loads on Beams Window - Flexible Cap Version 

 

Distributed Loads on Beams 

 The maximum number of rows defining distributed load on beams for each load case is limited 

to 1000. 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the currently selected one. 

• Delete Row.  Delete the selected row. 

• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a row. 

 

 For each row the following columns are available: 

• Direction.  Select the direction in which the distributed load will be applied.  The user can select 

along the local or global axes. 

• Beam/Set.  Enter the plate number or the Beam Set to which the distributed loads will be 

applied. If a Beam Set is entered, the values for End and Incr. will be ignored. 

• End.  For a sequence of beams, enter the highest beam number to which the distributed load 

will be applied.  For a single beam enter zero in this column.  
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• Incr.  For a sequence of beams, enter the increment on beam number to get the intermediate 

beam numbers on the sequence to which the distributed load will be applied.  For a single beam 

enter zero in this column.  

• DL. Fx.  Enter the value for the distributed load in the x direction. 

• DL. Fy.  Enter the value for the distributed load in the y direction. 

• DL Fz.  Enter the value for the distributed load in the z direction. 

• DL. Mx.  Enter the value for the distributed moment in the x direction. 

• DL. My.  Enter the value for the distributed moment in the y direction. 

• DL. Mz.  Enter the value for the distributed moment in the z direction. 

 

By clicking on the Paste Values (From Clipboard) button, the program will paste the distributed 

loads on plates from the clipboard. By using this option, the program will replace all the values already 

defined. If the number of columns in the clipboard is not equal to the columns needed (10), the program 

will not paste any values. 

By clicking on the Copy Values (To Clipboard) button, the program will copy the distributed 

loads data to the clipboard.  

 

Close Button 

 Click on the Close button to close the window and go back to the Edit Load Case window. 

 

 

3.3.11.10 Concentrated Loads on Beams Window - Flexible Cap Version 

 

 In this window the user can define concentrated loads applied on beams which belong to the 

finite element mesh defining the flexible pile cap.  The load case number and name are displayed at the 

top of the window.  A sample of this window is shown in Figure 3.108. 
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Figure 3.108  Concentrated Loads on Beams Window - Flexible Cap Version 

 

Concentrated Loads on Beams 

 The maximum number of rows defining concentrated loads on beams for each load case is 

limited to 1000. 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the currently selected one. 

• Delete Row.  Delete the selected row. 

• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a row. 

 

 For each row the following columns are available: 

• Direction.  Select the direction in which the concentrated load will be applied.  The user can 

select along the local or global axes. 

• Beam/Set.  Enter the beam number or the Beam Set to which the distributed loads will be 

applied. If a Beam Set is entered, the values for End and Incr. will be ignored. 

• End.  For a sequence of beams, enter the highest beam number to which the concentrated load 

will be applied.  For a single beam enter zero in this column.  
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• Incr.  For a sequence of beams, enter the increment on beam number to get the intermediate 

beam numbers on the sequence to which the concentrated load will be applied.  For a single 

plate enter zero in this column.  

• Pos.  Enter the position along the beam where the concentrated load is applied. 

• DL. Fx.  Enter the value for the concentrated load in the x direction. 

• DL. Fy.  Enter the value for the concentrated load in the y direction. 

• DL Fz.  Enter the value for the concentrated load in the z direction. 

• DL. Mx.  Enter the value for the concentrated moment in the x direction. 

• DL. My.  Enter the value for the concentrated moment in the y direction. 

• DL. Mz.  Enter the value for the concentrated moment in the z direction. 

 

By clicking on the Paste Values (From Clipboard) button, the program will paste the 

concentrated loads on plates from the clipboard. By using this option, the program will replace all the 

values already defined. If the number of columns in the clipboard is not equal to the columns needed 

(11), the program will not paste any values. 

By clicking on the Copy Values (To Clipboard) button, the program will copy the distributed 

loads data to the clipboard.  

 

Close Button 

 Click on the Close button to close the window and go back to the Edit Load Case window. 

 

 

 

3.3.11.11 Distributed Lateral Loads Window 

 

 In this window the user may enter the distributed lateral loads along the piles.  A sample of this 

window is shown in Figure 3.109. 
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Figure 3.109  Distributed Lateral Loads Window 

 

Distributed Lateral Loads on Piles 

 The maximum number of rows for distributed loads definition is limited to 100. 

 The following buttons may be available based in the number of load cases: 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the current row. 

• Delete Row.  Delete the current row.   

• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a row. 

 

 For each row the following columns are available: 

•  Direction.  Select the direction in which the distributed load will be applied.  The user can select 

along the local (y and/or z) or global (Y and/or Z) axes. This option is useful when considering 

batter piles since the global and local axes are different. 
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• Pile/Set.  Enter the pile number or the Pile Set to which the distributed load will be applied. If a 

Pile Set is entered, the values for End and Incr. will be ignored. 

• End.  For a sequence of piles, enter the highest pile number to which the distributed load will be 

applied.  For a single pile enter zero in this column.  

• Incr.  For a sequence of piles, enter the increment on pile number to get the intermediate pile 

numbers on the sequence.  For a single pile enter zero in this column. 

• Set Y.  Enter the set number of the distributed lateral load to be applied in the Y direction 

(either local or global). 

• Factor Y.  Enter the factor to be applied at the distributed lateral load applied in the Y direction 

(either local or global). 

• Set Z.  Enter the set number of the distributed lateral load to be applied in the Z direction (either 

local or global).  Available for 3D analysis. 

• Factor Z.  Enter the factor to be applied at the distributed lateral load applied in the Z direction 

(either local or global).  Available for 3D analysis. 

 

Axial Component 

 The analysis of distributed loading on the Global axes is decomposed into the local axes, as 

shown in Figure 3.110.  The distributed load in the axial direction (local axes x) is integrated and 

considered as a concentrated force acting at the pile head.  Select the option Include Axial Component 

to consider the axial component of global loading into the analysis; otherwise, the axial component will 

not be included in the analysis.   

 

Set of Distributed Lateral Loads on Piles 

 Click on the Set of Distributed Lateral Loads button in order to open the Set of Distributed 

Lateral Loads window to define the distributed lateral loads along the pile. 

 

By clicking on the Paste Values (From Clipboard) button, the program will paste the 

concentrated loads on plates from the clipboard. By using this option, the program will replace all the 

values already defined. If the number of columns in the clipboard is not equal to the columns needed (8 

for 3D models and 6 for 2D models), the program will not paste any values. By clicking on the Copy 

Values (To Clipboard) button, the program will copy the distributed loads data to the clipboard.  

 

Close Button 

Click on the Close button to close the window and go back to the Loading Definition window. 



CHAPTER 3    References for Data Input     3-134 

 

GROUP 2022 for Windows User's Manual 
 

 

a) Distributed Load along global axes Y 

 

b) Equivalent load considering distributed loads along local axes y and local axes x 

 

c) Equivalent load considering distributed load along local axes y and concentrated load at top of pile 

along local axes x (axial) 

Figure 3.110  Equivalent distributed load in global and local axes 
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3.3.11.12 Soil Movement Window 

 

 In this window the user may enter the soil movement along the piles.  A sample of this window 

is shown in Figure 3.111. 

 

     

 

Figure 3.111  Soil Movement Window 

 

Soil Movement on Piles 

 The maximum number of rows for soil movement definition is limited to 100. 

 The following buttons may be available based in the number of rows defined: 

• Add Row.  Add a new row at the end of the list. 

• Insert Row.  Add a new row below the current row. 

• Delete Row.  Delete the current row.   

• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a row. 
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 For each row the following columns are available: 

•  Direction.  Select the direction in which the soil movement will be applied.  The user can select 

along the global (Y and/or Z) axes or local (y and/or z). This option is useful when considering 

batter piles since the global and local axes are different. 

• Pile/Set.  Enter the pile number or Pile Set to which the soil movement will be applied. It a Pile 

Set is entered the values for End and Incr. are ignored. 

• End.  For a sequence of piles, enter the highest pile number to which the soil movement will be 

applied.  For a single pile enter zero in this column. 

• Incr.  For a sequence of piles, enter the increment on pile number to get the intermediate pile 

numbers on the sequence.  For a single pile enter zero in this column. 

• Set Y.  Enter the set number of the soil movement set to be applied in the Y direction (either 

local or global). 

• Factor Y.  Enter the factor to be applied at the soil movement set applied in the Y direction 

(either local or global). 

• Set Z.  Enter the set number of the soil movement set to be applied in the Z direction (either 

local or global).  Available for 3D analysis. 

• Factor Z.  Enter the factor to be applied at the soil movement set applied in the Z direction 

(either local or global).  Available for 3D analysis. 

 

 

Set of Soil Movement on Piles 

 Click on the Set of Soil Movement button to open the Set of Soil Movement window to define 

the distributed lateral loads along the pile. 

 

By clicking on the Paste Values (From Clipboard) button, the program will paste the 

concentrated loads on plates from the clipboard. By using this option, the program will replace all the 

values already defined. If the number of columns in the clipboard is not equal to the columns needed (8 

for 3D models and 6 for 2D models), the program will not paste any values. By clicking on the Copy 

Values (To Clipboard) button, the program will copy the distributed loads data to the clipboard.  

 

 

Close Button 

Click on the Close button to close the window and go back to the Loading Definition window. 
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3.3.11.13 Incremental/PushOver Analysis Options Window 

 

 In this window the user may enter parameters to perform incremental/pushover analysis for the 

current load case. This window is not available for a model with a flexible pile cap (Flexible Cap Version). 

 

Incremental/PushOver Analysis Options 

 The following options are available in this window: 

• Perform Incremental/PushOver Analysis.  If this option is checked, the program will perform 

incremental/pushover analysis for the current load case.  

• Number of Points.  Enter the number of points used to perform the incremental/pushover 

analysis. The minimum number of points is 1 and the maximum number of points is 25.  The 

table for Factors of Loading will change according to the number of points defined. 

• Factors of Loading.  Enter the factors of loading at which the incremental/pushover analysis will 

be analyzed.  The factors will be applied to the loads (or specify displacements) applied at the 

pile group. 

• Logarithmic.  Click on this option to generate loading factors based on arithmetic interpolation. 

The program uses the last entry in the table to generate other values. 

• Arithmetic.  Click on this option to generate loading factors based on logarithmic interpolation. 

The program uses the last entry in the table to generate other values. 

• Ux, Fx.  If this option is checked, the program will keep constant for the incremental/pushover 

analysis the value assigned to specified displacement at the pile cap in the x direction or total 

load at the pile cap in the x direction. 

• Uy, Fy.  If this option is checked, the program will keep constant for the incremental/pushover 

analysis the value assigned to specified displacement at the pile cap in the y direction or total 

load at the pile cap in the y direction. 

• Rot z, Mz.  If this option is checked, the program will keep constant for the 

incremental/pushover analysis the value assigned to specified rotation at the pile cap in the z 

direction or total moment at the pile cap in the z direction. 

• Uz, Fz.  If this option is checked, the program will keep constant for the incremental/pushover 

analysis the value assigned to specified displacement at the pile cap in the z direction or total 

load at the pile cap in the z direction. Only for 3D models 

• Rot y, My.  If this option is checked, the program will keep constant for the 

incremental/pushover analysis the value assigned to specified rotation at the pile cap in the y 

direction or total moment at the pile cap in the y direction. Only for 3D models 
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• Rot x, Mx.  If this option is checked, the program will keep constant for the 

incremental/pushover analysis the value assigned to specified rotation at the pile cap in the x 

direction or total moment at the pile cap in the x direction. Only for 3D models. 

• Distributed Loads.  If this option is checked, the program will keep constant for the 

incremental/pushover analysis the distributed loads applied at the piles. 

 

Close Button 

Click on the Close button to close the window and go back to the Loading Definition window. 

 

  

Figure 3.112  Foundation Stiffness Options Window based on Nonlinear Soil Response 
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3.3.11.14 Foundation Stiffness Options Window 

 

 In this window the user may enter parameters for estimating the flexibility matrix and/or the 

stiffness matrix of the pile group system. This window is not available for a model with a flexible pile cap 

(Flexible Cap Version). 

 The program provides two methods to estimate the stiffness matrix, the first one is based on 

the Nonlinear Soil Response and the second one in Equivalent Elastic Springs. The Foundations Stiffness 

Window depends on the method choose by the user 

 

Method Based on Nonlinear Soil Response 

A sample of this window is shown in Figure 3.113. 

 

Foundation Stiffness Options 

 The following options are available in this window: 

• Generate Data for Foundation Stiffness.  If this option is checked, the program will compute the 

Flexibility Matrix for different levels of loads.  See Figure 3.114 , Figure 3.115, and Figure 3.116 

for estimation of The Flexibility Matrix in the two dimensional case. 

• Number of Points.  Enter the number of points used to compute the data for Foundation 

Stiffness.  The minimum number of points is 1 and the maximum number of points is 10.  The 

table for Factors of Loading will change according to the number of points defined. 

• Factors of Loading.  Enter the factors of loading at which the data for Foundation Stiffness will 

be generated.  The factors will be applied to the concentrated loads at the pile cap.  No 

distributed loads on piles will be included in order to estimate the Foundation Stiffness. 

• Logarithmic.  Click on this option to generate loading factors based on arithmetic interpolation. 

The program uses the last entry in the table to generate other values. 

• Arithmetic.  Click on this option to generate loading factors based on logarithmic interpolation. 

The program uses the last entry in the table to generate other values. 

• Compute Foundation Stiffness.  If this option is checked, the program will compute the 

Foundation Stiffness Matrix, based on the Flexibility Matrix estimated, for the different levels of 

loads.  The Stiffness Matrix is defined as the inverse of the Flexibility Matrix. 

• Consider Only Diagonal Terms.  If this option is checked, the program will compute the 

Foundation Stiffness Matrix neglecting the out of diagonal terms.  See Figure 3.122. 



CHAPTER 3    References for Data Input     3-140 

 

GROUP 2022 for Windows User's Manual 
 

 

Close Button 

Click on the Close button to close the window and go back to the Loading Definition window. 

 

 

   

Figure 3.113  Foundation Stiffness Options Window based on Nonlinear Soil Response 
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Procedure to Estimate the Foundation Stiffness Based on Nonlinear Soil Response 

 

 The procedure to estimate the Foundation Stiffness Based on Nonlinear Soil Response can be 

summarized in the following steps: 

1. Estimation of Flexibility Coefficients. The flexibility coefficients are estimating by performing an 

analysis applying a force in one degree of freedom and no force in all other degrees of freedom. 

By dividing the resultant displacements between the applied force, the flexibility components 

associated to the degree of freedom in which the load was applied the flexibility coefficients are 

estimated. See Figure 3.114 , Figure 3.115, and Figure 3.116 for the estimation of the flexibility 

components in the two dimensional case 

 

2. Estimation of Flexibility Matrix. The Flexibility Matrix is obtained by filling out the flexibility 

coefficients estimated. The flexibility coefficients estimated while applying the force in one 

degree of freedom correspond to a complete row in the Flexibility Matrix. In Figure 3.117 a 

Flexibility Matrix for a 2-dimensional model is presented, while in Figure 3.118 the Flexibility 

Matrix for a 3-dimensional model is presented. 

Please note that in general the GROUP program represents the soil using nonlinear springs. For 

a nonlinear system, the symmetric coupling (off-diagonal) components may not have the same 

value, so the Flexibility Matrix obtained by the group program is non-symmetric. Only if the 

system is linear elastic the Flexibility Matrix will be symmetric.  

 

3. Estimation of the Stiffness Matrix. The Stiffness Matrix is obtained by using the relationship 

between the Flexibility and Stiffness Matrices. The Stiffness Matrix is the inverse of the 

Flexibility Matrix. 

Please note that if the Flexibility Matrix is non-symmetric, the Stiffness Matrix is also non-

symmetric. 

In Figure 3.120 a Flexibility Matrix for a 2-dimensional model is presented, while in Figure 3.121 

the Flexibility  Matrix for a 3-dimensional model is presented. 

 

4. Only Diagonal Terms. If the user only wants to estimate a Stiffness Matrix considering only the 

diagonal terms, the program fills only the diagonal terms on the Flexibility Matrix, then the 

program inverts the Diagonal Flexibility Matrix to estimate the Diagonal Stiffness Matrix. Those 

matrices for the 3-dimensional case are presented in Figure 3.122. 
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Figure 3.114  Flexibility Matrix Components due to a force in X direction (2D case) 

 

Figure 3.115  Flexibility Matrix Components due to a force in Y direction (2D case) 
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Figure 3.116  Flexibility Matrix Components due to a moment in Z direction (2D case) 
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Figure 3.117  Flexibility Matrix for a two-dimensional model 
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Figure 3.118  Flexibility Matrix for a three-dimensional model 
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 Figure 3.119  Estimation of Stiffness Matrix from a Flexibility Matrix 
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Figure 3.120  Stiffness Matrix for a two-dimensional model 
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Figure 3.121  Stiffness Matrix for a three-dimensional model 
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Figure 3.122  Stiffness Matrix considering only diagonal terms for a three-dimensional model 

 

 

 

Important Notes 

 The estimation of the flexibility components as well as the Stiffness Matrix may involve a 

numerous number of analyses, so it is recommended to be sure that the program gets a solution with 

the suggested level of load before running a case including the Stiffness Matrix Estimation. 

 If a force in a specific degree of freedom is not defined, the program will not estimate the 

flexibility components for that degree of freedom. 
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 If the program can not get convergence for an analysis on a specific degree of freedom, the 

program will not estimate the flexibility components for that degree of freedom. 

 If the program does not get components for a specific degree of freedom, for numerical 

purposes it assumes a value of 1 for diagonal terms and 0 for off-diagonal terms. The values assumed for 

the program on those cases are only for completeness and to avoid numerical problems, those are not 

intended to replace more rigorous computations. User should proceed with caution if values are missing 

or there is no convergence in the solution. 

 Since the current procedure involves nonlinear behavior, both the Flexibility Matrix and Stiffness 

Matrix may be non-symmetric. 

 

 

 

 

Method Based on Equivalent Elastic Springs 

A sample of this window is shown in Figure 3.123. 

 

Foundation Stiffness Options 

 The following options are available in this window: 

• Compute Foundation Stiffness.  If this option is checked, the program will compute the Stiffness 

Matrix for different levels of loads or displacements.  See Figure 3.114 , Figure 3.115, and Figure 

3.116 for estimation of The Stiffness Matrix in the two dimensional case. 

• Number of Points.  Enter the number of points used to compute the data for Foundation 

Stiffness.  The minimum number of points is 1 and the maximum number of points is 10.  The 

table for Factors of Loading will change according to the number of points defined. 

• Factors of Loading/Displacement.  Enter the factors of loading/displacement at which the 

Foundation Stiffness will be generated.  The factors will be applied to the concentrated loads at 

the pile cap.  No distributed loads on piles will be included in order to estimate the Foundation 

Stiffness. 

• Logarithmic.  Click on this option to generate loading factors based on arithmetic interpolation. 

The program uses the last entry in the table to generate other values. 

• Arithmetic.  Click on this option to generate loading factors based on logarithmic interpolation. 

The program uses the last entry in the table to generate other values. 

• Consider Axial Force in Piles.  If this option is checked, the program will include the contribution 

of the axial load in the Stiffness Matrix (second order effect). 
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• Select level of loading.  

o Based on the Applied Load.  If this option is selected, the program will compute the 

Foundation Stiffness Matrix based on the defined load.  

o Based on a Target Deflection.  If this option is selected, the program will scale the load 

until getting the target deflection. Some iterations may be needed.  

o Scale only load associated with Deflection.  If this option is selected, the program will 

scale only the load associated with the target degree of freedom, all other loads will be 

kept constant throughout the iterations. This entry is available only if the option Based 

on Target Deflection is selected. 

o Ux.  Enter the value for a target deflection in the X direction. This entry is available only 

if the option Based on Target Deflection is selected. 

o Uy.  Enter the value for a target deflection in the Y direction. This entry is available only 

if the option Based on Target Deflection is selected. 

o Rot. z.  Enter the value for a target rotation in the Z direction. This entry is available only 

if the option Based on Target Deflection is selected. 

o Uz.  Enter the value for a target deflection in the Z direction. This entry is available only 

if the option Based on Target Deflection is selected. 

o Rot. x.  Enter the value for a target rotation in the X direction. This entry is available only 

if the option Based on Target Deflection is selected. 

o Rot. y.  Enter the value for a target rotation in the Y direction. This entry is available only 

if the option Based on Target Deflection is selected. 

o Tolerance (%).  Enter the value for specified tolerance while reaching the target 

deflection. This entry is available only if the option Based on Target Deflection is 

selected. 

o Max. Iterations  Enter the maximum number of iterations allowed while reaching the 

target deflection. This entry is available only if the option Based on Target Deflection is 

selected. 

 

Close Button 

Click on the Close button to close the window and go back to the Loading Definition window. 
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Figure 3.123  Foundation Stiffness Options Window based on Equivalent Elastic Springs 
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Procedure to Estimate the Foundation Stiffness Based on Equivalent Elastic Springs  

 

 The procedure to estimate the Foundation Stiffness Based on Equivalent Elastic Springs can be 

summarized in the following steps:  

Perform analysis for a level of load or for a target displacement (may require iterations). 

Estimate equivalent elastic lateral springs along the pile and axial springs at the top of pile. 

Calculate equivalent elastic stiffness at each pile head by means of static condensation. 

Compute equivalent elastic stiffness at pile cap using a kinematic approach. 

1. Analysis for Load or Target Displacement. Perform an analysis for the defined level of load or 

for a specific target displacement. If a target displacement is desired, various analysis may be 

required until getting the target deflection within a tolerance.  

 

2. Estimation of Elastic Springs. If a solution was obtained the soil behavior is represented using 

equivalent elastic springs. The equivalent elastic lateral springs along the pile are estimated by 

dividing the soil reaction between the lateral deflection times the increment on discretization 

along the pile. The equivalent elastic axial spring at the top of each pile is estimated by dividing 

the axial force at the top of the pile by the axial displacement at the top of the pile. For a three-

dimensional model the equivalent elastic torsional spring at each pile is estimated by dividing 

the torsional moment at the top of the pile by the torsional rotation at the top of the pile. 

 

3. Static Condensation. The lateral equivalent stiffness at each pile head is estimated based on the 

method of static condensation.  

 

4. Equivalent Stiffness for Pile Group. The Equivalent Elastic Stiffness for the whole pile group is 

estimated by the kinematic method, considering the coordinates and direction of each pile. 

 

 

Important Notes 

 The estimation of the Stiffness Matrix may involve a numerous number of analyses, so it is 

recommended to be sure that the program gets a solution with the suggested level of load before 

running a case including the Stiffness Matrix Estimation. 

 Since the current procedure involves equivalent linear springs, the Stiffness Matrix is symmetric. 
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Figure 3.124  Analysis due to a load or target displacement 

  

 

Figure 3.125  Estimation of equivalent elastic springs  
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Figure 3.126  Static Condensation to find Lateral Stiffness at Pile Head 

 

 

Figure 3.127  Equivalent Elastic Stiffness for a Pile Group 
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3.3.11.15 Analysis Options Window 

 

 Several parameters for computation control are provided in this window.  A sample of this 

window is shown in Figure 3.128. 

 

    

Figure 3.128  Analysis Option Window 

 

 A general description for the data needed under each computation parameter is listed below. 
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o Maximum Iterations on Pile Group.  This is the maximum number of iterations allowed for 

the global behavior of the pile group.  The default value is 100. 

o Maximum Iterations on Individual Pile.  This is the maximum number of iterations allowed 

for each individual pile.  The default value is 100. 

o Tolerance on Equilibrium of Pile Group.  

• Primary relative criteria (DU/U). This is the maximum tolerated relative error on pile 

cap deflections computed by two consecutive iterations for the global pile group.  

The default value is 0.0001. 

• Alternative absolute criteria. Check this option for using an absolute criteria to check 

the convergence on the pile cap. If checking this option, the following two values 

must be input: 

• Tolerance of Cap Deflection.  This is the maximum tolerated difference on cap 

deflections computed by two consecutive iterations for the pile group.  The default 

value is 0.0001 in (2.54 x 10-6 m). 

• Tolerance of Cap Rotation.  This is the maximum tolerated difference on cap 

deflections computed by two consecutive iterations for the pile group.  The default 

value is 1 x 10-6 rad. 

•  

o Tolerance on Pile Deflection.  This is the maximum tolerated difference on pile deflections 

computed by two consecutive iterations for individual piles.  The default value is 0.0001 in 

(2.54 x 10-6 m). 

o Initial Step Increment.  This value is helpful if the program is not able to reach convergence 

by applying the total load.  The user may use this value to apply the load in steps.  At each 

step the program will apply an increment of load equal to this value times the total load.  

The default value is 1. 

o Minimum Step Increment.  This value is helpful if the program does not reach convergence 

by applying the total load.  If the program does not reach convergence, the program will try 

to use a load increment factor equal to half of the current load increment factor.  If the new 

increment factor is smaller than this value, the program will stop the analysis for the current 

load case.  The default value is 1. 

o Include Axial Load Variation Along Piles.  Check this option, to use the axial load variation 

along piles for the analysis of the pile group. This option is only available if the program 

computes the axial load displacement curve internally, since the program computes the t-z 

and q-w curves internally. So, this option is not available in piles where a user defined axial 

load displacement curve is defined. 
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o Number of Processors, nmax n.  Enter the number of processors desired to be used for the 

analysis of the current load case. The program displays the maximum number of processors 

available. Leave the number as zero to let the program decided for the number of 

processors to be used for the analysis of the current load case.  The default value is 1. 

 

 
Save Marked Values As Default Values Button 

Click on the Set Marked Values As Default Values button to override the default values by the ones 

marked defined in the current load case. The values not marked will not be overridden. The program will 

assign the default values for the definition of new load cases or combinations. 

 
Copy Marked Values for All Loads and Combinations Button 

Click on the Copy Marked Values for All Loads and Combinations button to override the values in all 

loads and combinations defined so far by the ones marked defined in the current load case. The values 

not marked will not be overridden.  

 
Close Button 

Click on the Close button to close the window and go back to the Loading Definition window. 

 

 

 

 

3.3.11.16 Output Variables Window 

 

 

 Define which variables for results along the piles will be printed in the output file.  A sample of 

this window is shown in Figure 3.129. 

   



CHAPTER 3    References for Data Input     3-157 

 

GROUP 2022 for Windows User's Manual 
 

 

Figure 3.129  Output Variables Window 

 

 Mark the variable to be printed in the output file. Please note that some variables may not be 

available. 

 
 Default Button 

Click on the Default button to mark the default values printed by default. 

 
Select All Button 

Click on the Select All button to mark all the variables. 
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Unselect All Button 

Click on the Unselect All button to unmark all the variables. 

 
Close Button 

Click on the Close button to close the window and go back to the Loading Definition window. 

 

 

 

3.3.11.17  Load Combinations Window 

 

 In this window the load combinations definition is carried out.  A sample of this window is 

shown in Figure 3.130 
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Figure 3.130  Load Combinations Window 

 

Load Combinations Definition 

 The maximum number of load combinations is limited to 100 

 The following buttons may be available based on the number of load combinations: 

• Add Load Comb..  Add a new row at the end of the list. 

• Insert Load Comb.  Add a new row below the current row. 

• Delete Load Comb.  Delete the current row.   

• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a row. 
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 For each load combination (row) the following columns are available: 

•  Load Comb.  Click on the Edit Load Comb button to open the Edit Load Combination window 

for definition of load combinations factors and analysis options. 

• Load Comb Name.  In the second column enter the name of the load combination being 

defined. 

• Run.  Check this option to analyze the load combination. 

 

 If two or more load cases are defined the program can compute the load combination envelopes 

(maximum and minimum effects).  Check the Calculate Load Combinations Envelopes option to 

calculate the envelopes.  Also, select the option for output of the calculated envelopes. 

• Only at pile cap.  Print the equivalent load and displacements of the pile cap at the origin. 

• At pile cap and at pile heads.  Print the equivalent load and displacements of the pile cap at the 

origin.  Also, for each pile print the pile top displacement and reactions in both pile coordinate 

system (local axes) and global coordinate system (global axes). 

• Pile cap, pile heads and along piles.  Print the equivalent load and displacements of the pile cap 

at the origin.  Also, for each pile, print the pile top displacement and reactions in both pile 

coordinate system (local axes) and global coordinate system (global axes).  In addition, for each 

pile, print deflection, moment, shear, soil reaction, stress and rigidity along the pile.  If this 

option is selected the user may define the increment in nodes to print the response along the 

piles. 

 

Click on the Output Variables button to open the Output Variables window for defining which 

variables for results along the pile would like to be printed in the output file for the load 

combination envelopes. 

 

Get Load Factors from a LRFD File 

 The following options are available: 

• File Name.  Enter the file name (extension .LRFD) which includes the factors for load and 

resistance. 

• Browse.  Click this button to navigate and select the file which includes the factors for load and 

resistance.  If a file is selected, the file name entry will show the respective name of the file. 

• Read Factors from File and Generate Load Combinations.  Click this button to read the factors 

from the LRFD file and generate the load combinations.  Load combinations will be generated 

based on the load factors read and the load case type. 

• View/Edit File.  Click this button to view and/or edit the LRFD file using the default word-

processor.  See Figure 3.131. 
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Figure 3.131  Sample of a LRFD File 

 

Save Load Factors to a LRFD File 

 The following options are available: 

• Generate LRFD File from Load Combinations.  Click this button to generate an LRFD file based 

on the load combinations defined.  The Save As window dialog will appear to save the file to a 

folder. Search for the folder and provide the name to save the file.  If a file with the same name 

already exists, a confirmation message indicating so will appear.  By clicking OK in the 

confirmation window, the input data file under the existing file name will be replaced with the 

current data. 

• Top Comment.  Enter the comment to be included in the first line of the generated LRFD file. 

 

Close Button 

Click on the Close button, to close the window and go back to the Loading Definition window. 
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3.3.11.18 Edit Load Combination Window 

 

 In this window the definition of each load combination is carried out.  The load combination 

number and name are displayed at the top of the window.  A sample of this window is shown in Figure 

3.132 

 

  

 

Figure 3.132  Edit Load Combination Window 

 

Load Combination Factors 

 The maximum number of rows to define the load combination is limited to 100 

 The following buttons may be available based on the number of load cases: 

• Add Row.  To add a new row for load combination definition at the end of the list. 

• Insert Row.  To add a new row for load combination definition at the current row. 

• Delete Row.  To delete the current row.   
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• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a row. 

 

 For each load combination (row) the following columns are available: 

• Load Case, Name.  Select the Load Case to be part of the load combination. 

• Load Factor.  Enter the load factor associated to the load case. 

Resistance Factors 

 Use to compute the demand capacity ratio on the load combinations: 

• Bending Moment.  Enter the resistance factor to be applied at the bending moment capacity. 

• Shear.  Enter the resistance factor to be applied at the shear capacity. 

Type of Loading 

 Select Use Cyclic Model por p-y curves if available and enter the Number of Cycles to consider a 

Cyclic Loading.  The type of loading is very important to take into account when analyzing piles under 

lateral loading.  Further reference about the "Influence of Nature of Loading" is included in the Chapter 

"Soil Response Under Natural Loading" of the Technical Manual. 

Cyclic loading is primarily used for storm, wave, or wind types of loading.  The main effect from cyclic 

loading is to reduce the soil resistance based on the soil criteria for cyclic p- curves, as described in the 

Technical Manual. 

Analysis Options 

 Click on the Edit Analysis Options button to open the Analysis Options window for the 

definition of convergence parameters for the analysis. The Analysis Option window is described under 

item 3.3.11.15 Analysis Options Window 

Print Results Options 

 Select the option for output of the results for the current load case. 

• Only at pile cap.  Print the equivalent load at origin and displacements of the pile cap at the 

origin. 

• At pile cap and at pile heads.  Print the equivalent load at origin and displacements of the pile 

cap at the origin.  Also, for each pile, print the pile top displacement and reactions in both pile 

coordinate system (local axes) and global coordinate system (global axes). 

• Pile cap, pile heads and along piles.  Print the equivalent load at origin and displacements of the 

pile cap at the origin.  Also, for each pile, print the pile top displacement and reactions in both 

pile coordinate system (local axes) and global coordinate system (global axes). In addition, for 

each pile, print deflection, moment, shear, soil reaction, stress and rigidity along the pile.  If this 
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option is selected the user may define the increment in nodes to print the response along the 

piles. 

Click on the Output Variables button to open the Output Variables window for defining which 

variables for results along the pile would like to be printed in the output file for the current load 

combination. 

Copy Load Combination 

 The option is helpful for when there are load combinations that have few differences.  So, the 

user may copy one into another and do the required changes as needed. 

 Select the load combination that is going to be the source (already defined), and then click on 

the Copy button to proceed with copying all the load combination data to the current combination. 

 This option is available if at least two load combinations have been defined. 

Close Button 

Click on the Close button, to close the window and go back to the Load Combination window. 

 

 

3.3.12 Data - Soil Layers 

 

 This submenu allows the user to specify the different types of soil to be used for the automatic 

generation of soil resistance (p-y) curves and/or axial load-displacement curves and/or torque-rotation 

curves.  GROUP 2022 will automatically generate the noted curves under default conditions.  This 

submenu option is not needed if the user specifies external curves for soil-resistance, load-displacement 

and torque-rotation curves. 

 

 

Figure 3.133  Soil Layers Window 
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 The following buttons may be available based on the number of piles: 

• Add Row.  To add a new row for soil layer definition at the end of the list. 

• Insert Row.  To add a new row for soil layer definition at the current row. 

• Delete Row.  To delete the current row.   

 

For each soil layer (row) the following columns are available: 

• Layer. Sequential numbering automatically provided by the program for each soil layer.  The 

maximum number of soil layers is limited to 20. 

• Soil Type. There are 13 internal types of soil that the user can specify through the drop-down menu.  

Please refer to Chapter 4 of the Technical Manual for a general review of the theory of p-y curves in 

different types of soil.  A review of load-displacement curves for different types of soil can be 

founded in Chapter 5 of the Technical Manual.  The types of soil as well as the data input required 

for each particular soil are listed in Table 3.5 and Table 3.6 . 

• Depth for Top of Soil Layer. Values for the top of the soil layer are entered according to the global 

origin of coordinates of the pile group.  The origin of global coordinates is at the point of application 

of group loads, usually at the top of the pile cap.  A positive value indicates a distance measured 

downward from the top of the pile cap.  A negative value usually indicates a distance measured 

above the top of the pile cap (only used for permanently embedded pile caps).   

• Depth for Bottom of Soil Layer. Values for the bottom of the soil layer are also entered according to 
the global origin of coordinates of the pile group.  The coordinate of the bottom of each layer should 
always be equal to the coordinate of the top of the following layer. 

• Properties of Layer. Click this button to enter the soil information about the layer.  The parameters 
will depend on the soil type assigned.   

 

 

 



 

 

Soil Type 

Soil Parameters (UNITS) 

Effective 
Unit 

Weight 

Undrained 
Cohesion, 

c 

Strain 
Factor, 

50 

Friction 
Angle, 

 

p-y 
Modulus, 

k 

Uniaxial 
Comp.  

Strength, 
qu 

Initial 
Modulus, 
of Rock 
Mass, Er 

Strain 
Factor, 

krm 
RQD J 

Type 
of  

Soil 
Test 

Rock 
Type 

SPT 
Blow-
count 

Cone 
Tip 
Res. 

Residual. 
Strength 

Poisson 
ratio 

GSI Dilat. 
/Intact 
Rock 
Mod. 

Press. 
/Rock 
Mass 
Mod. 

Ultimate 
Unit Site 
Friction 

Ultimate 
Unit Tip 
Resis-
tance 

(F/L3) (F/L2) (L/L) (DEG) (F/L3) (F/L2) (F/L2) (L/L) (%)     (F/L2) (F/L2)   (F/L2) (F/L2) (F/L2) (F/L2) 

Soft Clay 
(Matlock) 

          
         

  

API Soft 
Clay with 
User-def J 

          
         

  

Mod. Soft 
Clay with 
Initial K 

          
         

  

Stiff Clay 
with Free 
Water 
(Reese) 

          

         

  

Stiff Clay 
w/o Free 
Water 
(Reese) 

          

         

  

Mod. Stiff 
Clay w/o 
Free 
Water 

         

          

  

Sand 
(Reese) 

         
          

  

API Sand 
(O’Neil)  

         
          

  

Liquefiable 
Sand 
(Rollins)  

         
          

  

Liquefiable 
Sand 
Hybrid 
Model  

         

          

  

 
Table 3.5  Soil Types and Parameters Needed per Soil Type  
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Soil Type 

Soil Parameters (UNITS) 

Effective 
Unit 

Weight 

Undrained 
Cohesion, 

c 

Strain 
Factor, 

50 

Friction 
Angle, 

 

p-y 
Modulus, 

k 

Uniaxial 
Comp.  

Strength, 
qu 

Initial 
Modulus, 
of Rock 
Mass, Er 

Strain 
Factor, 

krm 
RQD J 

Type 
of  

Soil 
Test 

Rock 
Type 

SPT 
Blow 
Count 

Cone 
Tip 
Res. 

Residual. 
Strength 

Poisson 
ratio 

GSI Dilan. 
/Intact 
Rock 
Mod. 

Press. 
/Rock 
Mass 
Mod. 

Ultimate 
Unit Site 
Friction 

Ultimate 
Unit Tip 
Resis-
tance 

(F/L3) (F/L2) (L/L) (DEG) (F/L3) (F/L2) (F/L2) (L/L) (%)     (F/L2) (F/L2)   (F/L2) (F/L2) (F/L2) (F/L2) 

Weak Rock 
(Reese) 

 
         

          
  

Strong 
Rock 
(Vuggy 
Limestone) 

          

         

  

Piedmont 
Residual 
 

          
         

  

Massive 
Rock 
 

          
         

  

 
Loess 
 

          
         

  

Silt 
(Cemented 
c-phi) 

 

          

         

  

Elastic 
Subgrade 
 

          
         

  

User 
Defined 
p-y curves 

         
          

  

 
Table 3.6  Soil Types and Parameters Needed per Soil Type (continuation) 

 

 



 

 

Description of the soil parameters as follows: 

➢ Effective Unit Weight. Values of effective unit weight for each soil depth are entered in 
standard units of force per unit volume.  The program will linearly interpolate for values 
between two consecutive soil depths. 

➢ Undrained Cohesion, c. Values of undrained cohesion (undrained shear strength), for clays and 
silts at each depth are entered in standard units of force per unit area.  The undrained shear 
strength is generally taken as half of the unconfined compressive strengths. 

➢ Strain Factor, 50. Values of strain at 50% of the maximum stress 𝜖50 for clays at each soil depth 
are entered in standard units of strain.  Table 3.7 provides values of 𝜖50 for clays and Table 3.8 
provides values for stiff clays. 

 

Consistency of Clay 𝝐𝟓𝟎 

Soft 0.020 

Medium 0.010 

Stiff 0.005 

 

Table 3.7  Values of 50 for Clays 

 

Average Undrained 

Shear Strength (kPa) 

𝝐𝟓𝟎 

50-100 0.007 

100-200 0.005 

300-400 0.004 

 

Table 3.8  Values of 50 for Stiff Clays 

 

➢ Friction Angle, . Values of the angle of internal friction, , for sands and/or silts at each soil 
depth are entered in degrees. 

➢ p-y Modulus, k. This is the value for the constant 𝑘 used in the equation 𝐸𝑠 = 𝑘𝑥.  This constant 
is in units of force per cubic length and depends on the type of soil and lateral loading imposed 
on the pile group.  It has two different uses: 1) to define the initial (maximum) value of 𝐸𝑠 on 
internally generated p-y curves of submerged stiff clays and/or sands; and ii) to initialize the 𝐸𝑠 
array for the first iteration of pile analysis.  Suggested values of the parameter 𝑘 for sands are 
given in Table 3.9.  Suggested values for the parameter 𝑘 used for clays are given in Table 3.10. 
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Relative Density Loose Medium Dense 

Submerged Sand 20 lb/in3 

5,430 kN/m3 

60 lb/in3 

16,300 kN/m3 

125 lb/in3 

33,900 kN/m3 

Sand Above WT 25 lb/in3 

6,790 kN/m3 

90 lb/in3 

24,430 kN/m3 

225 lb/in3 

61,000 kN/m3 

 

Table 3.9  Soil-Modulus Parameter k for Sands 

 

 

 

Clay Type Avg.  Undrained 
Shear Strength (𝒄𝒖) 

Static Cyclic 

Soft 1.74 – 3.47 psi 

250 – 500 psf 

12 – 24 kPa 

30 pci 

 

8,140 kPa/m 

 

Medium 3.47 – 6.94 psi 

500 – 1000 psf 

24 – 48 kPa 

100 pci 

 

27,150 kPa/m 

 

Stiff 6.94 – 13.9 psi 

1000 – 2000 psf 

48 – 96 kPa 

500 pci 

 

136,000 kPa/m 

200 pci 

 

54,300 kPa/m 

Very Stiff 13.9 – 27.8 psi 

2000 – 4000 psf 

96 – 192 kPa 

1000 pci 

 

271,000 kPa/m 

400 pci 

 

108,500 kPa/m 

Hard 27.8 – 55.6 psi 

4000 – 8000 psf 

192 – 383 kPa 

2000 pci 

 

543,000 kPa/m 

800 pci 

 

217,000 kPa/m 

 

Table 3.10  Soil Modulus Parameter k for Clays 
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➢ Uniaxial Compressive Strength, qu. This value is the unconfined compressive strength of rock at 
the specified depth.  Values at elevations between the top and bottom elevations will be 
determined by linear interpolation 

➢ Initial Modulus of Rock Mass, 𝑬𝒓. The mass modulus for weak rock should be entered for this 
value.  This value may be measured in the field using an appropriate test or may be obtained 
from the product of the modulus reduction ratio and Young's modulus measured on intact rock 
specimens in the laboratory. 

➢ Strain Factor, 𝒌𝒓𝒎. This parameter typically ranges between 0.0005 and 0.00005.  This value is 
requested for weak rock. 

➢ 𝑹𝑸𝑫. This the Rock Quality Designation Value for weak Rock.  The secondary structure of the 
weak rock is described using the Rock Quality Designation (RQD).  Enter the value of RQD in 
percent for the weak rock  

➢ 𝑱. This value is used for the API soft clay with user-defined J model and the Modified Soft Clay 
with Initial K model. The program does not perform error checking on the input value of J, the 
user should consider the advice by Matlock (refer to Chapter 4 of the Technical Manual) for 
selecting the J value. 

➢ Type of Soil Test. This value is used for the Piedmont Residual model. There are four field 
testing methods: Dilatometer, Menard Pressuremeter, Standard Penetration Test and Cone 
Penetration Test. 

➢ Rock Type, Hoek Brown material index, mi. This value is used for the Massive Rock model. It is a 
dimensionless number ranging from 4 to 32 that depends on the type of rock. 

➢ SPT Blow Count. This value is used for the Piedmont Residual model and the Liquified Sand 
Hybrid model. 

➢ Cone Tip Resistance. This value is used for the Piedmont Residual model and the Loess model. 

➢ Residual Strength. This value is used for the Liquified Sand Hybrid model. 

➢ Poisson’s ratio. This value is used for the Massive Rock model. 

➢ Geologic Strength Index, GSI. This value is used for the Massive Rock model. It is a 
dimensionless number ranging from 0 to 100 that depends on the quality of the massive rock 

➢ Dilatometer Modulus. This value is used for the Piedmont Residual model. 

➢ Pressuremeter Modulus. This value is used for the Piedmont Residual model. 

➢ Intact Rock Modulus. This value is used for the Massive Rock model. 

➢ Rock Mass Modulus. This value is used for the Massive Rock model. 

➢ Ultimate unit side friction. Values of maximum unit side friction are the maximum values of unit 
side resistance to axial loads, fmax.  These values are used by the program in order to generate 

t-z curves internally.  These values are ignored and should be left as zero if the user prefers to 
enter specific load-displacement curves.  Values of maximum unit side friction should be 
entered in units of force per unit area.  The user can also ask the program to compute an 
estimated value of tip resistance if zero is entered 

➢ Ultimate unit tip resistance. Values of maximum unit tip resistance are the maximum values 
which can be developed for end bearing.  These values are used by the program in order to 
generate q-w curves internally.  These values are ignored and should be left as zero if the user 
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prefers to enter specific load-displacement curves.  Values of maximum tip resistance should be 
entered in units of force per unit area.  The user can also ask the program to compute an 
estimated value of tip resistance if zero is entered. 

 

 

3.3.13 Data - Set of Soil Resistance (p-y) Curves 

 

 This submenu option allows the user to enter specific relationships of soil resistance (p) and 

lateral movement of the pile (y) for specified depths of each pile subgroup.  This submenu option is 

inactive under normal conditions, because the program defaults to automatic generation of soil-

resistance (p-y) curves.  However, sometimes the user may prefer to enter specific p-y curves.  These 

cases usually arise when local data for the soil response are available.  The GROUP program cannot use a 

user-inputted p-y curve to calculate resistances against embedded pile caps. 

 To activate this submenu option, the user must check Enter User-Defined Soil-Resistance (p-y) 

Curves under the Options menu. 

  

Figure 3.134  Set of Soil-Resistance Window 

 

 This window allows the user to manage the sets of soil-resistance curves.  The user is allowed a 

maximum of fifty sets.  Clicking on the Soil Resistance Set button in the Edit column allows the user to 

manage the curves within the set. 
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Figure 3.135  Soil-Resistance Set Window 

 Here the user should specify the depth of the soil resistance curves, each of which should 

represent the distance from the top of the pile to the depth where the p-y curve is being specified.  

Inputted p-y curves are linearly interpolated between two consecutive values of depth.  The maximum 

number of depths in each soil-resistance set curve is limited to 20.  Clicking on the Soil Resistance Curve 

button in the next column allows the user to edit the individual curve.  The other curve sets (Axial Load-

Displacement, Torque-Rotation, Distributed Lateral Loads, Nonlinear EI) are managed similarly. 
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Figure 3.136  Soil-Resistance Curve Window 

 

 The following buttons may be available based on the number of piles: 

• Add Row.  To add a new row for definition of a p-y point at the end of the list. 

• Insert Row.  To add a new row for definition of a p-y point at the current row. 

• Delete Row.  To delete the current row.   

 

For each p-y point (row) the following columns are available: 

 

• Point. This is a sequential number that is provided to each point of the soil-resistance curve 

being defined.  This number is automatically provided by the program as new rows are added.  

The maximum number of points in each soil-resistance (p-y) curve is limited to 25.  This column 

is also found in the other curve sets. 
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• Soil Resistance, p. Values of load transfer must be inputted in units of load per unit length.  For 

reference, a review of the theory of “Soil Response for Lateral Loading” is included in Chapter 4 

of the Technical Manual. 

• Deflection, y. Values of lateral movement must be inputted in units of length.  For reference, a 

review of the theory of “Soil Response for Lateral Loading” is included in Chapter 4 of the 

Technical Manual. 

 

As the user enters the values, the curve will be displayed in the graph at the top of the window.  

If the chart is not updated since the last change, the user may need to move the cursor to 

another window to trigger window redraw. 

 

The program also allows copying the entire curve from a text file or from the clipboard 

(memory). 

To copy the curve points from a file: 

• Click on Browse button to find the file with the information about the curve.  After selecting the 

file, the file name (including path) should appear in the File Name field. 

• To review or edit the file click on the View/Edit File button.  The text file will be open using the 

notepad editor. 

• To copy the curve, click on the Read Values from File.  If the copy is successful the p-y points will 

be populated based on the input data read and the chart will be updated. 

 

To copy the curve points from the clipboard: 

• Copy the curve points to the clipboard using a text editor or the original program.  The 

information has to be in text format. 

• Click on the Paste values from Clipboard (text) button to proceed with the copy.  If the copy is 

successful, the p-y points will be populated based on the input data read and the chart will be 

updated. 

 

3.3.14 Data - Sets of Axial Load-Displacement Curves 

 

 This submenu option allows the user to enter specific relationships of axial load versus 

displacement for the pile head of each pile subgroup.  This submenu option is inactive under normal 

conditions, because the program defaults to automatic generation of load-displacement curves.  

However, sometimes the user may prefer to enter curves for axial load versus displacement at the pile 

head.  These cases usually arise when data from loading tests are available. 

 To activate this submenu option, the user must check Enter User-Defined Load-Displacement 

Curves under the Options menu. 
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Figure 3.137  Set of Axial Load vs.  Displacement Window 

 

 This window allows the user to manage the sets of axial load-displacement curves.  The user is 

allowed a maximum of fifty sets.  Clicking on the Load-Displacement Curve button allows the user to 

edit the individual curve.  The other curve sets (Soil Resistance, Torque-Rotation, Distributed Lateral 

Loads, Nonlinear EI) are managed similarly.   

  

Figure 3.138  Axial Load-Displacement Curve Window 
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The Axial Load-Displacement Curve window is very similar to the Soil Resistance Curve window, so 

refer to the description of the Soil Resistance Window for operations.  Specific features for this window 

are explained below: 

For each axial load-displacement point (row) the following columns are available: 

 

• Point. This is a sequential number that is provided to each point of the axial load-displacement 

curve being defined.  This number is automatically provided by the program as new rows are 

added.  The maximum number of points in each axial load-displacement curve is limited to 25. 

• Axial Load. Values of axial load are entered in units of force with the positive direction being 

downwards (using the same sign convention as for the pile-group loads).  For reference, a 

review of the theory of “Soil Response for Axial Loading” is included in Chapter 5 of the 

Technical Manual. 

• Pile-Top Displacement. Values of displacement at pile top are entered in units of length with 

downward movements as positive.  For reference, a review of the theory of “Soil Response for 

Axial Loading” is included in Chapter 5 of the Technical Manual. 

 

 

As the user enters the values, the curve will be displayed in the graph at the top of the window.  

If the chart is not updated since the last change, the user may need to move the cursor to 

another window to trigger window redraw. 

 

The program also allows copying the entire curve from a text file or from the clipboard 

(memory). 

To copy the curve points from a file: 

• Click on Browse button to find the file with the information about the curve.  After selecting the 

file, the file name (including path) should appear in the File Name field. 

• To review or edit the file click on the View/Edit File button.  The text file will be open using the 

notepad editor. 

• To copy the curve, click on the Read Values from File.  If the copy is successful the points will be 

populated based on the input data read and the chart will be updated. 

 

To copy the curve points from the clipboard: 

• Copy the curve points to the clipboard using a text editor or the original program.  The 

information has to be in text format. 

• Click on the Paste values from Clipboard (text) button to proceed with the copy.  If the copy is 

successful, the points will be populated based on the input data read and the chart will be 

updated. 
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3.3.15 Data - Sets of Torque-Rotation Curves 

 

 This submenu option allows the user to enter specific relationships of torsional load versus 

rotation for the pile head of each pile for 3-dimensional models only.  This submenu option is inactive 

under normal conditions, because the program defaults to automatic generation of torque-rotation 

curves.  However, sometimes the user may prefer to enter curves for torque versus rotation at the pile 

head. 

 To activate this submenu option, the user must check Enter User-Defined Torque-Rotation 

Curves under the Options menu. 

 

  

 

Figure 3.139  Set of Torque vs.  Rotation Window 

 

 This window allows the user to manage the sets of torque-rotation curves.  The user is allowed a 

maximum of fifty sets.  Clicking on the Torque-Rotation Curve button allows the user to edit the 

individual curve.  The other curve sets (Soil Resistance, Axial Load-Displacement, Distributed Lateral 

Loads, Nonlinear EI) are managed similarly.   
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Figure 3.140  Torque-Rotation Curve Window 

 

The Torque-Rotation Curve window is very similar to the Soil Resistance Curve window, so refer to the 

description of the Soil Resistance Window for operations.  Specific features for this window are 

explained below: 

For each torque-rotation point (row) the following columns are available: 

 

• Point. This is a sequential number that is provided to each point of the torque-rotation curve 

being defined.  This number is automatically provided by the program as new rows are added.  

The maximum number of points in each torque-rotation curve is limited to 25. 

• Pile Top Torque. Values of torque are entered in units of force times length.  For reference, a 

review of the theory of “Isolated Piles Subjected to Torque” is included in Chapter 3 of the 

Technical Manual. 



CHAPTER 3    References for Data Input     3-12 

 

GROUP 2022 for Windows User's Manual 
 

• Rotation: Values of rotation at pile top are entered in units of radians.  For reference, a review 

of the theory of “Isolated Piles Subjected to Torque” is included in Chapter 3 of the Technical 

Manual. 

 

As the user enters the values, the curve will be displayed in the graph at the top of the window.  

If the chart is not updated since the last change, the user may need to move the cursor to 

another window to trigger window redraw. 

 

The program also allows copying the entire curve from a text file or from the clipboard 

(memory). 

To copy the curve points from a file: 

• Click on Browse button to find the file with the information about the curve.  After selecting the 

file, the file name (including path) should appear in the File Name field. 

• To review or edit the file click on the View/Edit File button.  The text file will be open using the 

notepad editor. 

• To copy the curve, click on the Read Values from File.  If the copy is successful the points will be 

populated based on the input data read and the chart will be updated. 

 

To copy the curve points from the clipboard: 

• Copy the curve points to the clipboard using a text editor or the original program.  The 

information has to be in text format. 

• Click on the Paste values from Clipboard (text) button to proceed with the copy.  If the copy is 

successful, the points will be populated based on the input data read and the chart will be 

updated. 

 

3.3.16 Data - Sets of Nonlinear EI 

 

 This submenu option allows the user to enter nonlinear moment-curvature data for specified 

pile sections.  This submenu option is inactive under normal conditions.  However, sometimes the user 

may want to enter nonlinear moment curvature data. 

  

Figure 3.141  Set of Nonlinear EI Window 
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 This window allows the user to manage the sets of nonlinear moment curvature curves.  The 

user is allowed a maximum of fifty sets.  Clicking on the Sets of Moment Curvature button in the Edit 

column allows the user to manage the curves within the set. 

 

 

 

  

Figure 3.142  Moment Curvature Set Window 

 

 Here the user should specify the axial load of the moment curvature curve.  Inputted moment 

curvature curves are linearly interpolated between two consecutive values of axial load.  The maximum 

number of axial loads in each moment curvature set curve is limited to 20.  Clicking on the Moment 

Curvature Data button in the next column allows the user to edit the individual curve.  The other curve 

sets (Soil Resistance, Axial Load-Displacement, Torque-Rotation, Distributed Lateral Loads) are managed 

similarly. 
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Figure 3.143  Moment Curvature Data Window 

 

The Moment Curvature Data window is very similar to the Soil Resistance Curve window, so refer to the 

description of the Soil Resistance Window for operations.  Specific features for this window are 

explained below: 

For each moment curvature point (row) the following columns are available: 

 

• Point. This is a sequential number that is provided to each point of the moment curvature data 

being defined.  This number is automatically provided by the program as new rows are added.  

The maximum number of points in each moment curvature curve is limited to 25. 

• Moment. Values of bending moment are entered in units of force times length. 

• Curvature. Values of curvature are entered in units of radians per length. 
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As the user enters the values, the curve will be displayed in the graph at the top of the window.  

If the chart is not updated since the last change, the user may need to move the cursor to 

another window to trigger window redraw. 

 

The program also allows copying the entire curve from a text file or from the clipboard 

(memory). 

To copy the curve points from a file: 

• Click on Browse button to find the file with the information about the curve.  After selecting the 

file, the file name (including path) should appear in the File Name field. 

• To review or edit the file click on the View/Edit File button.  The text file will be open using the 

notepad editor. 

• To copy the curve, click on the Read Values from File.  If the copy is successful the points will be 

populated based on the input data read and the chart will be updated. 

 

To copy the curve points from the clipboard: 

• Copy the curve points to the clipboard using a text editor or the original program.  The 

information has to be in text format. 

• Click on the Paste values from Clipboard (text) button to proceed with the copy.  If the copy is 

successful, the points will be populated based on the input data read and the chart will be 

updated. 

 

 

3.3.17 Data - Sets of Red. Factor Lat. Load-Along Depth 

 

 This submenu option allows the user to enter factors for lateral load along depth for each pile 

subgroup.  This submenu option is inactive under normal conditions.  However, sometimes the user 

would like to enter the factors along depth to simulate reduction on the soil response for various 

reasons. 

 To activate this submenu option, the user must check Reduction Factors for Lateral Load along 

Depth under the Options menu. 

 

 



CHAPTER 3    References for Data Input     3-16 

 

GROUP 2022 for Windows User's Manual 
 

   

Figure 3.144  Set of Reduction Factors along Depth Window 

 

 This window allows the user to manage the sets of reduction factor for lateral load along depth.  

The user is allowed a maximum of one hundred sets.  Clicking on the Reduction Factors button allows 

the user to edit the individual curve.  The other curve sets (Soil Resistance, Torque-Rotation, Distributed 

Lateral Loads, Nonlinear EI) are managed similarly.   
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Figure 3.145  Reduction Factors Window 

 

The Reduction Factors window is very similar to the Soil Resistance Curve window, so refer to the 

description of the Soil Resistance Window for operations.  Specific features for this window are 

explained below: 

For each point (row) the following columns are available: 

 

• Point. This is a sequential number that is provided to each point of the curve being defined.  This 

number is automatically provided by the program as new rows are added.  The maximum 

number of points in each reduction factor curve is limited to 50. 

• Depth. Value of depth along pile at which the reduction factors are defined. 

• P-Factor. Value of the reduction factor for the load at the specified depths. 

• Y-Factor. Value of the reduction factor for displacement at the specified depths. 

 

 

As the user enters the values, the curves will be displayed in the graph at the top of the window.  

If the chart is not updated since the last change, the user may need to move the cursor to 

another window to trigger window redraw. 

 

The program also allows copying the entire curves from a text file or from the clipboard 

(memory). 

To copy the curve points from a file: 

• Click on Browse button to find the file with the information about the curves.  After selecting 

the file, the file name (including path) should appear in the File Name field. 

• To review or edit the file click on the View/Edit File button.  The text file will be open using the 

notepad editor. 

• To copy the curvse, click on the Read Values from File.  If the copy is successful the points will 

be populated based on the input data read and the chart will be updated. 

 

To copy the curve points from the clipboard: 

• Copy the curve points to the clipboard using a text editor or the original program.  The 

information has to be in text format. 

• Click on the Paste values from Clipboard (text) button to proceed with the copy.  If the copy is 

successful, the points will be populated based on the input data read and the chart will be 

updated. 
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3.3.18 Data - Sets of Soil Movement 

 

 This submenu option allows the user to enter distributed loads along the piles to be used for 

both 2-dimensional and 3-dimensional models.  This submenu option is active.  This window can be 

accessed also from the Soil Movement window 

 

   

Figure 3.146  Set of Soil Movement Window 

 

 This window allows the user to manage the sets of soil movement.  The user is allowed a 

maximum of two thousand sets.  Clicking on the Soil Movement button allows the user to edit the 

individual distributed load.  The other curve sets (Soil Resistance, Axial Load-Displacement, Torque-

Rotation, Distributed Loads, Nonlinear EI) are managed similarly.   
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Figure 3.147  Soil Movement Window 

 

The Soil Movement window is very similar to the Soil Resistance Curve window, so refer to the 

description of the Soil Resistance Window for operations.  Specific features for this window are 

explained below: 

For each distributed load point (row) the following columns are available: 

 

• Point. This is a sequential number that is provided to each point of the soil movement data 

being defined.  This number is automatically provided by the program as new rows are added.  

The maximum number of points in each distributed load set is limited to 25. 

• Depth. Values of depths are entered in units of length.  Each depth should represent the 

distance from the top of the pile to the depth where the soil movement is being specified. 

• Soil Move. Values of soil movement entered in units of force per unit length. 

 

As the user enters the values, the curve will be displayed in the graph at the top of the window.  

If the chart is not updated since the last change, the user may need to move the cursor to 

another window to trigger window redraw. 
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The program also allows copying the entire curve from a text file or from the clipboard 

(memory). 

To copy the curve points from a file: 

• Click on Browse button to find the file with the information about the curve.  After selecting the 

file, the file name (including path) should appear in the File Name field. 

• To review or edit the file click on the View/Edit File button.  The text file will be open using the 

notepad editor. 

• To copy the curve, click on the Read Values from File.  If the copy is successful the points will be 

populated based on the input data read and the chart will be updated. 

 

To copy the curve points from the clipboard: 

• Copy the curve points to the clipboard using a text editor or the original program.  The 

information has to be in text format. 

• Click on the Paste values from Clipboard (text) button to proceed with the copy.  If the copy is 

successful, the points will be populated based on the input data read and the chart will be 

updated. 

 

 

3.3.19 Data - Sets of Distributed Loads 

 

 This submenu option allows the user to enter distributed loads along the piles to be used for 

both 2-dimensional and 3-dimensional models.  This submenu option is active.  This window can be 

accessed also from the Distributed Lateral Load window 

 

  

Figure 3.148  Set of Distributed Lateral Loads Window 

 

 This window allows the user to manage the sets of distributed lateral loads.  The user is allowed 

a maximum of two thousand sets.  Clicking on the Distributed Loads button allows the user to edit the 
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individual distributed load.  The other curve sets (Soil Resistance, Axial Load-Displacement, Torque-

Rotation, Nonlinear EI) are managed similarly.   

 

 

  

Figure 3.149  Distributed Load Window 

 

The Distributed Load window is very similar to the Soil Resistance Curve window, so refer to the 

description of the Soil Resistance Window for operations.  Specific features for this window are 

explained below: 

For each distributed load point (row) the following columns are available: 

 

• Point. This is a sequential number that is provided to each point of the distributed load data 

being defined.  This number is automatically provided by the program as new rows are added.  

The maximum number of points in each distributed load set is limited to 25. 
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• Depth. Values of depths are entered in units of length.  Each depth should represent the 

distance from the top of the pile to the depth where the load is being specified. 

• Load per Unit Depth. Values of distributed load per unit depth are entered in units of force per 

unit length. 

 

As the user enters the values, the curve will be displayed in the graph at the top of the window.  

If the chart is not updated since the last change, the user may need to move the cursor to 

another window to trigger window redraw. 

 

The program also allows copying the entire curve from a text file or from the clipboard 

(memory). 

To copy the curve points from a file: 

• Click on Browse button to find the file with the information about the curve.  After selecting the 

file, the file name (including path) should appear in the File Name field. 

• To review or edit the file click on the View/Edit File button.  The text file will be open using the 

notepad editor. 

• To copy the curve, click on the Read Values from File.  If the copy is successful the points will be 

populated based on the input data read and the chart will be updated. 

 

To copy the curve points from the clipboard: 

• Copy the curve points to the clipboard using a text editor or the original program.  The 

information has to be in text format. 

• Click on the Paste values from Clipboard (text) button to proceed with the copy.  If the copy is 

successful, the points will be populated based on the input data read and the chart will be 

updated. 

 

 

 

3.3.20 Data- Sets of Data to Print p-y Curves 

 

 This submenu option allows the user to enter information for printing the internally generated 

p-y curves.  This submenu option is inactive under normal conditions. 

 Only internally generated p-y curves may be printed by the program.  Printed p-y curves are 

calculated expressly for the specified depths only for verification purposes.  The number of depths that 

the user selects has no effects on the accuracy of the results because the p-y curves are calculated at 

each pile increment for internal computations.   
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 In the output data file and graphics, the labels of depths of p-y curves are printed as depths 

below ground line.  These labels will thus be different than requested depths of printout when the 

ground line is not at the same level as the origin of the global coordinate system.   

 If the user selects Pile-Cap Embedded under Pile Cap Options and also request to print an 

internally generated p-y curve within the height of the pile cap, then two different p-y curves will be 

printed:  one corresponding to the p-y curve for the pile cap and the other corresponding to the p-y 

curve for the specified pile subgroup.  The difference can easily be identified in the pile diameters.  In 

addition, the p-y curve corresponding to the pile cap will usually be a stiffer curve. 

 

 To activate this submenu option, the user must check Print p-y Curves under the Options menu. 

 

  

Figure 3.150  Printing Depths for p-y Curves Window 

 

 The following buttons may be available based on the number of desired p-y curves to print: 

• Add Row.  To add a new row for definition of a p-y print at the end of the list. 

• Insert Row.  To add a new row for definition of a p-y print at the current row. 

• Delete Row.  To delete the current row.   

 

For each p-y print (row) the following columns are available: 

 

• Number. This is a sequential number that is provided to each point of a p-y print being defined.  

This number is automatically provided by the program as new rows are added.  The maximum 

number of p-y curves to print is limited to 50. 

• Pile Group Number. Enter the number of the pile group associated with the p-y curve to print. 

• Depth Below Origin. Values of depth must be inputted in units of length.  Values for depth 

should be entered according to the global coordinate system.  Values may be positive if 

downward from the origin or negative for soils above the pile cap. 
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• Displacement Sets. Click on the Displacements for Printing p-y curves button to enter the 

values of displacements at which the p-y curves are desired.  GROUP will use default values if no 

displacements are entered. 

 

  

Figure 3.151  Displacements for p-y Curves Window 

 

 The following buttons may be available based on the number of displacements desired to print: 

• Add Row.  To add a new row for definition of a displacement at the end of the list. 

• Insert Row.  To add a new row for definition of a displacement at the current row. 

• Delete Row.  To delete the current row.   

 

For each displacement (row) the following columns are available: 

 

• Number. This is a sequential number that is provided to each displacement being defined.  This 

number is automatically provided by the program as new rows are added.  The maximum 

number of displacements to print is limited to 25. 

• Displacements. Values of displacements must be inputted in units of length.   

 

The program also allows copying the entire displacement list from a text file or from the 

clipboard (memory). 

To copy the displacement list from a file: 

• Click on Browse button to find the file with the information about the displacement list.  After 

selecting the file, the file name (including path) should appear in the File Name field. 

• To review or edit the file click on the View/Edit File button.  The text file will be open using the 

notepad editor. 

• To copy the curve, click on the Read Values from File.  If the copy is successful the displacement 

list will be populated based on the input data read. 
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To copy the displacement list from the clipboard: 

• Copy the displacement list to the clipboard using a text editor or the original program.  The 

information has to be in text format. 

• Click on the Paste values from Clipboard (text) button to proceed with the copy.  If the copy is 

successful, the displacement list will be populated based on the input data read. 

 

3.3.21 Data – Import Soil Layers from an EnCPT Soil File 

 

 This submenu option is used to import soil layer generated by the EnCPT program.  

 

 

  

 

Figure 3.152  Import Soil Layers from EnCPT Window 
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Click on the Browse and Open File button to navigate and select the output file generated for 

EnCPT which contains the soil layer data. If soil layer data is available in the file, the data will be 

displayed in the window.  

Click on the Copy Soil Layer Data to Current Model button to transfer the data in memory to 

the internal tables of GROUP 2022. It should be noted that the program will overwrite the current 

definition of soil layering.  

 

 

 

 

3.3.22 Data – Import Soil and Section Data from LPILE Model 

 

 This submenu option is used to import Soil and/or Section Data from an LPILE model 

(v2015/2016/2018/2019/2022). 
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Figure 3.153  Import p-y curves from LPILE Window 

 

 

 

Click on the Browse and Open button to navigate and select the input file for LPILE models (v 

2015, 2018, 2019, 2022) which contains the input date. If the data is available, the information will be 

read into memory and a summary will be displayed.  

The button Open LPILE File Using Notepad is enabled after a successful reading of the file into 

memory. Please click into this button to edit the file and check the data read by the program.  

Click on the Import Data button to transfer the data in memory to the internal tables of GROUP 

2022. Program will transfer the data that is checked. If the transferring of data was successful, a 

message indicating so will show up. It will also indicate the section number(s) where the section data 

were copied. For the soil data, the program will override the current soil layer defined. The program 

automatically will convert the data values to the current units being used on the GROUP model.  
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To verify the correct transfer of the data, click on the View Soil Layers, View Pile Cross Sections 

and/or View Pile Properties buttons. 

Click on the Close button to Close the Window and go back to the main window of the program. 

Please note that the data will not be transferred to the GROUP tables if the user closes the window 

before clicking on the Import Data button. 

 

 

3.3.23 Data – Import p-y Curves Generated by LPILE 

 

 This submenu option is used to import p-y curves generated by the LPILE program 

(v2012/2013/2015/2018/2019/2022). Actually, the user may be able to copy individual p-y curves using 

the option described item 3.3.13 (Data - Set of Soil Resistance (p-y) Curves). This option allows the user 

to transfer all the p-y curves generated by LPILE at once.  
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Figure 3.154  Import p-y curves from LPILE Window 

 

 

 

Click on the Browse and Open button to navigate and select the output file generated for LPILE 

(v 2012/2013/2018/2019/2022) which contains the p-y curve data. If p-y curve is available in the file, the 

curves will be read into memory and plotted in the graph.  

The button Open LPILE File Using Notepad is enabled after a successful reading of the file into 

memory. Please click into this button to edit the file and check the data read by the program.  

Click on the Import p-y Curves button to transfer the data in memory to the internal tables of 

GROUP 2022. Program will transfer all the curves if the Import All Curves option is selected; otherwise it 

will transfer only the selected curves. If the transferring of data was successful, a message indicating so 

will show up. It will also indicate the set number where the p-y curves were copied. The program 

automatically will convert the p-y curves values to the current units being used on the GROUP model.  
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To verify the correct transfer of the data (or to edit p-y curve tables) click on the Sets of p-y 

Curves button. Please refer to item  3.3.13 (Data - Set of Soil Resistance (p-y) Curves) for a full 

description on the window.  

Click on the Close button to Close the Window and go back to the main window of the program. 

Please note that the p-y curve data will not be transferred to the GROUP table if the user closes the 

window before clicking on the Import p-y curves button. 

 

 

3.3.24 Data - Import Nonlinear EI Data Generated by LPILE 

 

 This submenu option is used to import Moment Curvature data generated by the LPILE program 

(v2012/2013/2015/2018/2019/2022). Actually, the user may be able to copy individual Moment-

Curvature plots using the option described item 3.3.16 (Data - Sets of Nonlinear EI). This option allows 

the user to transfer all the moment curvature plots generated by LPILE at once.  
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Figure 3.155  Import Nonlinear EI Data from LPILE Window 

 

Click on the Browse and Open button to navigate and select the output file generated for LPILE 

(v 2012/2013/2018/2019/2022) which contains the Nonlinear EI data. If Moment curvature data is 

available in the file, the curves will be read into memory and plotted in the graph.  

The button Open LPILE File Using Notepad is enabled after a successful reading of the file into 

memory. Please click into this button to edit the file and check the data read by the program.  

Click on the Import Moment Curvature Sets button to transfer the data in memory to the 

internal tables of Group 2022. Program will transfer all the curves if the Import All Curves option is 

selected; otherwise it will transfer only the selected curves. If the transferring of data was successful, a 

message indicating so will show up. It will also indicate the set number(s) where the moment curvature 

data were copied. The program automatically will convert the moment curvature values to the current 

units being used on the GROUP model.  
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To verify the correct transfer of the data (or to edit p-y curve tables) click on the Sets of 

Nonlinear EI button. Please refer to item 3.3.16  (Data - Sets of Nonlinear EI) for a full description on the 

window.  

Click on the Close button to Close the Window and go back to the main window of the program. 

Please note that the Moment Curvature data will not be transferred to the GROUP table if the user 

closes the window before clicking on the Import p-y curves button. 

 

 

3.3.25 Data - Import Group Layout from Excel File 

 

 This submenu option is used to import a group layout from an excel file. The information 

required is consistent with the one listed in item 3.3.4 Data - Pile Group Properties and item 3.3.5 Data - 

Pile-Head Coordinates. User should take a look at the templates included in the examples folder to 

prepare a more complex pile group layout. Program does not check the consistency of the data in the 

excel file, so the file should be prepared with care to avoid crashing of the program. See item 3.3.27 

Data - Export Group Layout to Excel File, for sheets required in the excel file. 

 

 

3.3.26 Data - Import Loading from Excel File 

 

 This submenu option is used to import loading from an excel file. The information required is 

consistent with the one listed in item 3.3.11 Data - Loading. User should take a look at the templates 

included in the examples folder to prepare a more complex loading scheme. Program does not check the 

consistency of the data in the excel file, so the file should be prepared with care to avoid crashing of the 

program. See item 3.3.28Data - Export Loading to Excel File, for sheets required in the excel file. 

 

 

3.3.27 Data - Export Group Layout to Excel File 

 

 This submenu option is used to export a group layout to an excel file. The information exported 

is consistent with the one listed in item 3.3.4 Data - Pile Group Properties and item 3.3.5 Data - Pile-

Head Coordinates. User may use this option to generate a basic template in order to prepare a more 

complex pile group layout.  
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 The following sheets are generated in the excel file 

• Parameters.  Include Version Number, Analysis Mode and Units. 

• 3D-Layout.  Generated for 3D models. Include information for Pile Group Properties (item 3.3.4) 

and Pile Head Coordinates (item 3.3.5) 

• 2D-Layout.  Generated for 2D models. Include information for Pile Group Properties (item 3.3.4) 

and Pile Head Coordinates (item 3.3.5) 

• Comments.  General comments for some columns in Layout sheet. 

 

For a model using a flexible pile cap (Flexible Cap Version) the following additional sheets are 

generated 

• Node_Coordinates.  Include the node connectivity information (item 3.3.7.1) 

• Plate_Connectivity.  Include the information about plate connectivity (item 3.3.8.1) and plate 

offsets (item 3.3.8.2) 

• Beam_Connectivity.  Include the information about beam connectivity (item 3.3.9.1), beam 

offsets (item 3.3.9.2), beam end zones (item 3.3.9.3) and beam rotation (item 3.3.9.4) 

• Conc.Springs_Nodes. Include information for Concentrated Springs at Nodes (item 3.3.10.1) 

• Dist.Springs_Plates. Include information for Distributed Springs on Plates (item 3.3.10.2) 

• Dist.Springs_Beams. Include information for Distributed Springs on Beams (item 3.3.10.3) 

 

 

3.3.28 Data - Export Loading to Excel File 

 

 This submenu option is used to export loading to an excel file. The information exported is 

consistent with the one listed in item 3.3.11 Data - Loading. User may use this option to generate a basic 

template in order to prepares a more complex loading scheme.  

 The following sheets are generated in the excel file 

• Parameters.  Include Version Number, Analysis Mode and Units. 

• Load Cases.  Include definition for the load cases (item 3.3.11.1), parameters for the load case 

(item 3.3.11.2),  and analysis options (item 3.3.11.15). The sheet is always created, but it may be 

blank if no load cases are defined. 

• Conc.Loads-3D.  Generated for 3D models. Include information for definition of concentrated 

loads at pile cap (item 3.3.11.4 ). Information for each load case can be separated by a blank 

line. The sheet is always created for a 3D model, but it may be blank if no concentrated loads 

are defined in any load case. 

• Conc.Loads-2D.  Generated for 2D models. Include information for definition of concentrated 

loads at pile cap (item 3.3.11.4 ). Information for each load case can be separated by a blank 
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line. The sheet is always created for a 2D model, but it may be blank if no concentrated loads 

are defined in any load case. 

• Spec.Disp.-3D.  Generated for 3D models. Include information for definition of specified 

displacements at pile cap (item 3.3.11.5 ). Information for each load case can be separated by a 

blank line. The sheet is always created for a 3D model, but it may be blank if no specified 

displacements are defined in any load case. 

• Spec.Disp.-2D.  Generated for 2D models. Include information for definition of specified 

displacements at pile cap (item 3.3.11.5 ). Information for each load case can be separated by a 

blank line. The sheet is always created for a 2D model, but it may be blank if no specified 

displacements are defined in any load case. 

• Stiffness.  Include information for definition of foundation stiffness at pile cap (item 3.3.11.14 ). 

Information for each load case can be separated by a blank line. The sheet is always created, but 

it may be blank if no stiffness option is defined in any load case. 

• Incremental.  Include information for definition of incremental/pushover analysis (item  

3.3.11.14). Information for each load case can be separated by a blank line. The sheet is always 

created, but it may be blank if no incremental/pushover analysis is defined in any load case. 

• Dist.Load-3D.  Generated for 3D models. Include information for definition of distributed loads 

along the piles (item 3.3.11.11). Information for each load case can be separated by a blank line. 

The sheet is always created for a 3D model, but it may be blank if no distributed loads are 

defined in any load case. 

• Dist.Load-2D.  Generated for 2D models. Include information for definition of distributed loads 

along the piles (item 3.3.11.11). Information for each load case can be separated by a blank line. 

The sheet is always created for a 2D model, but it may be blank if no distributed loads are 

defined in any load case. 

• Soil Move.-3D.  Generated for 3D models. Include information for definition of soil movement 

along the piles (item 3.3.11.11). Information for each load case can be separated by a blank line. 

The sheet is always created for a 3D model, but it may be blank if no soil movement are defined 

in any load case. 

• Soil Move.-2D.  Generated for 2D models. Include information for definition of soil movement 

along the piles (item 3.3.11.11). Information for each load case can be separated by a blank line. 

The sheet is always created for a 2D model, but it may be blank if no soil movement are defined 

in any load case. 

• Load Comb.  Include definition for the load combinations (item 3.3.11.17), parameters for the 

load combination (item 3.3.11.18), and analysis options (item 3.3.11.15). The sheet is always 

created, but it may be blank if no load combinations are defined. 

• Comb-Factors.  Include definition for each load combination (item 3.3.11.18). The sheet is 

always created, but it may be blank if no combinations are defined in any load combination. 

• Comments.  General comments for this file. 
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For a model using a flexible pile cap (Flexible Cap Version) the following additional sheets are 

generated 

• Spec.Disp_Nodes. Include information for Specified Displacements at Nodes (item 

3.3.11.63.3.11.73.3.10.1) 

• Conc.Loads_Nodes. Include information for Concentrated Loads at Nodes (item 

3.3.11.73.3.10.1) 

• Dist.Loads_Plates. Include information for Distributed Loads on Plates (item 3.3.11.8) 

• Dist.Loads_Beams. Include information for Distributed Loads on Beams (item 3.3.11.9) 

• Conc.Loads_Beams. Include information for Concentrated Loads on Beams (item 3.3.11.10) 

 

 

3.4 Edit Menu (Editing Objects Using Graphics Tools) 
 

 To activate the options under the Edit menu, the 3D View window must be open. 

. 

 

Figure 3.156  Edit Menu with 3D View Active 

 

. 
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Figure 3.157  Edit Menu with 3D View Active - Flexible Cap Version 
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3.4.1 Edit - Select Piles 

 

Activate Select Piles by clicking on Select Piles in the Edit menu.  Note that the Select Piles 

option is checked.  Also Select Piles can be activated by clicking on the Select Piles tool button. 

 

 Then, left click the desired pile to select it, and the selected pile will be shown in red.  The status 

bar (at the bottom of the screen) will indicate the number of selected piles. 

 

 

 
Figure 3.158  Selection by clicking 
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 Selection can also be made using a box, by left clicking and dragging the mouse.  Again, the 

selected piles will be shown in red.   

 

 
 

Figure 3.159  Selection using a box 

 

 To add piles to the selection, hold the Shift or Ctrl keys while selecting the new piles.  To remove 

piles from the selection, press the Ctrl key and click on the pile(s) you wish to deselect. 
 

 To deactivate the Select Piles, click on Select Piles in the Edit menu.  Note that the Select Piles 

option is not checked 
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3.4.2 Edit - Select Mode - Flexible Cap Version 

 

Use this option to activate selection for all the objets in the model. This option include Select 

Piles, Select Plates, Select Beams and Select nodes.  Also Select Mode can be activated by clicking on 

the Select Mode tool button. 

 

 To deactivate the Select Mode, click on Select Mode in the Edit menu.  Note that the Select 

Mode option is not checked 

 

 
 

3.4.3 Edit - Select Plates - Flexible Cap Version 

 

Activate Select Plates by clicking on Select Plates in the Edit menu.  Note that the Select Plates 

option is checked.  Also Select Plates can be activated by clicking on the Select Plates tool button. 

 

 Then, left click the desired plate to select it, and the selected plate will be shown in purple.  The 

status bar (at the bottom of the screen) will indicate the number of selected plates. 

 

 Selection can also be made using a box, by left clicking and dragging the mouse.  The selected 

plates will be shown in purple.   
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Figure 3.160  Selection of plates - Flexible Cap Version 

 

 To add plates to the selection, hold the Shift or Ctrl keys while selecting the new plates.  To 

remove plates from the selection, press the Ctrl key and click on the plate(s) you wish to deselect. 
 

 To deactivate the Select Plates, click on Select Plates in the Edit menu.  Note that the Select 

Plates option is not checked 
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3.4.4 Edit - Select Beams - Flexible Cap Version 

 

Activate Select Beams by clicking on Select Beams in the Edit menu.  Note that the Select 

Beams option is checked.  Also Select Beams can be activated by clicking on the Select Beams tool 

button. 

 

 Then, left click the desired plate to select it, and the selected beam will be shown in red.  The 

status bar (at the bottom of the screen) will indicate the number of selected beams. 

 

 Selection can also be made using a box, by left clicking and dragging the mouse.  The selected 

beams will be shown in red.   

 

 

  
 

Figure 3.161  Selection of beams - Flexible Cap Version 
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 To add beams to the selection, hold the Shift or Ctrl keys while selecting the new beams.  To 

remove beams from the selection, press the Ctrl key and click on the beam(s) you wish to deselect. 
 

 To deactivate the Select Beams, click on Select Beams in the Edit menu.  Note that the Select 

Beams option is not checked 

 

 
 

3.4.5 Edit - Select Nodes - Flexible Cap Version 

 

 Activate Select Nodes by clicking on Select Nodes in the Edit menu.  Note that the Select Nodes 

option is checked.  Also Select nodes can be activated by clicking on the Select nodes tool button. 

 

 Then, left click the desired node to select it, and the selected node will be shown in light blue.  

The status bar (at the bottom of the screen) will indicate the number of selected nodes. 

 

 Selection can also be made using a box, by left clicking and dragging the mouse.  The selected 

nodes will be shown in light blue.   
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Figure 3.162  Selection of nodes - Flexible Cap Version 

 

 To add nodes to the selection, hold the Shift or Ctrl keys while selecting the new nodes.  To 

remove nodes from the selection, press the Ctrl key and click on the node(s) you wish to deselect. 
 

 To deactivate the Select Nodes, click on Select Nodes in the Edit menu.  Note that the Select 

Nodes option is not checked 

 

 

 Note, that the Selection can be performed for Piles, Plates, Beams and Nodes at the same time.   
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Figure 3.163  Selection of piles, plates and nodes - Flexible Cap Version 
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3.4.6 Edit – Pause Select 

 

 Activate Pause Select by clicking on Pause Select in the Edit menu.  Note that the Pause Select 

option is checked.  Also pause select can be activated by clicking on the Pause Select tool button. 

 

 The Pauses Select option is enabled after the Select Piles (or Select Plates or Select Beams or 

Select Nodes for the Flexible Cap Version) is activated. Be activating this option the current selection will 

be kept in memory, allowing to perform view transformations like translation rotation and zooming 

(which are deactivated while any Selection is activated). After getting the required view transformation 

deactivate the Pause Select option to continue with selection. 

 

 To deactivate the Pause Select, click on Pause Select in the Edit menu.  Note that the Pause 

Select option is not checked 

 

 

3.4.7 Edit -Add Pile 

 

 Select the Add Pile item from the Edit menu or click the Add Pile tool button.  Then the New 

Pile window will appear.  The window will vary between 2D and 3D models. 
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Figure 3.164  New Pile Window.  2D Model 
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Figure 3.165  New Pile Window.  3D Model 

 

 Fill in the necessary information and click the OK button to save and close the window, or click 

the Save and Add New Pile button to save the information and return to the same window to add an 

additional pile, or click the Cancel button to cancel the process and close the window.  Refer to Data - 

Pile Group Properties and Data - Pile Head Coordinates for a description of the different input 

parameters. 
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3.4.8 Edit - Pile Layout  

 

 Select the Pile Layout item from the Edit menu or click the Pile Layout tool button.  The Pile 

Layout window will appear (this window is similar to the New Pile window).  In this window the user 

may change the input parameters. 

 

 The Pile Layout window will vary slightly whether there are some piles selected or not 

 

 If no piles are selected the window will show up the input parameters of the current pile 

(starting with pile number 1).  The user may navigate throughout the different piles using the Previous 

and Next buttons displayed at the bottom of the window.  Also, the user may jump to a pile number by 

selecting the Pile Number at the Select Pile Number pull-down menu and then clicking the Go button.  

The current pile will be highlighted in the 3D View window with green color. 
 

  

Figure 3.166  Pile Layout Window.  No piles Selected 
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 If piles are selected the window will show up the input information of the selected piles (which 

are highlighted in the 3D View window in red color).  In this window the input parameters that are 

similar to all the selected piles are displayed in white background, while the input parameters that are 

not the same for all the selected piles are shown in gray background.  Any change in the input 

parameters will be assigned for all the piles selected. 
 

 

  

Figure 3.167  Pile Layout Window.  Piles Selected 
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3.4.9 Edit - Delete Piles 

 

 Please note that this option is enabled after a selection has been performed.  Delete piles by 

choosing Delete Pile(s) under the Edit menu, or by clicking the Delete Pile tool button.  Then, a window 

for confirmation of the deletion will appear.  Click “OK” to complete the deletion, or click “Cancel” to 

cancel the deletion process. 

 

 

Figure 3.168  Window for confirmation of deletion 

 

 Please note that pile numbering may be rearranged after deletion of piles. 

 

 

3.4.10 Edit - Move Piles 

 

Please note that this option is enabled after copying has been performed.  Move the selected piles, by 

choosing Move Pile(s) from the Edit menu or by clicking the Move Pile(s) tool button.  The Move 

Options window will then appear.   

 By default, the Absolute Coordinates option is selected.  The reference point is the pile head 

position of the first selected pile.  The program will estimate the increment by the difference between 

the target and the reference point 
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Figure 3.169  Move Options Window.  Absolute Coordinates 

 

 If the Relative Coordinates option is selected, then the user must provide the coordinate 

increment. 

 

 

 

 
Figure 3.170  Move Options Window.  Relative Coordinates 



CHAPTER 3    References for Data Input     3-52 

 

GROUP 2022 for Windows User's Manual 
 

Fill in the necessary fields and click “OK” to finish the moving process, or click “Cancel” to cancel the 

process.   
 

3.4.11 Edit - Copy Piles 

 

 Please note that this option is only enabled after a selection has been performed.  Copy the 

selected piles to the buffer by choosing Copy from the Edit menu or by clicking the Copy Pile tool 

button.   

 

3.4.12 Edit - Paste Pile 

 

 Please note that this option is enabled after copying has been performed.  Paste the selected 

piles, by choosing Paste from the Edit menu or by clicking the Paste Pile tool button.  The Paste Options 

window will then appear.   

 By default, the Absolute Coordinates option is selected.  The reference point is the pile head 

position of the first selected pile.  The program will estimate the increment by the difference between 

the target and the reference point 

 

 

 

 
Figure 3.171  Paste Options Window.  Absolute Coordinates 
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 If the Relative Coordinates option is selected, then the user must provide the coordinate 

increment. 

 

 

 
Figure 3.172  Paste Options Window.  Relative Coordinates 

 

Fill in the necessary fields and click “OK” to finish the copying and pasting process, or click “Cancel” to 

cancel the process.   

 

3.4.13 Edit - Paste Array 

 

 Please note that this option is enabled after the copying process has been performed.  Paste 

using an array of the selected piles, by selecting Paste Array from the Edit menu, or by clicking the Paste 

Array tool button.  The Paste Array Options window will then appear. 
 

 Fill in the necessary fields and click “OK” to finish the copying and pasting process, or click 

“Cancel” to cancel the process. 
 

 Two paste array schemes are available.  Rectangular array and Polar Array 
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For the rectangular array, the space increment in X, Y and Z directions and the number of rows to be 

copied in X, Y and Z directions are required 
 

 

 

Figure 3.173  Paste Array Options Window.  Rectangular array 

 

 

Figure 3.174  Pile layout after paste using rectangular array 
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For the polar array, the center of generation point (X, Y and Z), the number of lines to be generated, and 

the angle increment are required 
 

 

Figure 3.175  Paste Array Options Window.  Polar array 

 

 

Figure 3.176  Pile layout after paste using polar array 
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3.4.14 Edit -Add Plate - Flexible Cap Version 

 

 Select the Add Plate item from the Edit menu.  Then the New Plate window will appear. 

 

     

 

Figure 3.177  New Plate Window - Flexible Cap Version  

 

 

 Fill in the necessary information and click the OK button to save and close the window, or click 

the Save and Add New Plate button to save the information and return to the same window to add an 

additional plate, or click the Cancel button to cancel the process and close the window. Please note that 

the program may get the selected node by clicking on the Get Selected button.  
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3.4.15 Edit – Edit Plate  

 

 Select the Edit Plate item from the Edit menu.  The Edit Plate window will appear (this window 

is similar to the New Plate window).  In this window the user may change the input parameters. 

 

 The Edit Plate window will vary slightly whether there are some plates selected or not 

 

 If no plates are selected the window will show up the input parameters of the current plate 

(starting with plate number 1).  The user may navigate throughout the different plates using the arrows 

at the right of Plate Number.  Also, the user may jump to a plate number by selecting the Plate Number 

at the combo box under Plate Number.  The current plate will be highlighted in the 3D View window 

with light blue color. 
 

   

Figure 3.178  Edit Plate Window.  No plates Selected - Flexible Cap Version 

 

 If plates are selected the window will show up the input information of the selected plates 

(which are highlighted in the 3D View window in purple color).  In this window the input parameters 

that are similar to all the selected plates are displayed in white background, while the input parameters 
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that are not the same for all the selected plates are shown in gray background.  Any change in the input 

parameters will be assigned for all the plates selected. 
 

 

   

Figure 3.179  Edit Plate Window.  Plates Selected - Flexible Cap Version 

 

 

 

3.4.16 Edit - Delete Plates (Flexible Cap Version) 

 

 Please note that this option is enabled after a selection has been performed.  Delete plates by 

choosing Delete Plate(s) under the Edit menu.  Then, a window for confirmation of the deletion will 

appear.  Click “OK” to complete the deletion, or click “Cancel” to cancel the deletion process. 
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Figure 3.180  Window for confirmation of plates deletion - Flexible Cap Version 

 

 

3.4.17 Edit - Divide Plates - Flexible Cap Version 

 

 Please note that this option is enabled after a selection has been performed.  By selecting this 

option, the Divide Plates window will appear. 

 

   

Figure 3.181  Divide Plates Window - Flexible Cap Version 

 

 Enter the number of divisions on the local Y and Z directions (refer to Figure 3.81 for axis 

definition and node numbering) and click “OK” to finish the plate division process, or click “Cancel” to 

cancel the process. 
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 The program will divide only the selected plates; however, it is recommended to divide all the 

plates that belong to the mesh to guarantee mesh compatibility among all the plates. 
 

 
a) Original Mesh     b) After Divide Plates 

Figure 3.182  Divide Plates option - Flexible Cap Version 

 

 

 

3.4.18 Edit -Add Beam - Flexible Cap Version 

 

 Select the Add Beam item from the Edit menu.  Then the New Beam window will appear. 
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Figure 3.183  New Beam Window - Flexible Cap Version  

 

 

 Fill in the necessary information and click the OK button to save and close the window, or click 

the Save and Add New Beam button to save the information and return to the same window to add an 

additional beam, or click the Cancel button to cancel the process and close the window. Please note that 

the program may get the selected node by clicking on the Get Selected button.  
 

 

3.4.19 Edit – Edit Beam  

 

 Select the Edit Beam item from the Edit menu.  The Edit Beam window will appear (this window 

is similar to the New Beam window).  In this window the user may change the input parameters. 

 

 The Edit Beam window will vary slightly whether there are some beams selected or not 
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 If no beams are selected the window will show up the input parameters of the current beam 

(starting with beam number 1).  The user may navigate throughout the different beams using the arrows 

at the right of Beam Number.  Also, the user may jump to a beam number by selecting the Beam 

Number at the combo box under Beam Number.  The current beam will be highlighted in the 3D View 

window with yellow color. 
 

   

Figure 3.184  Edit Beam Window.  No beams Selected - Flexible Cap Version 

 

 If beams are selected the window will show up the input information of the selected beams 

(which are highlighted in the 3D View window in purple color).  In this window the input parameters 

that are similar to all the selected plates are displayed in white background, while the input parameters 

that are not the same for all the selected plates are shown in gray background.  Any change in the input 

parameters will be assigned for all the plates selected. 
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Figure 3.185  Edit Beam Window.  Beams Selected - Flexible Cap Version 

 

 

 

3.4.20 Edit - Delete Beams (Flexible Cap Version) 

 

 Please note that this option is enabled after a selection has been performed.  Delete beams by 

choosing Delete Beam(s) under the Edit menu.  Then, a window for confirmation of the deletion will 

appear.  Click “OK” to complete the deletion, or click “Cancel” to cancel the deletion process. 

 

  

Figure 3.186  Window for confirmation of beams deletion - Flexible Cap Version 
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3.4.21 Edit - Divide Beams - Flexible Cap Version 

 

 Please note that this option is enabled after a selection has been performed.  By selecting this 

option, the Divide Beams window will appear. 

 

   

Figure 3.187  Divide Beams Window - Flexible Cap Version 

 

 Enter the number of divisions on the local X directions (refer to Figure 3.86 for axis definition 

and node numbering) and click “OK” to finish the beam division process, or click “Cancel” to cancel the 

process. 
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b) Original Mesh     b) After Divide beams 

Figure 3.188  Divide Beams option - Flexible Cap Version 

 

 

3.4.22 Edit -Add Node - Flexible Cap Version 

 

 Select the Add Node item from the Edit menu.  Then the New Node window will appear. 

 

   

 

Figure 3.189  New Node Window - Flexible Cap Version  
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 Fill in the necessary information and click the OK button to save and close the window, or click 

the Save and Add New Node button to save the information and return to the same window to add an 

additional plate, or click the Cancel button to cancel the process and close the window.   
 

3.4.23 Edit – Edit Node  

 

 Select the Edit Node item from the Edit menu.  The Edit Node window will appear (this window 

is similar to the New Node window).  In this window the user may change the input parameters. 

 

 The Edit Node window will vary slightly whether there are some nodes selected or not 

 

 If no nodes are selected the window will show up the input parameters of the current node 

(starting with node number 1).  The user may navigate throughout the different nodes using the arrows 

at the right of Node Number.  Also, the user may jump to a node number by selecting the Node Number 

at the combo box under Node Number.  The current node will be highlighted in the 3D View window 

with yellow color. 
 

  

Figure 3.190  Edit Node Window.  No nodes Selected - Flexible Cap Version 
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 If nodes are selected the window will show up the input information of the selected nodes 

(which are highlighted in the 3D View window in light blue color).  In this window the input parameters 

that are similar to all the selected nodes are displayed in white background, while the input parameters 

that are not the same for all the selected nodes are shown in gray background.  Any change in the input 

parameters will be assigned for all the nodes selected. 
 

 

  

Figure 3.191  Edit Node Window.  Nodes Selected - Flexible Cap Version 

 

 

 

3.4.24 Edit - Delete Nodes - Flexible Cap Version 

 

 Please note that this option is enabled after a selection has been performed.  Delete nodes by 

choosing Delete Node(s) under the Edit menu.  Then, a window for confirmation of the deletion will 

appear.  Click “OK” to complete the deletion, or click “Cancel” to cancel the deletion process. Note that 

only unconnected nodes will be deleted. 
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Figure 3.192  Window for confirmation of nodes deletion - Flexible Cap Version 

 

 

3.4.25 Edit - Delete Unconnected Nodes - Flexible Cap Version  

 

 Delete unconnected nodes by choosing Delete Unconnected Node(s) under the Edit menu.  

Then, a window for confirmation of the deletion will appear.  Click “OK” to complete the deletion, or 

click “Cancel” to cancel the deletion process.  

 

   

Figure 3.193  Window for confirmation of unconnected nodes deletion - Flexible Cap Version 
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3.4.26 Edit – Move All Selected – Flexible Cap Version 

 

 Please note that this option is enabled after selection of pile(s) node(s), plate(s) and/or beam(s). 

has been performed. Move the selected objects, by choosing Copy Node(s), Plate(s) and/or (Beam(s) 

from the Edit menu.  The Move All Selected window will then appear.   

 By default, the Absolute Coordinates option is selected.  Users should enter values for reference 

and target point.  The program will estimate the increment by the difference between the target and the 

reference point. 

If the Relative Coordinates option is selected, then the user must provide the coordinate 

increment. 

 

Fill in the necessary fields and click “OK” to finish the moving process, or click “Cancel” to cancel 

the process.   

 

Please note that some objects like beam and plates elements may not be moved if all the 

objects were not selected. 

 
 

     

Figure 3.194  Move All Selected Window – Flexible Cap Version 
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3.4.27 Edit – Move All Selected – Flexible Cap Version 

 

 Please note that this option is enabled after selection of node(s), plate(s) and/or beam(s). has 

been performed. Copy the selected objects, by choosing Copy Pile(s), Node(s), Plate(s) and/or (Beam(s) 

from the Edit menu.  The Copy All Selected window will then appear.   

 By default, the Absolute Coordinates option is selected.  Users should enter values for reference 

and target point.  The program will estimate the increment by the difference between the target and the 

reference point. 

If the Relative Coordinates option is selected, then the user must provide the coordinate 

increment. 

 

Fill in the necessary fields and click “OK” to finish the copying process, or click “Cancel” to cancel 

the process.   

 
 

     

Figure 3.195  Copy All Objects Window – Flexible Cap Version 
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3.4.28 Edit - Delete All Selected - Flexible Cap Version  

 

 Please note that this option is enabled after a selection has been performed.  Delete all selected  

by choosing Delete All Selected under the Edit menu.  Then, a window for confirmation of the deletion 

will appear.  Click “OK” to complete the deletion, or click “Cancel” to cancel the deletion process. Note 

that all elements (piles, plates and/or beams and maybe nodes selected  will be deleted. 

 

    

Figure 3.196  Window for confirmation of all selected elements deletion - Flexible Cap Version 

 

 

 

3.4.29 Edit - Pile Sets 

 

 This submenu option allows to define pile sets that can be used to assign loading along the piles 

or to be used for selection  

 By selecting this option, the Pile Sets Definition window will appear 

 

3.4.29.1 Pile Sets Definition Window 

 

 In this window the pile sets definition is carried out.  A sample of this window is shown in Figure 

3.197 
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Figure 3.197  Pile Sets Definition Window 

 

 

 

Sets Definition 

• Add Set.  Add a new row at the end of the list. 

• Insert Section.  Add a new row above the current row. 

• Delete Section.  Delete the current row.   

• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a section. 

• Highlight Current Set.  If this option is checked the program will highlight (with a different color) 

the current set. 

 

 For each set (row) the following columns are available: 

•  Edit Set.  Click on the Edit Set button to open the Edit Pile Set window for assigning the piles 

that will belong to the pile set being defined. 

• Set Name.  In the second column enter the name associated with the set being defined. The 

name should start with a letter and should not contain blanks. The Name ALL is reserved for set 

1 and correspond to all the piles in the model. 

• # Obj.  In the third column the number of objects currently assigned to the set is displayed. 
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Close Button 

 Click on the Close button to close the window and go back to the GROUP window. 

 

 

 

3.4.29.2 Edit Pile Set Window 

 

 In this window the user can define the piles that belong to the current set. The set number is 

displayed at the top of the window.  A sample of this window is shown in Figure 3.198. 

 

 

   

Figure 3.198  Edit Pile Set Window 
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Set Definition 

• Add From Input List.  Click on this button to add pile numbers to the pile set from the numbers 

entered in the Input List field. Entries in the Input List field are separated by the comma symbol 

“,”, and a sequence is indicated by the column symbol “:”. For instance, the sequence “1:5” will 

indicate the list 1,2,3,4,5 and the sequence “1:5:2” will indicate the sequence 1,3,5. 

• Add From Selected.  Click on this button to add object to the pile set from the selected piles. 

• Edit Set.  Click on this button to open a dialog to edit the pile set being defined. 

• Clear Set.  Click on this button to clear all the current entries of the pile set. 

• Highlight Current Set.  If this option is checked the program will highlight (with a different color) 

the current set. 

 

Options 

• Append.  Select this option if new entries will be added to the current entries in the set. 

• Replace.  Select this option if new entries will be replacing the current entries in the set. 

 

 

Close Button 

 Click on the Close button to close the window and go back to the Pile Sets Definition window. 

 

 

3.4.30 Edit - Plate Sets - Flexible Cap Version 

 

 This submenu option allows to define plate sets that can be used to assign springs or loading on 

plates or to be used for selection  

 By selecting this option, the Plate Sets Definition window will appear 

 

3.4.30.1 Plate Sets Definition Window 

 

 In this window the plate sets definition is carried out.  A sample of this window is shown in  

Figure 3.199 
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Figure 3.199  Plate Sets Definition Window - Flexible Cap Version 

 

 

Sets Definition 

• Add Set.  Add a new row at the end of the list. 

• Insert Section.  Add a new row above the current row. 

• Delete Section.  Delete the current row.   

• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a section. 

• Highlight Current Set.  If this option is checked the program will highlight (with a different color) 

the current set. 

 

 For each set (row) the following columns are available: 

•  Edit Set.  Click on the Edit Set button to open the Edit Plate Set window for assigning the plates 

that will belong to the plate set being defined. 

• Set Name.  In the second column enter the name associated with the set being defined. The 

name should start with a letter and should not contain blanks. The Name ALL is reserved for set 

1 and correspond to all the plates in the model. 

• # Obj.  In the third column the number of objects currently assigned to the set is displayed. 
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Close Button 

 Click on the Close button to close the window and go back to the GROUP window. 

 

 

 

3.4.30.2 Edit Plate Set Window 

 

 In this window the user can define the plates that belong to the current set. The set number is 

displayed at the top of the window.  A sample of this window is shown in Figure 3.200. 

 

 

    

Figure 3.200  Edit Plate Set Window - Flexible Cap Version 
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Set Definition 

• Add From Input List.  Click on this button to add plate numbers to the plate set from the 

numbers entered in the Input List field. Entries in the Input List field are separated by the 

comma symbol “,”, and a sequence is indicated by the column symbol “:”. For instance, the 

sequence “1:5” will indicate the list 1,2,3,4,5 and the sequence “1:5:2” will indicate the 

sequence 1,3,5. 

• Add From Selected.  Click on this button to add object to the plate set from the selected plates. 

• Edit Set.  Click on this button to open a dialog to edit the plate set being defined. 

• Clear Set.  Click on this button to clear all the current entries of the plate set. 

• Highlight Current Set.  If this option is checked the program will highlight (with a different color) 

the current set. 

 

Options 

• Append.  Select this option if new entries will be added to the current entries in the set. 

• Replace.  Select this option if new entries will be replacing the current entries in the set. 

 

 

Close Button 

 Click on the Close button to close the window and go back to the Plate Sets Definition window. 

 

 

3.4.31 Edit - Beam Sets - Flexible Cap Version 

 

 This submenu option allows to define plate sets that can be used to assign springs or loading on 

beams or to be used for selection  

 By selecting this option, the Beam Sets Definition window will appear 

 

3.4.31.1 Beam Sets Definition Window 

 

 In this window the beam sets definition is carried out.  A sample of this window is shown in 

Figure 3.201 
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Figure 3.201  Beam Sets Definition Window - Flexible Cap Version 

 

 

Sets Definition 

• Add Set.  Add a new row at the end of the list. 

• Insert Section.  Add a new row above the current row. 

• Delete Section.  Delete the current row.   

• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a section. 

• Highlight Current Set.  If this option is checked the program will highlight (with a different color) 

the current set. 

 

 For each set (row) the following columns are available: 

•  Edit Set.  Click on the Edit Set button to open the Edit Plate Set window for assigning the plates 

that will belong to the plate set being defined. 

• Set Name.  In the second column enter the name associated with the set being defined. The 

name should start with a letter and should not contain blanks. The Name ALL is reserved for set 

1 and correspond to all the beams in the model. 

• # Obj.  In the third column the number of objects currently assigned to the set is displayed. 

 



CHAPTER 3    References for Data Input     3-79 

 

GROUP 2022 for Windows User's Manual 
 

 

Close Button 

 Click on the Close button to close the window and go back to the GROUP window. 

 

 

 

3.4.31.2 Edit Beam Set Window 

 

 In this window the user can define the beams that belong to the current set. The set number is 

displayed at the top of the window.  A sample of this window is shown in Figure 3.200. 

 

 

     

Figure 3.202  Edit beam Set Window - Flexible Cap Version 
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Set Definition 

• Add From Input List.  Click on this button to add beam numbers to the plate set from the 

numbers entered in the Input List field. Entries in the Input List field are separated by the 

comma symbol “,”, and a sequence is indicated by the column symbol “:”. For instance, the 

sequence “1:5” will indicate the list 1,2,3,4,5 and the sequence “1:5:2” will indicate the 

sequence 1,3,5. 

• Add From Selected.  Click on this button to add object to the beam set from the selected beams. 

• Edit Set.  Click on this button to open a dialog to edit the beam set being defined. 

• Clear Set.  Click on this button to clear all the current entries of the beam set. 

• Highlight Current Set.  If this option is checked the program will highlight (with a different color) 

the current set. 

 

Options 

• Append.  Select this option if new entries will be added to the current entries in the set. 

• Replace.  Select this option if new entries will be replacing the current entries in the set. 

 

 

Close Button 

 Click on the Close button to close the window and go back to the Beam Sets Definition window. 

 

 

3.4.32 Edit - Node Sets - Flexible Cap Version 

 

 This submenu option allows to define node sets that can be used to assign loading along the 

nodes or to be used for selection  

 By selecting this option, the Node Sets Definition window will appear 

 

3.4.32.1 Node Sets Definition Window 

 

 In this window the node sets definition is carried out.  A sample of this window is shown in 

Figure 3.203. 
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Figure 3.203  Node Sets Definition Window - Flexible Cap Version 

 

 

Sets Definition 

• Add Set.  Add a new row at the end of the list. 

• Insert Section.  Add a new row above the current row. 

• Delete Section.  Delete the current row.   

• Confirm Deletion.  If this option is checked the program will require a confirmation before 

deleting a section. 

• Highlight Current Set.  If this option is checked the program will highlight (with a different color) 

the current set. 

 

 For each set (row) the following columns are available: 

•  Edit Set.  Click on the Edit Set button to open the Edit Node Set window for assigning the nodes 

that will belong to the node set being defined. 

• Set Name.  In the second column enter the name associated with the set being defined. The 

name should start with a letter and should not contain blanks. The Name ALL is reserved for set 

1 and correspond to all the piles in the model. 

• # Obj.  In the third column the number of objects currently assigned to the set is displayed. 
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Close Button 

 Click on the Close button to close the window and go back to the GROUP window. 

 

 

 

3.4.32.2 Edit Node Set Window 

 

 In this window the user can define the nodes that belong to the current set. The set number is 

displayed at the top of the window.  A sample of this window is shown in Figure 3.204. 

 

 

   

Figure 3.204  Edit Node Set Window - Flexible Cap Version 
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Set Definition 

• Add From Input List.  Click on this button to add node numbers to the node set from the 

numbers entered in the Input List field. Entries in the Input List field are separated by the 

comma symbol “,”, and a sequence is indicated by the column symbol “:”. For instance, the 

sequence “1:5” will indicate the list 1,2,3,4,5 and the sequence “1:5:2” will indicate the 

sequence 1,3,5. 

• Add From Selected.  Click on this button to add object to the node set from the selected nodes. 

• Edit Set.  Click on this button to open a dialog to edit the node set being defined. 

• Clear Set.  Click on this button to clear all the current entries of the node set. 

• Highlight Current Set.  If this option is checked the program will highlight (with a different color) 

the current set. 

 

Options 

• Append.  Select this option if new entries will be added to the current entries in the set. 

• Replace.  Select this option if new entries will be replacing the current entries in the set. 

 

 

Close Button 

 Click on the Close button to close the window and go back to the Node Sets Definition window. 
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3.5 Options Menu 
 

 This menu contains parameters that set preferences for the analytical run or problem 

description.  Three types of submenu choices are available.  Those ending with three periods (...) 

produce a sub-window for specification of further details.  Those ending with a right arrow ( ) will 

show a drop-down list of possible choices.  Finally, the selection of any other submenu option produces 

a check mark ( ) to indicate that it is active.   

 

     

Figure 3.205  Options contained in the Options Menu 
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Figure 3.206  Options contained in the Options Menu - Flexible Cap Version 
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3.5.1 Options - Units 

 

 This option provides the user with a choice of specifying input data in either English Units or 

International Units (S.I.  units).   

 

  

Figure 3.207  Units Option 

 

 In general, the following specific units of measurement will be used throughout the program: 

 

Units Length Force 

English (EN) 
(without kip option) 

feet (ft) 
inches (in) 

pounds (lbs) 

English (EN) 
(with kip option) 

feet (ft) 
inches (in) 

kips (kip) 

International (SI) meters (m), 
millimeters (mm) 

kilonewtons (kN) 

 
Table 3.11  Unit systems 

 

 The user may change from one system of units to the other as many times as desired.  The 

program will automatically convert all the appropriate input that was already specified for the user 

before the time of selection of a different system of units.  Small conversion errors may appear if 

multiple changes of units are performed.  The user must always check that the input data have been 

converted appropriately. 
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3.5.2 Options – Use Kips as Unit of Force 

 

 This option provides the user with a choice to use load in kips or pounds while using an English 

Units system. If the option is checked any variable related to loading (force) should be entered in kips, in 

the option is checked the loading (force) should be entered in pounds. The option files will be printed in 

a consistent manner. 

 The user may check or unchecked this option as many times as desired.  The program will 

automatically convert all the appropriate input that was already specified for the user before the time of 

selection of a different option.  Small conversion errors may appear if multiple changes of units are 

performed.  The user must always check that the input data have been converted appropriately. 

 

3.5.3 Options - Analysis Mode 

 

 GROUP allows the user to analyze the pile group either using 2-dimensional model or using 3- 

dimensional model.  The program will use the 3-dimensional mode as the default condition. 

 

 

Figure 3.208  Analysis Mode Option 

 

 For the 2-dimensional model, the user enters only three load components (vertical load in the X-

direction, lateral load in the Y-direction and bending moment in the Z-direction (X-Y plane).  A two-

dimensional model is recommended for conditions where piles are arranged symmetrically in a pile 

group.  For the 3-dimensional analysis both loads and moments in the X, Y and Z directions can be 

entered. 

 Some menu options and windows will change accordingly to the analysis mode selected. 

 When the user changes the Analysis Mode, the program will ask if the user wants to convert the 

pile group layout to the corresponding new mode.  For instance, the following window appears while 

changing from 3D Analysis to a 2D Analysis.  By clicking "Yes", the pile layout will be converted; by 

clicking "No", the pile configuration will be lost and by clicking "Cancel" the Mode change will be 

cancelled.  It is recommended to check the converted model for accuracy. 
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Figure 3.209  Message window to confirm conversion from 3D layout to a 2D layout 

 

 

3.5.4 Options – Pile Cap Type - Flexible Cap Version 

 

The standard version of the program GROUP 2022 consider the pile-cap using rigid assumptions. 

The flexible cap version of the program GROUP 2022 allows the user to analyze the pile cap 

either using a rigid model or a flexible model.  The program will use the rigid model as the 

default condition. The flexible model is only available for 3-dimensional analysis. 

 

 

Figure 3.210  Pile-Cap Type Options - Flexible Cap Version 

 

 For the rigid model, the movement of the pile-cap can be represented by the movement of the 

origin of coordinates. The origin of coordinates has 3 degrees of freedom for a 2-dimensional analysis 

and 6 degrees of freedom for a 3-dimensional analysis. 

For the flexible model, the pile-cap is discretized using a finite element model with 4 node plate 

elements and/or beam elements. Each node of the finite element mesh considers 6 degrees of freedom: 

3 translations and 3 rotations. The piles are connected to the pile-cap through rigid elements. 
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3.5.5 Options – Adjust Depth for Batter Piles 

 

 This option will be checked under program default conditions.  The check mark indicates that 

the program will use the vertical projection of the piles in order to estimate the soil resistance, p-y 

curves, t-z curves and q-w curves. If this option is unchecked the program will use the actual length of 

the pile to estimate soil resistance, as was performed in previous versions of GROUP.  

 

3.5.6 Options – Generate Axial L-D (and T-R) curves on Soil Profile 

 

 This option will be checked under program default conditions.  The check mark indicates that 

the program will generate the axial load versus displacement curves (and torque versus rotation curves) 

considering the soil profile for each pile and the batter angle. If this option is unchecked the program 

generate one curve per pile property, as was performed in previous versions of GROUP.  

 

3.5.7 Extend Interpolation for L-D (and T-R) curves 

 

 This option will be checked under program default conditions.  The check mark indicates that 

the program will extend the interpolation of the L-D (and T-R curves) towards the maximum defined. 

The program will use the value of load (torque) corresponding the to the maximum displacement 

(rotation) if the displacement (rotation) is larger than the maximum defined. The program will use the 

value of load (torque) corresponding the to the maximum displacement (rotation) if the displacement 

(rotation) is smaller than the minimum defined. If this option is not checked the program will use a value 

of zero in those events (as previous versions of GROUP)  

 

 

3.5.8 Use Layering Correction (Method of Georgadis) 

 

 This option will be checked under program default conditions.  The check mark indicates that 

the program will use layering correction. By unchecking this option, the program will not use a layering 

correction, so the equivalent depth of each layer will be equal to actual depth of the layer. 
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3.5.9 Do not use Layering Correction is soil above is of same type 

 

 This option will be unchecked under program default conditions.  The check mark indicates that 

the program will not estimate layering correction if soil above of current layer is of same material. By 

unchecking this option, the program will use a layering correction even if the soil above is of same type. 

 

 

3.5.10 Options - Modify Group Layout using Template 

 

 This option allows to modify the existing layout for a regular rectangular or circular pile group 

configuration. After selecting this option, the Modify Group Layout using Template Window will appear. 

The window is similar to the New from Template window described in item 3.2.2 (File - New from 

Template). Please refer to item  3.2.2 (File - New from Template) for a full description on the window. 

The new option in this window is the ability to define a new pile as shown in Figure 3.211 or select from 

a previous pile properties as shown in Figure 3.212. 

 

   

Figure 3.211  Modify Group Layout using Template Window. Defining new pile properties. 
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Figure 3.212  Modify Group Layout using Template Window. Using existing pile properties. 

 

 

3.5.11 Options - Modify Group Layout using Template – Flexible Cap Version 

 

 This option allows to modify the existing layout for a regular rectangular or circular pile group 

configuration. After selecting this option, the Modify Group Layout using Template Window will appear. 

The window is similar to the New from Template window described in item 3.2.3 (File - New from 

Template – Flexible Cap Version). Please refer to item 3.2.3 (File - New from Template – Flexible Cap 

Version) for a full description on the window. The new option in this window is the ability to define a 

new pile as shown in Figure 3.213 Figure 3.211or select from a previous pile properties as shown in 

Figure 3.214. 
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Figure 3.213  Modify Group Layout using Template Window. Defining new properties – Flexible Cap 
Version 

 

   

 

Figure 3.214  Modify Group Layout using Template Window. Using existing properties  – Flexible Cap 
Version. 
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3.5.12 Options - Modify Flexible Cap Layout using Template - Flexible Cap Version 

 

 This option allows to modify the existing flexible pile-cap finite element mesh. This option will 

only define rectangular pile-caps. After selecting this option, the Modify Flexible Cap Layout using 

Template Window will appear. 

 

   

 

Figure 3.215  Modify Flexible Cap Layout using Template Window - Flexible Cap Version 

 

 The following parameters can be defined in the Modify Flexible Cap Using Template window: 

• Plate Geometry Definition: Select between the options: By Number of Elements or By Grid 

Definition.  Various entries may show up or hide based on the selection. 
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• Minimum Number of Plate Elements: Enter the Minimum Number of Plates for generation of the 

rectangular finite element mesh. Enter number of elements for Y and Z directions.  

• Match Pile Coordinates with Finite Element Nodes: Check this option (default) to ensure a full 

compatibility between the finite element mesh of the pile-cap and pile head coordinates. 

• Pile-Cap Dimension: Enter the dimensions of the rectangular pile-cap in the Y and Z directions. 

• Pile-Cap Center Coordinates: Enter the coordinates for the center of the pile-cap (Y and Z 

coordinates). 

• Grid Definition: Enter the coordinates for the coordinates that will define the finite element mesh 

for the Y and Z directions. 

Other options of the window are similar to the New from Template window described in item 3.2.3 (File 

- New from Template – Flexible Cap Version). Please refer to item 3.2.3 (File - New from Template – 

Flexible Cap Version) for a description on those options. 

Note that the pile-cap is considered to be horizontal and the X coordinate of all the nodes that belong to 

the pile cap will be estimated based on the X coordinate of the pile group (minimum X value for all 

piles). A rigid element will be used to connect each pile head with a vertical projected node 

(recommended for compatibility) or inside plate or inside beam that belongs to the finite element mesh 

defining the flexible pile-cap. 

 

3.5.13 Options – Shift Piles and Soil Elevations 

 

This option allows the user to move up (or down) the pile head coordinates, soil coordinates and 

loading on pile cap. 
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Figure 3.216  Shifting Options 

 

For a model with a flexible pile-cap model (Flexible Cap Version). The vertical coordinates of the 

nodes that belong to the finite element mesh can also be shifted. 

 

     

Figure 3.217  Shifting Options - Flexible Cap Version 

 



CHAPTER 3    References for Data Input     3-96 

 

GROUP 2022 for Windows User's Manual 
 

 Click OK to shift the checked data based on the values entered. 

 

 

3.5.14 Options - Enter User-Defined Soil-Resistance (p-y) Curves 

 

 This option will be unchecked under program default conditions.  The check mark indicates that 

the model may include User-Defined soil-resistance curves.  If this option is check-marked the option 

Sets of Soil-Resistance (p-y) Curves in the Data menu is activated.  Extra information will also need to be 

inputted in the Soil-Resistance (p-y) Curve Set column of the Pile Groups window under the Data menu. 

 

3.5.15 Options - Enter User-Defined Load-Displacement Curves 

 

 This option will be unchecked under program default conditions.  The check mark indicates that 

the program will accept User-Defined load-displacement curves.  If this option is check-marked the 

option Sets of Axial Load-Displacement Curves in the Data menu is activated.  Extra information will 

also need to be inputted in the Axial Load-Settle.  Curve Set column of the Pile Groups window under 

the Data menu. 

 

3.5.16 Options - Enter User-Defined Torque-Rotation Curves 

 

 This option is enabled for a 3-dimensional model.  This option will be unchecked under program 

default conditions.  The check mark indicates that the program will accept User-Defined torque-rotation 

curves.  If this option is check-marked the option Sets of Torque-Rotation Curves in the Data menu is 

activated.  Extra information will also need to be inputted in the Torque-Rotation Curve Set column of 

the Pile Groups (3D) window under the Data menu. 

 

3.5.17 Options – Consider Non-Symmetric Sections for Nonlinear EI 

 

 This option will be unchecked under program default conditions.  The check mark indicates that 

the program will be able to estimate nonlinear bending stiffness for non-symmetric sections, for this 

case the moment curvature may be non-symmetric and it will have positive and negative values. By 

unchecking this option, the program will be able to consider only symmetric sections for the estimation 
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of nonlinear bending stiffness, for this case the moment curvature estimated will be assumed to be 

symmetric and it will have only positive values.  

 

3.5.18 Options - Reduction Factors for Lateral Loads 

 

 By selecting this option, the Reduction Factors for Lateral Loads Window will appear.  

Under default conditions, group-reduction factors will not be considered for lateral loading. 

 

   

Figure 3.218  Reduction Factors for Lateral Loads Window 

 

 The user is provided with the following options: 

o Ignore Effects: Indicates that the group effects of closely-spaced piles will be ignored  
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o Specify: Indicates that the user will directly specify the values of reduction factors for lateral 

loads. Those values are specified in the P-Multiplier and Y-Multiplier columns of the Pile 

Groups window under the Data menu. 

o Automatically Generate: Indicates that the program will automatically generate reduction 

factors for piles in a closely-spaced group.  

For the latest two options the user can assign one of the next two sub-options: 

▪ Get movement from analysis: The program will get the direction of cap movement 

from the analysis. For a rigid cap model the program uses the movement (Y and Z) 

at the origin of coordinates. For a flexible cap model (Flexible Cap Version), the 

program uses the averaged movement from all the FEM nodes that belong to the 

pile cap. 

▪ Define reference movement: The direction of movement will be specified by the 

user in the UY and UZ fields. Check on this option if there are problems of 

convergence and the solution is moving back and forth between iterations. You can 

do an initial analysis using ignoring effects to get the direction of movement and 

then do the final analysis using this option. 

 

  Information about these factors are included in Chapter 6 in the Technical Manual, “Reduction 

Factor for Soil Resistance in a Closely-Spaced Pile Group”. 

 

3.5.19 Options - Reduction Factors for Lateral Loads Along Depth 

 

 Under default conditions, reduction factors for lateral loads along depth will not be considered.  

This option should be selected if the user wishes to consider a reduction factor for lateral loading along 

depth.  If this option is check-marked the option Sets of Red. Fact. Lateral Load along Piles in the Data 

menu is activated.  Extra information will also need to be inputted in the Set of Lateral Red. Factor 

along Depth column of the Pile Groups window under the Data menu. 

 

 

3.5.20 Options - Reduction Factors for Axial Loads 

 

 Under default conditions, reduction factors for axial loads will not be considered for axial 

loading.  This option should be selected if the user wishes to consider a reduction factor for axial 

loading.  The reduction factors for axial loads will be specified by the user in the Red. Factor Axial Load 

column of the Pile Groups window under the Data menu. 
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  Information about these factors are included in Chapter 7 in the Technical Manual, “Reduction 

Factors for Piles under Axial Loading in a Closely-Spaced Pile Group”. 

 

3.5.21 Options - Print Generated p-y Curves 

 

 If the user wishes to print p-y curves at selected depths for verification purposes, this option 

must be checked.  If this option is check-marked, the option Sets of Data to Print generated p-y curves 

under the Data menu is activated. 

 

 

3.5.22 Options - Default Control Options ... 

 

 By selecting this option, the Default Control Options Window will appear. 
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Figure 3.219  Default Control Options Window 

 

A general description for the data needed under each computation parameter is listed below.  

o Maximum Iterations on Pile Group.  This is the maximum number of iterations allowed for 

the global behavior of the pile group.  The default value is 100. 

o Maximum Iterations on Individual Pile.  This is the maximum number of iterations allowed 

for each individual pile.  The default value is 100. 

o Tolerance on Equilibrium of Pile Group.  

• Primary relative criteria (DU/U). This is the maximum tolerated relative error on pile 

cap deflections computed by two consecutive iterations for the global pile group.  

The default value is 0.0001. 
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• Alternative absolute criteria. Check this option for using an absolute criteria to check 

the convergence on the pile cap. If checking this option, the following two values 

must be input: 

• Tolerance of Cap Deflection.  This is the maximum tolerated difference on cap 

deflections computed by two consecutive iterations for the pile group.  The default 

value is 0.0001 in (2.54 x 10-6 m). 

• Tolerance of Cap Rotation.  This is the maximum tolerated difference on cap 

deflections computed by two consecutive iterations for the pile group.  The default 

value is 1 x 10-6 rad. 

•  

o Tolerance on Pile Deflection.  This is the maximum tolerated difference on pile deflections 

computed by two consecutive iterations for individual piles.  The default value is 0.0001 in 

(2.54 x 10-6 m). 

o Initial Step Increment.  This value is helpful if the program is not able to reach convergence 

by applying the total load.  The user may use this value to apply the load in steps.  At each 

step the program will apply an increment of load equal to this value times the total load.  

The default value is 1. 

o Minimum Step Increment.  This value is helpful if the program does not reach convergence 

by applying the total load.  If the program does not reach convergence, the program will try 

to use a load increment factor equal to half of the current load increment factor.  If the new 

increment factor is smaller than this value, the program will stop the analysis for the current 

load case.  The default value is 1. 

o Include Axial Load Variation Along Piles.  Check this option, to use the axial load variation 

along piles for the analysis of the pile group. This option is only available if the program 

computes the axial load displacement curve internally, since the program computes the t-z 

and q-w curves internally. So, this option is not available in piles where a user defined axial 

load displacement curve is defined. 

o Number of Processors, nmax n.  Enter the number of processors desired to be used for the 

analysis of the current load case. The program displays the maximum number of processors 

available. Leave the number as zero to let the program decided for the number of 

processors to be used for the analysis of the current load case.  The default value is 1. 
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Copy Marked Values for All Loads and Combinations Button 

Click on the Copy Marked Values for All Loads and Combinations button to override the values in all 

loads and combinations defined so far by the ones marked defined in the current load case. The values 

not marked will not be overridden.  

 
Close Button 

Click on the Close button to close the window and go back to the Main window. 

 

3.5.23 Options - Default Output Variables ... 

 

 By selecting this option, the Default Output Variables Window will appear. 
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Figure 3.220  Output Variables Window 

 

 Mark the variable to be printed in the output file. Please note that some variables may not be 

available. 

 

 
 Default Button 

Click on the Default button to mark the default values printed by default. 
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Select All Button 

Click on the Select All button to mark all the variables. 

 
Unselect All Button 

Click on the Unselect All button to unmark all the variables. 

 
Set for All Load Cases and Combinations Button 

Click on the Set for All Load Cases and Combinations button to copy the default parameter values for all 

the load cases and combinations defined for the current model. 

 
Close Button 

Click on the Close button to close the window and go back to the Main window. 

 
 

 

3.5.24 Options - Text Editor Options ... 

 

 By selecting this option, the Text Editor Options Window will appear. 

  
 

Figure 3.221  Text Editor Options Window 

 

 In the prompt that appears, the user should enter the complete path and command line for 

their preferred text editor or word processor.  As a default, the command line c:\windows\notepad.exe 

sets Microsoft Notepad as the default text editor.  This text editor will be used to Edit Input File, 

Processor Run Notes, Output File, and Summary File when called from the Computation menu. 
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3.5.25 Options - Check for Updates as the Program Starts  

 

 This option is used to instruct GROUP to check the ENSOFT website for updates to software 

when GROUP is opened.  An active internet connection is required. 

 If the option is check-marked the following will appear next time the program starts  

   

Figure 3.222  Message window to confirm checking for updates on ENSOFT site 

 

Clicking “Yes” opens the user’s default internet browser to an Ensoft webpage listing update 

information specific to GROUP 2022. 

 

 

3.5.26 Options - Include Load Case/Comb Number on Graphs 

 

 This option is used to instruct GROUP to include the Load Case/Comb. Number at the bottom of 

the displayed graphs. 
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Figure 3.223  Effect of the Include Load Case/Comb Number on Graphs option. 

 

 

3.5.27 Options - Limit Active Curves on Graphs 

 

 This option is used to instruct GROUP to limit the number of default active curves on graphs to 

20. The reason to limit the number of curves is to display the plot faster. If the user wants to plots all the 

curves, just uncheck this option. Please note that while the graph is displayed the user can activate or 

deactivate curves using the Plot Menu.  
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3.6 View Menu 
 

 This menu is used to review, in proportional graphical form, the geometric shape and 

configuration for the modeled pile group.   

 

 

Figure 3.224  Options contained in the View Menu when 3D View is not active 
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Figure 3.225  Options contained in the View Menu when 3D View is active 
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3.6.1 View - Pile Top 

 

 This option provides a plan view of the group model, as observed from the top.  

 

 

Figure 3.226  Sample of Pile Top View 
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3.6.2 View - 3D View 

 

 This option opens the 3D View window that provides a 3-dimensional view of the group model. 

 

 

Figure 3.227  Sample of 3D View 
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3.6.3 View - XY View (Front) 

 

 This option switches the viewing angle in a direction perpendicular to the XY plane (Front View). 

 

Figure 3.228  XY View (Front)  

 

 

3.6.4 View - XY View (Back) 

 

 This option switches the viewing angle in a direction perpendicular to the XY plane (Back View). 

 

Figure 3.229  XY View (Back)  
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3.6.5 View - XZ View (Right) 

 

 This option switches the viewing angle in a direction perpendicular to the XZ plane (Right View). 

 

Figure 3.230  XZ View (Right)  

 

 

3.6.6 View - XZ View (Left) 

 

 This option switches the viewing angle in a direction perpendicular to the XZ plane (Left View). 

 

Figure 3.231  XZ View (Left)  
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3.6.7 View - YZ View (Top) 

 

 This option switches the viewing angle in a direction perpendicular to the YZ plane (Top View). 

 

Figure 3.232  YZ View (Top)  

 

 

3.6.8 View - YZ View (Bottom) 

 

 This option switches the viewing angle in a direction perpendicular to the YZ plane (Bottom 

View). 

 

Figure 3.233  YZ View (Bottom)  
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3.6.9 View - XYZ View (Iso) 

 

 This option switches the viewing angle in to an isometric view (Iso View). 

 

Figure 3.234  XYZ View (Iso)  

 

 

3.6.10 View - XYZ View (Reversed) 

 

 This option switches the viewing angle to the back view (Reversed View). 

   

Figure 3.235  XYZ View (Reversed)  
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3.6.11 View - Panning 

 

 This option set the mouse movement to a translation of the viewing reference point. 

 

Figure 3.236  Panning in the 3D-View display 

 

3.6.12 View - Zooming 

 

 This option set the mouse movement to enlarge or reduce the model displayed. 

 

Figure 3.237  Zooming in the 3D-View display 
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3.6.13 View - Zoom Window 

 

 This option allows to enlarge the current view based on the box traced by the mouse 

movement. 

 

Figure 3.238  Zoom by defining a window in the 3D-View display 

 

3.6.14 View - Rotating 

 

 This option set the mouse movement to a rotation of the viewing angle. 

 

Figure 3.239  Rotating in the 3D View display 
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3.6.15 View - Rotation Values 

 

 This option allows the user to enter the rotation angles of the viewing angle. 

 

Figure 3.240  Rotating in the 3D View by defining the rotation angles 

 

 

3.6.16 View - Zoom In 

 

 This option allows the user to enlarge the current view about 1.5 times. 

 

Figure 3.241  Effect of the Zoom-in option 
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3.6.17 View - Zoom Out 

 

 This option allows the user to reduce the current view about 1.5 times. 

 

Figure 3.242  Effect of the Zoom-out option 

 

 

 

3.6.18 View – Previous View 

 

 This option allows the display the previous view used if available. 

 

 

 

 

3.6.19 View – Next View 

 

 This option allows the display the next view used if a previous view was selected. 
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3.6.20 View - Restart View 

 

 This option allows the user to reset all the panning, rotation and zooming performed and display 

the model using a view angle perpendicular to the XY plane (Front View). 

 

Figure 3.243  Effect of the Restart View option 

 

 

3.6.21 View - Refresh View 

 

 This option allows the user to redraw the model. This option is useful to display the model after 

some changes have been made. Changes may not be displayed automatically in the 3D View window. 

 

Figure 3.244  Effect of the Refresh View option, after reducing pile length 
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3.6.22 View - General Toolbar 

 

 This option allows the user to toggle on and off the General Toolbar. The General Toolbar is 

associated with the File Menu 

 

 
 

 

 

 

 

 

Figure 3.245  General Toolbar 

 

 

 

3.6.23 View - Data Input Toolbar 

 

 This option allows the user to toggle on and off the Data Input Toolbar. The Data Input Toolbar 

is associated with the Data Menu. 

 

 
 

 

 

 

 

 

Figure 3.246  Data Input Toolbar 
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Figure 3.247  Data Input Toolbar. Additional Buttons for Flexible Cap Version  

 

 

 

3.6.24 View - Edit Toolbar 

 

 This option allows the user to toggle on and off the Edit Toolbar. The Edit Pile Toolbar is 

associated with the Edit Menu 

 

 

 
 

 

 

 

 

 

Figure 3.248  Edit Toolbar 
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Figure 3.249  Edit Toolbar. Additional Buttons for Flexible Cap Version 

 

 

 

3.6.25 View - Options Toolbar 

 

 This option allows the user to toggle on and off the Options Toolbar. The Options Toolbar is 

associated with the Options Menu 

 

 
 

 

 

 

 

 

Figure 3.250  Data Input Toolbar 
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3.6.26 View - View Toolbar 

 

 This option allows the user to toggle on and off the View Toolbar. The View Toolbar is available 

if the 3D View window is active and it is associated with the View Options in the Options Menu. 

 

 
 

 

 

 

 

 

Figure 3.251  View Toolbar 

 

 

 

 

3.6.27 View - Transform Toolbar 

 

 This option allows the user to toggle on and off the Transform Toolbar. The Transform Toolbar is 

available if the 3D View window is active and it is associated with the Transform Options in the Options 

Menu. 

 

  
 

 

 

 

 

 

Figure 3.252  View Toolbar 
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3.6.28 View - Computations Toolbar 

 

 This option allows the user to toggle on and off the Computations Toolbar. The Computations 

Toolbar is associated with the Computation Menu 

 

  
 

 

 

 

 

 

 

Figure 3.253  Computations Toolbar 

 

 

 

3.6.29 View - Output Toolbar 

 

 This option allows the user to toggle on and off the Output Toolbar. The Output Toolbar is 

available if the 3D View window is active and it is associated with the Output Options in the Show 3D 

View Menu 

 

 
 

 

 

 

 

 

Figure 3.254  Output Toolbar 
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Figure 3.255  Output Toolbar. Additional Buttons for Flexible Cap Version 
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3.6.30 View - Plots Toolbar 

 

 This option allows the user to toggle on and off the Plots Toolbar. The Plots Toolbar is associated 

with the Graphs Menu 

 

 

 
 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

Figure 3.256  Plots Toolbar 
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Figure 3.257  Plots Toolbar (Continuation) 

 

 

 

3.6.31 View - Help Toolbar 

 

 This option allows the user to toggle on and off the Help Toolbar. The Help Toolbar is Associated 

with the Help Menu 

 

 

           
 

 

 

 

 

 

Figure 3.258  Help Toolbar 
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 This menu is used to review, in proportional graphical form, the geometric shape and 

configuration for the modeled pile group.   

 

 

 

    

 

Figure 3.259  Options contained in the Show 3D View Menu 
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Figure 3.260  Options contained in the Show 3D View Menu – Flexible Cap Version 
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 Below there is a description of the menu items 

 
 

3.7.1 Show 3D View -Piles 

 

 This option allows the user to show the piles. 

 

 
 

 a) Piles option check-marked b) Piles option not check-marked 

Figure 3.261  Effects on 3D model display using Piles option 

 

 

 

3.7.2 Show 3D View -Show Only 1 Row 

 

 This option is available only in 2D models and allows the display on only one row of piles 
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3.7.3 Show 3D View -Pile Numbers 

 

 This option allows the user to show the pile numbers at each pile head. 

 

 
 

Figure 3.262  Effects on 3D model display using Pile Numbers option 
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3.7.4 Show 3D View -Pile Properties 

 

 This option allows the user to show the pile property index at each pile head. 

 

  
 

Figure 3.263  Effects on 3D model display using Pile Properties option 
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3.7.5 Show 3D View -Pile Wire/Pile Shade 

 

 This option allows the user to toggle between showing the piles as lines or as surfaces. 

 

  
 

 a) Pile Wire option b) Pile Shade option 

Figure 3.264  Effects on 3D model display using Pile Wire/Pile Shade options 
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3.7.6 Show 3D View -Pile Local Axes 

 

 This option allows the user to show the local axes at the top of each pile head. 

The following color pattern is used: 

- x axis, blue 

- y axis, green 

- z axis, red 

 

 
 

 a) Local Axes check-marked b) Local Axes not check-marked 

Figure 3.265  Effects on 3D model display using Local Axes option 
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3.7.7 Show 3D View –Pile Head Connections 

 

 This option allows the user to show the symbols indicating the pile head connections at the top 

of each pile head. 

 

  
 

Figure 3.266  A 3D model display using Pile Head Connections option 
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3.7.8 Show 3D View -Pile Cap 

 

 This option allows the user to show the pile cap. 

 

  
 

 a) Pile Cap option check-marked b) Pile Cap option not check-marked 

Figure 3.267  Effects on 3D model display using Pile Cap option 
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3.7.9 Show 3D View – FEM Nodes - Flexible Cap Version 

 

 This option allows the user to display the FEM nodes that belong to the finite element mesh 

defining the flexible pile-cap. Nodes will be draw with red color 

 

      
 

 a) FEM Nodes not check-marked b) FEM Nodes check-marked 

Figure 3.268  Effects on 3D model display using FEM Nodes option. Flexible Cap Version 
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3.7.10 Show 3D View – Node Numbers - Flexible Cap Version 

 

 This option allows the user to display the node numbers. This option is enabled if the FEM 

Nodes are displayed.  

 

       
 

Figure 3.269  Node Numbers option. Flexible Cap Version 
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3.7.11 Show 3D View – FEM Edges - Flexible Cap Version) 

 

 This option allows the user to display the FEM Edges that belong to the finite element mesh 

defining the flexible pile-cap 

 

        
 

 a) FEM Edges not check-marked b) FEM Edges check-marked 

 

Figure 3.270  Effects on 3D model display using FEM Edges option - Flexible Cap Version 
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3.7.12 Show 3D View – FEM Plates - Flexible Cap Version 

 

 This option allows the user to display the FEM plates that belong to the finite element mesh 

defining the flexible pile-cap. 

 

      
 

 a) FEM Plates not check-marked b) FEM Plates check-marked 

 

Figure 3.271  Effects on 3D model display using FEM Plates option - Flexible Cap Version 
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3.7.13 Show 3D View – Plate Thickness - Flexible Cap Version 

 

 This option allows the user to display the thickness of plate elements in the flexible pile-cap; 

otherwise plate elements are displayed with no thickness (default). 

 

    
 

 a) Plate Thickness not check-marked b) Plate Thickness check-marked 

 

Figure 3.272  Effects on 3D model display using Plate Thickness option. Flexible Cap Version 
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3.7.14 Show 3D View – Plate Numbers - Flexible Cap Version 

 

 This option allows the user to display the plate numbers. This option is enabled if the FEM Plates 

are displayed.  

 

        
 

Figure 3.273  Plate Numbers option - Flexible Cap Version 
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3.7.15 Show 3D View – FEM Beams - Flexible Cap Version 

 

 This option allows the user to display the FEM beams that belong to the finite element mesh 

defining the flexible pile-cap. 

 

          
 

 a) FEM Beams not check-marked b) FEM Beams check-marked 

 

Figure 3.274  Effects on 3D model display using FEM Beams option - Flexible Cap Version 
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3.7.16 Show 3D View – Shade beams - Flexible Cap Version 

 

 This option allows the user to shade the beams elements in the flexible pile-cap; otherwise 

beam elements are displayed as lines (default). 

 

       
 

 a) Shade Beams not check-marked b) Shade Beams check-marked 

 

Figure 3.275  Effects on 3D model display using Shade Beams option. Flexible Cap Version 
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3.7.17 Show 3D View – Beam Numbers - Flexible Cap Version 

 

 This option allows the user to display the beam numbers. This option is enabled if the FEM 

Beams are displayed.  

 

            
 

Figure 3.276  Beam Numbers option - Flexible Cap Version 
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3.7.18 Show 3D View – Beam Local Axes - Flexible Cap Version 

 

 This option allows the user to display the beam numbers. This option is enabled if the FEM 

Beams are displayed.  

The following color pattern is used: 

- x axis, black 

- y axis, green 

- z axis, red 

 

 

          
 

Figure 3.277  Beam Numbers option - Flexible Cap Version 
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3.7.19 Show 3D View – Plate/Beam Offsets - Flexible Cap Version 

 

 This option allows the user to display the offsets of the elements if they are defined. Program 

will display lines between the nodes and the corners of plate elements or ends of beam elements.  

 

          

       
 

 a) Plate/Beam Offsets not check-marked b Plate/Beam Offsets check-marked 

 
 

Figure 3.278  Plate/Beam Offsets option - Flexible Cap Version 
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3.7.20 Show 3D View – Beam Local Axes - Flexible Cap Version 

 

 This option allows the user to display the end zones of the beams if they are defined.  

 

 

 

  

 

 a) Beam End Zones not check-marked b Beam End Zones check-marked 

 

 
 

Figure 3.279  Beam Numbers option - Flexible Cap Version 
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3.7.21 Show 3D View – Concentrated Springs at Nodes (Flexible Pile Cap) 

 

 This option allows the user to show the concentrated springs at nodes. 

 

   
 

Figure 3.280  Concentrated Springs at Nodes option - Flexible Cap Version 
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3.7.22 Show 3D View - Distributed Springs on Plates (Flexible Pile Cap) 

 

 This option allows the user to show the distributed springs on plates. 

 

 
 

Figure 3.281  Distributed Springs on Plates option - Flexible Cap Version 
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3.7.23 Show 3D View - Distributed Springs on Beams (Flexible Pile Cap) 

 

 This option allows the user to show the distributed springs on beams. 

 

  
 

Figure 3.282  Distributed Springs on Plates option - Flexible Cap Version 
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3.7.24 Show 3D View -Soil Layers 

 

 This option allows the user to show the soil layers. 

 

 
 

Figure 3.283  Effects on 3D model display using Soil Layers option 
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3.7.25 Show 3D View -Layer Labels 

 

 This option allows the user to show the layer labels. 

 

 
 

Figure 3.284  Effects on 3D model display using Layer Labels option 
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3.7.26 Show 3D View -Layer Depth Labels 

 

 This option allows the user to show the layer depth labels. 

 

 
 

Figure 3.285  Effects on 3D model display using Layer Depth Labels option 
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3.7.27 Show 3D View - Concentrated Loads at Pile Cap 

 

 This option allows the user to show the concentrated loads at the pile cap for the current load 

case. 

 

 
 

Figure 3.286  Effects on 3D model display using Concent. Loads at Pile Cap option 
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3.7.28 Show 3D View - Distributed Loads on Piles 

 

 This option allows the user to show the distributed loads on piles for the current load case. 

 

 
 

Figure 3.287  Effects on 3D model display using Distributed Loads at Piles option 

 

 Note that the distributed loads are drawn at the integration points assuming linear 

interpolation.  If the integration points do not coincide with the depths defined in the distributed load 

sets, a difference may be shown in the drawing. 
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3.7.29 Show 3D View – Specified Displacements at Nodes (Flexible Pile Cap) 

 

 This option allows the user to show the specified displacements at nodes for the current load 

case. 

 

 
 

Figure 3.288  Specified Displacements at Nodes option - Flexible Cap Version 
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3.7.30 Show 3D View – Concentrated Loads at Nodes (Flexible Pile Cap) 

 

 This option allows the user to show the concentrated loads at nodes for the current load case. 

 

  
 

Figure 3.289  Concentrated Loads at Nodes option - Flexible Cap Version 
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3.7.31 Show 3D View - Distributed Loads on Plates (Flexible Pile Cap) 

 

 This option allows the user to show the distributed loads on plates for the current load case. 

 

  
 

Figure 3.290  Distributed Loads on Plates option - Flexible Cap Version 
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3.7.32 Show 3D View - Distributed Loads on Beams (Flexible Pile Cap) 

 

 This option allows the user to show the distributed loads on beams for the current load case. 

 

   
 

Figure 3.291  Distributed Loads on Beams option - Flexible Cap Version 
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3.7.33 Show 3D View - Concentrated Loads on Beams (Flexible Pile Cap) 

 

 This option allows the user to show the concentrated loads on beams for the current load case. 

 

    
 

Figure 3.292  Distributed Loads on Beams option - Flexible Cap Version  
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3.7.34 Show 3D View -Global Axes 

 

 This option allows the user to show the global axes at the origin of coordinates. 

 

The following color pattern is used: 

- X axis, blue 

- Y axis, green 

- Z axis, red 

 

 

  
 

 a) Global Axes check-marked b) Global Axes not check-marked 

 

Figure 3.293  Effects on 3D model display using Global Axes option 
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3.7.35 Show 3D View -Vertical Lines 

 

 This option allows the user to show vertical lines that start from the top of each pile head. 

 

 
 

 a) Vertical Lines check-marked b) Vertical Lines not check-marked 

Figure 3.294  Effects on 3D model display using Vertical Lines option 
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3.7.36 Show 3D View -Show Loading Options 

 

 This option opens the Show Loading Options Window that allows the user to change the default 

drawing for loading and boundary conditions. 

 

  

Figure 3.295  Show Loading Options Window 
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Figure 3.296  Show Loading Options Window - Flexible Cap Version 
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3.7.37 Show 3D View -Show Springs Options – Flexible Cap Version 

 

 This option opens the Show Springs Options Window that allows the user to change the default 

drawing for springs. 

 

  

Figure 3.297  Show Sprimgs Options Window – Flexible Cap Version 

 

 



CHAPTER 3    References for Data Input     3-167 

 

GROUP 2022 for Windows User's Manual 
 

3.7.38 Show 3D View –Display Values Options 

 

 This option opens the Display Values Window that allows the user to change the default format 

for displaying values in the 3D -View. 

 

 

Figure 3.298  Display Values Options Window 
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3.7.39 Show 3D View -Show Grid 

 

 This option allows the user to show a three-dimensional grid. 

 

 
 

 a) Show Grid check-marked b) Show Grid not check-marked 

Figure 3.299  Effects on 3D model display using Show Grid option 
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3.7.40 Show 3D View - Grid Options 

 

 This option allows the user to change the increment values for the 3D grid. 

 

  
 

Figure 3.300  Grid Options Window 
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3.7.41 Show 3D View – Pile Color 

 

 This option allows the user to color the piles using six options: Default, by pile properties, by pile 

sections, by pile numbers, by generated LD curves and by generated TR curves. 

 

 
 

 a) Default b) By Pile Properties 

 

 
 

 c) By Pile Sections d) By Pile Numbers 

Figure 3.301  Effects on 3D model display using Pile Color option 
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3.7.42 Show 3D View - Highlight Piles 

 

 This option allows the user to highlight piles using various options, showing the highlighted 

pile(s) with a yellow color. 

 

 
 

Figure 3.302  Effects on 3D model display using Highlight Piles option 

 

 



CHAPTER 3    References for Data Input     3-172 

 

GROUP 2022 for Windows User's Manual 
 

 

3.7.43 Show 3D View - Highlight Plates - Flexible Cap Version) 

 

 This option allows the user to highlight plates using various options, showing the highlighted 

plate(s) with a light blue color. 

 

 

 

Figure 3.303  Effects on 3D model display using Highlight Plates option – Flexible Cap Version 
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3.7.44 Show 3D View - Highlight Beams - Flexible Cap Version) 

 

 This option allows the user to highlight beams using various options, showing the highlighted 

beam(s) with a yellow color. 

 

 
  

 

Figure 3.304  Effects on 3D model display using Highlight Beams option – Flexible Cap Version 
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3.7.45 Show 3D View - Highlight Nodes - Flexible Cap Version 

 

 This option allows the user to highlight nodes using various options, showing the highlighted 

node(s) with a yellow color. 

 

 
 

 

Figure 3.305  Effects on 3D model display using Highlight Nodes option – Flexible Cap Version 
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3.7.46 Show 3D View - Select Piles 

 

 This option allows the user to select piles using various options. The selected pile(s) will be 

displayed on red color.  

 This option is enabled if the option Select Piles is checked under the Edit Menu or the Select 

Piles Tool Button was checked. 

 

 
 

Figure 3.306  Effects on 3D model display using Select Piles option 
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3.7.47 Show 3D View - Select Plates - Flexible Cap Version 

 

 This option allows the user to select plates using various options. The selected plates(s) will be 

displayed on magenta color. 

 This option is enabled if the option Select Plates is checked under the Edit Menu or the Select 

Plates Tool Button was checked. 

 

  

 
 

Figure 3.307  Effects on 3D model display using Select Plates option- Flexible Cap Version 
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3.7.48 Show 3D View - Select Beams - Flexible Cap Version 

 

 This option allows the user to select beams using various options. The selected beam(s) will be 

displayed on red color. 

 This option is enabled if the option Select Beams is checked under the Edit Menu or the Select 

Beams Tool Button was checked. 

 

   

 
 

Figure 3.308  Effects on 3D model display using Select Beams option- Flexible Cap Version 
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3.7.49 Show 3D View - Select Nodes - Flexible Cap Version 

 

 This option allows the user to select nodes using various options. The selected node(s) will be 

displayed on light blue color. 

 This option is enabled if the option Select Nodes is checked under the Edit Menu or the Select 

Nodes Tool Button was checked. 

 

   

 
 

Figure 3.309  Effects on 3D model display using Select Nodes option- Flexible Cap Version 
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3.7.50 Show 3D View -Hide/Show Piles 

 

 This option allows the user to hide the selected piles. 

 

 
 

 a) Piles Select b) Using Hide Selected Piles option 

 

 
 

 c) Using Hide Except Selected Piles option d) Using Reverse Hiding option 

Figure 3.310  Effects on 3D model display using Show/Hide Piles option 

 



CHAPTER 3    References for Data Input     3-180 

 

GROUP 2022 for Windows User's Manual 
 

 

3.7.51 Show 3D View -Hide/Show Piles, Plates, Beams - Flexible Cap Version 

 

 This option allows the user to hide the selected piles and/or plates and/or beams. 

 

   
 

 a) Plates Select b) Using Hide Selected Piles/Plates option 

 

  
 

 c) Using Hide Except Selected Piles, Plates option d) Using Reverse Hiding option 

Figure 3.311  Effects on 3D model display using Show/Hide Piles, Plates, Beams option – Flexible Cap 
Version 
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3.8 Window Menu 
 

 

 

Figure 3.312  Options contained in the Windows Menu 

 

 

3.8.1 Window - Cascade 

 

 This option organizes all open windows so that they are all visible.  See Figure 3.312 for an 

example. 

 

3.8.2 Window - Arrange Icons 

 

 Any minimized windows will be aligned at the bottom left of the screen. 
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3.8.3 Window - Windows 

 

 After the options Cascade and Arrange Icons, the windows opened are listed in order of depth.  

Clicking on a window name through the menu brings it to the top. 

 

3.9 Help Menu 
 

 

  

Figure 3.313  Options contained in the Help Menu 
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3.9.1 Help- Documentation User's Manual 

 

 This option opens the User's Manual that is provided as a digital version in pdf format. 

 

 

 

Figure 3.314  Sample of User's Manual 
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3.9.2 Help- Documentation Example Manual 

 

 This option opens the Example Manual that is provided as a digital version in pdf format. 

 

  

 

 

Figure 3.315  Sample of Example Manual 
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3.9.3 Help- Documentation Technical Manual 

 

 This option opens the Technical Manual that is provided as a digital version in pdf format. 

 

 

 

Figure 3.316  Sample of Technical Manual 
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3.9.4 Help- About 

 

 This option provides a screen describing the program version, date, license user and methods 

for accessing technical support. 

  

  

Figure 3.317  About Window 
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3.9.5 Help- Check for Updates 

 

 This opens the user’s default internet browser to an ENSOFT webpage with specific update 

information for GROUP 2022.  If a new update is available the page will indicate that.  Follow 

instructions to download and install the update. 

 

 

 

Figure 3.318  Sample of Check for Updates 

 

 



CHAPTER 3    References for Data Input     3-188 

 

GROUP 2022 for Windows User's Manual 
 

 

3.9.6 Help- Ensoft Key Inquirer 

 

This option is available for a single user license. It opens the utiltity Ensoft Key Inquirer that 

provide information about the ENSOFT licenses available in the USB key. 

 

 

 

 

Figure 3.319  Sample of Ensoft Key Inquirer 
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3.9.7 Help- Check Network Dongle 

 

This option is available for a network license, client user.  It opens the utiltity Check Network 

Dongle that provide information about the ENSOFT network license. This option is useful when 

the program is not able to get a license from a serve computer. This utility will provide a more 

detailed information why the program is not able to get a license from the server. 

 

 

  

Figure 3.320  Sample of Check Network Dongle 

 

 



CHAPTER 4  References for Program Execution and Output Reviews     4-1 

 

GROUP 2022 for Windows User's Manual 
 

 

CHAPTER 4. References for Program 

Execution and Output 

Reviews 



CHAPTER 4  References for Program Execution and Output Reviews     4-2 

 

GROUP 2022 for Windows User's Manual 
 

 

4.1 Introduction  
 

 The current Chapter presents options related to execution of the program, and includes 

methods of addressing run-time errors; suggestions of review of files for input, output, and processor 

notes; and means for observing results in a graphical form.  The commands covered in this chapter are 

contained under the Computation, Graph, Plot and Show 3D View menu options 

 

4.2 Computation Menu 
 

 

  

Figure 4.1  Options contained in the Computation Menu 
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Figure 4.2  Options contained in the Computation Menu – Flexible Cap Version 

 

 



CHAPTER 4  References for Program Execution and Output Reviews     4-4 

 

GROUP 2022 for Windows User's Manual 
 

 

4.2.1 Computation- Run Analysis 

 

 This option runs the analytical computations.  Only use this after all data has been entered and 

saved.  The program will do a basic check of the data input before performing the computations; if a 

data is missing an error message with is description will show up. 

 

 

Figure 4.3  Sample message if an input data is missing 

 

 During the computation, a window with a progress bar will appear 

  

 

Figure 4.4  Sample message while running the analysis 
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 User may stop the current analysis by clicking on the Stop Computations button. After doing so, 

the program will show a message to confirm it. 

 

 

Figure 4.5  Sample message to stop the analysis 

 By clicking on the Yes button, the current analysis will stop, so results may not be available. 

Clicking on the No button will continue the analysis. 

 

 If the computation is successful, the program will notify the user.   

 

 

 
 

Figure 4.6  Sample message when analysis has finished 

 

 

The program will also notify the user if the computation is unsuccessful.   
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Figure 4.7  Sample message when analysis is unsuccessful 

 

 

The following text files (can be opened with any text editor) are generated: 

 

 

File 
Extension 

File 
Description 

*.gp12d Input Data file 

*.gp12e Echo Print Data file 

*.gp12o Output Results file 

*.gp12p Plot Results file 

*.gp12r Processor Notes file 

*.gp12t Summary Results file 

 

Table 4.1  Files created in GROUP 2022 runs 

 

In addition, the following text files (can be opened with any text editor) may be generated with the 

Flexible Cap Version: 

 

File 
Extension 

File 
Description 

*.sl12e Echo Print Data file (Flexible Cap) 

*.sl12o Output Results file (Flexible Cap) 

*.sl12t Summary Results file (Flexible Cap) 

 

Table 4.2  Files created in GROUP 2022 runs – Flexible Cap Version 

 

 

These files will be created in the same folder as the input file. 

 

It is recommended that users check for the consistency of the results after a successful run. 
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4.2.2 Computation- Run Moment Curvature Calculations 

 

 This option runs the moment curvature calculations. This option is available only if there is at 

least one nonlinear section.  Only use this after all section data has been entered and saved.  

 

 After computations are completed, the program will notify the user.   

 

 

 
 

Figure 4.8  Sample message when analysis has finished 

 

 

The following text file (that can be opened with any text editor) is produced: 

 

 

File 
Extension 

File 
Description 

*.gp12k Moment Curvature File 

 

Table 4.3  File created using Moment Curvature Calculations 

 

The file will be created in the same folder as the input file. 

 

It is recommended that users check for the consistency of the results after a successful run. 
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4.2.3 Computation- Select Load Case or Combination 

 

 This option opens the Select Load Case or Combination window. 

 

 

Figure 4.9  Select Load Case or Combination window 

 

In this window, the user can select the load case or load combination that will be active for 

displaying of the graphical results.  This window also shows the status of the different load cases or 

combinations defined in the model.  When a load case or load combination is selected, the current 

load case will be displayed in the second box of the status line. 
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4.2.4 Computation- View Input File 

 

 This submenu is used to view the input-data file in text mode.  This command becomes active 

after new data files have been saved to disk or when opening existing data files.  The command is 

helpful for experienced users who may just want to change one or two parameters quickly using the text 

editor, or for those users wishing to observe the prepared-input data in text mode. 

 

 
 

Figure 4.10  Sample of Input Text File 
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4.2.5 Computation- View Echo Print File 

 

 This submenu is used to view the echo print text file that is automatically produced during each 

analytical run.  This command becomes active after new data files have been saved to disk and 

executed, or when opening previously-executed data files.  Information usually contained in the output 

files consists of: 

o echo-print of input data,  

o data for curves of axial load versus displacement 

o data for curves of torque vs rotation 

o data for internally generated p-y curves,  

o data for internally generated moment curvature curves,  

 

 

Figure 4.11  Sample of Echo Print File 
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It is recommended that users check the echo-print of their input data to verify the values that the 

program is using for the desired analytical case. 

 

4.2.6 Computation- View Processor Run Notes 

 

 This submenu is used to view the text file that is automatically produced during each analytical 

run.  The file only includes notes produced during the processing of the input data.  The command 

becomes active after new-data files have been saved to disk and executed, or when opening previously-

executed data files.  Reviewing the notes is essential for debugging unsuccessful runs. 

 

 

Figure 4.12  Sample of Processor Run Notes Text File 
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 The actual number of lines titled READING depends on the input.  If the processor-run notes 

stop at a certain line without listing the line COMPUTATION IS PROCEEDING..., the user should check 

the specific input corresponding to the last line read and the line immediately following (that was 

not read). 

 

 After the line COMPUTATION IS PROCEEDING..., the program prints for each load case or load 

combination the error norm for global iterations (pile cap convergence) and iterations for lateral 

analysis of each pile if printing is requested for all the piles. 

 

 Common types of analytical-run failures are those providing error messages like Pile Failure in 

Uplift or Pile Failure in Bearing.  These two conditions will occur when the axial load on a pile is 

greater than the ultimate axial capacity of the corresponding pile.  To correct these types of 

problems, the user should check the pile size and soil parameters and make sure that the input data 

is reasonable.  If the pile and soil properties are proper, the user should reduce the axial load on the 

pile cap for a new analysis.  Also, these errors may be triggered if the analysis diverges under the 

current loading.  There may be different causes for divergence, so a complete review of the input 

data is recommended.  

 

 

4.2.7 Computation- View Output Results File 

 

 This submenu is used to view the output-text file that is automatically produced during each 

analytical run.  This command becomes active after new data files have been saved to disk and 

executed, or when opening previously-executed data files.  Information usually contained in the output 

files consists of: 

o results for deformation of the pile cap,  

o results for loads and deformation at the pile head for each pile (or a standard pile of each 

subgroup for 2D analysis), and  

o results for deflection, bending moment, shear, soil resistance, and related information, as a 

function of depth for each pile (or a standard pile of each subgroup for 2D analysis). 

 

It is recommended that users check the output files to verify the consistency of the solution 

estimated by the program. 
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Figure 4.13  Sample of Output Results File 
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4.2.8 Computation- View Summary Results File 

 

 This submenu is used to view the summary file that is automatically produced during each 

analytical run.  This command becomes active after new data files have been saved to disk and 

executed, or when opening previously-executed data files.  Information usually contained in the 

summary file consists of: 

o results for deformation of the pile cap,  

o summary table for results of loads and deformation at the pile head for each pile, including 

maximum and minimum values and location of those. 

o summary table for maximum and minimum results of deflection, bending moment, shear, 

soil resistance at each pile. 
 

 

Figure 4.14  Sample of Summary Results File 
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4.2.9 Computation- View Moment Curvature File 

 

 This submenu is used to view the moment curvature file that is automatically produced after 

selecting run moment curvature calculations.  This command becomes active after new data files have 

been saved to disk and executed, or when opening previously-executed data files.  Information usually 

contained in the output files consists of: 

o Axial thrust forces 

o Bending curvature, bending moment, bending stiffness. 

o  

 

Figure 4.15  Sample of Moment Curvature File 
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4.2.10 Computation- View Echo File (Flexible Cap) – Flexible Cap Version 

 

 This submenu is used to view the echo print file that is automatically produced during each 

analytical run if the pile cap is modeled as flexible.  This command becomes active after new data files 

have been saved to disk and executed, or when opening previously-executed data files.  Information 

usually contained in the output files consists of: 

o echo-print of finite element nodes,  

o echo-print of finite element connectivity,  

o data for loading on flexible cap 

 

 

 

Figure 4.16  Sample of Echo File (Flexible Cap) – Flexible Cap Version 
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It is recommended that users check the echo-print of their input data to verify the values that the 

program is using for the desired analytical case. 

 

4.2.11 Computation- View Output Results File (Flexible Cap) – Flexible Cap Version 

 

 This submenu is used to view the output-text file that is automatically produced during each 

analytical run.  This command becomes active after new data files have been saved to disk and 

executed, or when opening previously-executed data files.  Information usually contained in the output 

files consists of: 

o results for displacements on the nodes that belong to the flexible pile cap,  

o results for internal forces and stresses on plates that belong to the flexible pile cap 

o results for internal forces and deformations of the beams that belong to the flexible pile cap 

 

It is recommended that users check the output files to verify the consistency of the solution 

estimated by the program. 
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Figure 4.17  Sample of Output Results File (Flexible Cap) – Flexible Cap Version 

 

 

 

 

 

 

4.2.12 Computation- View Summary Results File (Flexible Cap) – Flexible Cap Version 

 

 This submenu is used to view the summary file that is automatically produced during each 

analytical run.  This command becomes active after new data files have been saved to disk and 
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executed, or when opening previously-executed data files.  Information usually contained in the 

summary file consists of: 

o maximum and minimum values of displacements at nodes, internal forces and stresses on 

plates and internal forces and deformations on beams on the flexible pile cap. 

 
 

 

Figure 4.18  Sample of Summary Results File 
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4.2.13 Computation- Special Plots 

 

 This submenu will open the Special Plots Window, that allows the user to plot the results after a 

successful run. 

 The Special Plots Window allows the user to plot results for both a specific Load Case or 

Combination and also for various Load Cases or Combinations. 

 

 

 

 

Figure 4.19  Special Plots Window 
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4.2.14 Computation- Incremental/PushOver Plots 

 

 This submenu will open the Incremental/PushOver Plots Window, that allows the user to plot 

the results after a successful run. 

 The Incremental/PushOver Plots Window allows the user to plot results available for 

incremental/pushover analysis. 

 

 

Figure 4.20  Incremental/PushOver Plots Window 
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4.3 General Comments for Graphics Mode 
 

 Graphics mode is accessed when the user selects to observe any one of the output curves.  

Graphical representation of output curves is produced under the following commands in the Graphs 

menu: 

• Generated p-y Curves 

• Generated Axial Load vs.  Displacement 

• Generated Torque vs.  Rotation  

• User Defined Axial Load vs.  Displacement 

• Deflection vs. Distance 

• Bending Moment vs. Distance 

• Shear vs. Distance 

• Soil Reaction vs. Distance 

• Def., Mom., Shear vs. Distance 

• Bending Stiffness vs. Distance 

• Deflection y dir vs. Distance 

• Deflection z dir vs. Distance 

• Moment z dir vs. Distance 

• Moment y dir vs. Distance 

• Shear y dir vs. Distance 

• Shear z dir vs. Distance  

• Soil Reaction y dir vs. Distance 

• Soil Reaction z dir vs. Distance 

• Bending Stiffness z dir vs. Distance 

• Bending Stiffness y dir vs. Distance 

• Def. y, Mom. z, Shear y vs. Distance 

• Def. z, Mom. y, Shear z vs. Distance 

• Deflection x dir vs. Distance 

• Axial Force vs. Distance 

• Resultant Deflection vs. Distance 

• Resultant Moment vs. Distance 

• Resultant Shear vs. Distance 

• Resultant Soil Reaction vs. Distance 

• Res. Def., Mom., Shear vs. Distance 

• Pile Cap Vertical Load vs.  Deflection 

• Pile Cap Load vs.  Lateral Deflection 

• Pile Cap Load vs.  Rotation 

• Pile Cap Moment vs.  Deflection 

• Pile Cap Moment vs.  Rotation 
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• Pile Cap Vertical Load vs.  Deflection X 

• Pile Cap Lateral Load vs.  Deflection Y 

• Pile Cap Lateral Load vs.  Deflection Z 

• Pile Cap Moment vs.  Rotation X 

• Pile Cap Moment vs.  Rotation Y 

• Pile Cap Moment vs.  Rotation Z 

• Pile Cap K11 vs.  Deflection X 

• Pile Cap K22 vs.  Deflection Y 

• Pile Cap K33 vs.  Rotation Z 

• Pile Cap K33 vs.  Deflection Z 

• Pile Cap K44 vs.  Rotation X 

• Pile Cap K55 vs.  Rotation Y 

• Pile Cap K66 vs.  Rotation Z 

Additionally, the program produces the nonlinear EI plots, like the moment curvature diagram; 

however, the description below does not apply to those curves. 

 The activation of any of the above listed curves will activate the graphics mode of GROUP 2022.  

Several changes occur during use of the graphics mode: new mouse commands are enabled and a new 

top-menu option becomes available. 

 The following table describes mouse commands that become enabled automatically during all 

graphical observation of the output curves. 

 

Event Description 

Mouse Left Click Zooms in the graphics at the 
clicked position (up to five zoom 

levels) 

Mouse Right Click Zoom out the graphics 

Mouse Double Click on Legend Turns the selected curve on/off 
at every click 

 

Table 4.4  Mouse commands in the graphics mode 
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Figure 4.21  Effects on graph display using mouse commands.  Defining box for zooming in (Left click) 
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Figure 4.22  Effects on graph display using mouse commands.  After zooming in 
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Figure 4.23  Effects on graph display using mouse commands.  Zooming out (Right Click) 
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Figure 4.24  Effects on graph display using mouse commands.  Hiding a curve (Double Click on 

Legend) 
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4.4 Plot Menu 
 

 The Plot menu command appears in the top-menu bar while in graphics mode.  The changes to 

the graphs are also valid to the current graph and while the graph is active.  Closing the graph will 

discard automatically all the changes.  Options contained in this menu are explained below: 

 

 

Figure 4.25  Options contained in the Plot Menu 
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4.4.1 Plot - Show Legend 

 

 Activates or deactivates the legend in the graphics window.  The legend box can be moved using 

click-and-drag. 

 

 

 
Figure 4.26  Effects on graph display using Plot Legend option.  Plot Legend check-marked 
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Figure 4.27  Effects on graph display using Plot Legend option.  Plot Legend not check-marked 
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4.4.2 Plot - Show Markers 

 

 This activates or deactivates the markers for each point of all the curves displayed in the active 

screen of the graphics mode.  The type of marker used in each curve is automatically selected by the 

program.  Once activated, the markers are enabled for all visible curves of the active graphics screen. 

 

 

 
Figure 4.28  Effects on graph display using Plot Markers option.  Using Markers every 5 increments 
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Figure 4.29  Effects on graph display using Plot Markers option.  Using no markers (Never) 
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4.4.3 Plot - Font Size 

 

 This option set the font size for the current graph. 

 

 

 
Figure 4.30  Effects on graph display using Font Size option. Using twice the Default Size 
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4.4.4 Plot - Line Width 

 

 This option set the line width for the current graph. 

 

 

 
Figure 4.31  Effects on graph display using Line Width option.  Using four times the Default Size 

 

 

 



CHAPTER 4  References for Program Execution and Output Reviews     4-35 

 

GROUP 2022 for Windows User's Manual 
 

 

4.4.5 Plot - Graph Title 

 

 This command is used to define the title for the current graph. 

 

 

 

Figure 4.32  Using Graph Title option 
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4.4.6 Plot - Edit Legend 

 

 This command is used to edit the labels for the legend. 

 

 

 

Figure 4.33  Using Edit Legend option 
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4.4.7 Plot - Active Curves 

 

 This option opens a new window that gives the user the ability to easily activate curves on the 

current graph.  Additionally, below the Active Curves option the names of the curves as they are 

referred to in the legend appear—clicking on those names also deactivates or activates them. 

 

 

 

Figure 4.34  Using Active Graphs option 
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4.4.8 Plot - Print 

 

 This command calls up the standard Windows print dialog.  The printed graphics are 

automatically sized to occupy the maximum width of the page. 

 

 

Figure 4.35  Using Print option 
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4.4.9 Plot - Page Setup 

 

 This command allows the user to customize the arrangement of the graph on the page for a 

hard copy print out. 

 

  

Figure 4.36  Using Page Setup option 
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4.4.10 Plot - Save To Disk 

 

 This command is used to save the active graphics screen to disk.  The format of the saved file is 

*.bmp. 

 

  

Figure 4.37  Using Save To Disk option 
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4.5 Graphs Menu 
 

 

 

   

Figure 4.38  Options contained in the Graphs Menu.  2D Model 
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Figure 4.39  Options contained in the Graphs Menu.  3D Model 
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4.5.1 Sign Convention for results along the piles 

 

 
 

Figure 4.40  Sign Convention for pile under lateral loading. (xy-plane loading) 
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Figure 4.41  Sign Convention for pile under lateral loading. (xz-plane loading) 
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4.5.2 Graphs- Generated p-y Curves 

 

 GROUP 2022 will generate p-y curves at user-specified depths for any particular pile or subgroup 

selected by the user.  This graphics option becomes available only if the user asked the program to print 

p-y curves for verification purposes using the command for Print p-y curves under the Options menu 

and the option Set of Data to Print p-y curves under the Data menu.   

 When available, the graphics screen will show the p-y curves for all selected depths. 

  In the output data file and graphics, the labels of depths of p-y curves are computed as depths 

below the ground line.  These labels will thus be different than requested depths of printout when the 

ground line is not at the same level as the origin of the global coordinate system (usually at the level of 

the pile cap). 

 If the user selects Pile-Cap Embedded under the Pile Cap Options menu item and also requests 

to print an internally generated p-y curve within the height of the pile cap, then two different p-y curves 

will be plotted.  One will correspond to the p-y curve for the pile cap and the other will correspond to 

the p-y curve for the specified pile subgroup.  The difference can easily be identified in the pile 

diameters.  In addition, the p-y curve corresponding to the pile cap will usually be a stiffer curve. 
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Figure 4.42  Sample graphics screen of p-y Curves command under the Graphs menu 
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4.5.3 Graphs- Generated Axial Load vs.  Displacement 

 

 If the program was asked to generate internally the curve of axial load versus displacement of a 

single pile, the user may select this item to observe a graphical representation of the curve. 

 Two curves are always generated for each pile type.  One curve corresponds to movements due 

to tensile loads while the other corresponds to movements due to compressive loads.  Curves 

corresponding to tensile loads are always the ones ending on a vertical slope.  Theoretically, curves 

corresponding to tensile and compressive loads may be equal if soils offer no resistance in end bearing.   

 

Figure 4.43  Sample graphics screen of Axial Load vs.  Displacement command under the Graphs 
menu 
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4.5.4 Graphs- Generated Torque vs.  Rotation 

 

 If the program was asked to generate internally the curve of torque versus rotation of a single 

pile, the user may select this item to observe a graphical representation of the curve. 

 

 

 

Figure 4.44  Sample graphics screen of Torque vs.  Rotation command under the Graphs menu 
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4.5.5 Graphs- User Defined p-y Curves 

 

 This graphics option become available only if the user enters a User-Defined p-y curve  

 

 

 

Figure 4.45  Sample graphics screen of p-y Curves command under the Graphs menu 
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4.5.6 Graphs- User Defined Axial Load vs. Displacement 

 

 This graphics option becomes available only if the user enters a User-Defined Axial Load-

Displacement curve. 

 

 

Figure 4.46  Sample graphics screen of Axial Load vs.  Displacement command under the Graphs 
menu 
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4.5.7 Graphs- User Defined Torque vs. Rotation 

 

 This graphics option becomes available only if the user enters a User-Defined Torque-Rotation 

curve. 

 

 

Figure 4.47  Sample graphics screen of Torque vs.  Rotation command under the Graphs menu 

 

 



CHAPTER 4  References for Program Execution and Output Reviews     4-52 

 

GROUP 2022 for Windows User's Manual 
 

4.5.8 Graphs - Deflection vs. Distance 

 

 This option provides a plot of lateral pile deflection versus distance from pile top of each 

individual pile in a 2-dimensional pile group. Notice that the lateral deflections are provided in values for 

the local axis of each pile (which is different for piles that have different batter). 

 

 

Figure 4.48  Sample graphics screen of Deflection vs. Distance command under the Graphs menu 
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4.5.9 Graphs - Moment vs. Distance 

 

 This option provides a plot of bending moment versus distance from pile top of each individual 

pile in a 2-dimensional pile group. Notice that the moments are provided in values for the local axis of 

each pile (which is different for piles that have different batter). 

 

 

Figure 4.49  Sample graphics screen of Moment vs. Distance command under the Graphs menu 
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4.5.10 Graphs - Shear vs. Distance 

 

 This option provides a plot of shear versus distance from pile top of each individual pile in a 3-

dimensional pile group. Notice that the shear forces are provided in values for the local axis of each pile 

(which is different for piles that have different batter). 

 

 

 

Figure 4.50  Sample graphics screen of Shear vs. Distance command under the Graphs menu 
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4.5.11 Graphs - Soil Reaction vs. Distance 

 

 This option provides a plot of lateral soil resistance versus distance from pile top of each 

individual pile in a 2-dimensional pile group. Notice that the soil reactions are provided in values for the 

local axis of each pile (which is different for piles that have different batter). 

 

 

Figure 4.51  Sample graphics screen of Soil Reaction vs. Distance command under the Graphs menu 
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4.5.12 Graphs – Bending Stiffness vs. Distance 

 

 This option provides a plot of the pile bending stiffness versus distance from pile top of each 

individual pile in a 2-dimensional pile group. Notice that the bending stiffness are provided in values 

along the local axis of each pile 

 

  

Figure 4.52  Sample graphics screen of Bending Stiffness vs. Distance command under the Graphs 
menu 
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4.5.13 Graphs – Def., Mom., Shear vs. Distance 

 

 This option provides a plot (in the same graph) of the lateral deflection, bending moment and 

shear versus distance from pile top of each individual pile in a 2-dimensional pile group. Notice that the 

deflection, moment and shear are provided in values for the local axis of each pile (which is different for 

piles that have different batter). 

 

  

 

Figure 4.53  Sample graphics screen of Def., Mom., Shear vs. Distance command under the Graphs 
menu 

 

 



CHAPTER 4  References for Program Execution and Output Reviews     4-58 

 

GROUP 2022 for Windows User's Manual 
 

4.5.14 Graphs - Deflection y dir vs. Distance 

 

 This option provides a plot of lateral pile deflection versus distance from pile top on the local y-

axis of each individual pile in a 3-dimensional pile group. Notice that the lateral deflections are provided 

in values for the local axis of each pile (which may be different for piles that have different batter and 

rotation angles). 

 

  

Figure 4.54  Sample graphics screen of Deflection y dir vs. Distance command under the Graphs 
menu 
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4.5.15 Graphs - Deflection z dir vs. Distance 

 

This option provides a plot of lateral pile deflection versus distance from pile top on the local z-axis of 

each individual pile in a 3-dimensional pile group. Notice that the lateral deflections are provided in 

values for the local axis of each pile (which may be different for piles that have different batter and 

rotation angles). 

 

  

Figure 4.55  Sample graphics screen of Deflection z dir vs. Distance command under the Graphs 
menu 
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4.5.16 Graphs - Moment z dir vs. Distance 

 

 This option provides a plot of bending moment about the local z-axis versus distance from pile 

top on the xy-plane of each individual pile in a 3-dimensional pile group. Notice that the moments are 

provided in values along the local axis of each pile (which may be different for piles that have different 

batter and rotation angles). 

 

  

Figure 4.56  Sample graphics screen of Moment z dir vs. Distance command under the Graphs menu 
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4.5.17 Graphs - Moment y dir vs. Distance 

 

 This option provides a plot of bending moment about the local y-axis versus distance from pile 

top on the xz-plane of each individual pile in a 3-dimensional pile group. Notice that the moments are 

provided in values along the local axis of each pile (which may be different for piles that have different 

batter and rotation angles). 

 

  

Figure 4.57  Sample graphics screen of Moment y dir vs. Distance command under the Graphs menu 
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4.5.18 Graphs - Shear y dir vs. Distance 

 

 This option provides a plot of shear versus distance from pile top on the local y-axis of each 

individual pile in a 3-dimensional pile group. Notice that the shear forces are provided in values for the 

local axis of each pile (which may be different for piles that have different batter and rotation angles). 

 

  

Figure 4.58  Sample graphics screen of Shear y dir vs. Distance command under the Graphs menu 
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4.5.19 Graphs - Shear z dir vs. Distance 

 

 This option provides a plot of shear versus distance from pile top on the local z-axis of each 

individual pile in a 3-dimensional pile group. Notice that the shear forces are provided in values for the 

local axis of each pile (which may be different for piles that have different batter and rotation angles). 

 

  

Figure 4.59  Sample graphics screen of Shear z dir vs. Distance command under the Graphs menu 
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4.5.20 Graphs - Soil Reaction y dir vs. Distance 

 

 This option provides a plot of lateral soil resistance versus distance from pile top on the local y-

axis of each individual pile in a 3-dimensional pile group. Notice that the soil reactions are provided in 

values for the local axis of each pile (which may be different for piles that have different batter and 

rotation angles). 

 

   

Figure 4.60  Sample graphics screen of Soil Reaction y dir vs. Distance command under the Graphs 
menu 
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4.5.21 Graphs - Soil Reaction z dir vs. Distance 

 

 This option provides a plot of lateral soil resistance versus distance from pile top on the local z-

axis of each individual pile in a 3-dimensional pile group. Notice that the soil reactions are provided in 

values for the local axis of each pile (which may be different for piles that have different batter and 

rotation angles). 

 

  

Figure 4.61  Sample graphics screen of Soil Reaction z dir vs. Distance command under the Graphs 
menu 
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4.5.22 Graphs – Bending Stiffness z dir vs. Distance 

 

 This option provides a plot of pile bending stiffness about the local z-axis versus distance from 

pile top of each individual pile in a 3-dimensional pile group. Notice that the bending stiffness are 

provided in values along the local axis of each pile. 

 

   

Figure 4.62  Sample graphics screen of Bending Stiffness z dir vs. Distance command under the 
Graphs menu 
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4.5.23 Graphs – Bending Stiffness y dir vs. Distance 

 

 This option provides a plot of bending stiffness about the local y-axis versus distance from pile 

top of each individual pile in a 3-dimensional pile group. Notice that the bending stiffness are provided 

in values along the local axis of each pile. 

 

   

Figure 4.63  Sample graphics screen of Bending Stiffness y dir vs. Distance command under the 
Graphs menu 
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4.5.24 Graphs – Def. y, Mom. y, Shear z vs. Distance 

 

 This option provides a plot (in the same graph) of the lateral deflection y, bending moment z and 

shear y versus distance from pile top of each individual pile in a 3-dimensional pile group. Notice that 

the deflection, moment and shear are provided in values for the local axis of each pile (which is different 

for piles that have different batter). 

 

  

 

Figure 4.64  Sample graphics screen of Def. y, Mom. z, Shear y vs. Distance command under the 
Graphs menu 
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4.5.25 Graphs – Def. z, Mom. y, Shear z vs. Distance 

 

 This option provides a plot (in the same graph) of the lateral deflection z, bending moment y and 

shear z versus distance from pile top of each individual pile in a 3-dimensional pile group. Notice that 

the deflection, moment and shear are provided in values for the local axis of each pile (which is different 

for piles that have different batter). 

 

  

 

Figure 4.65  Sample graphics screen of Def. z, Mom. y, Shear z vs. Distance command under the 
Graphs menu 
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4.5.26 Graphs – Deflection x Dir vs. Distance 

 

 This option provides a plot of deflection along the pile versus distance from pile top of each 

individual pile in a 3-dimensional pile group. If the user select Include Axial Variation along Piles, the 

variation may be displayed along depth of the pile; otherwise the plot may be constant along the pile 

and equal to the axial displacement at each pile head. 

 

   

 

Figure 4.66  Sample graphics screen of Deflection x Dir vs. Distance command under the Graphs 
menu 
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4.5.27 Graphs – Axial Force vs. Distance 

 

 This option provides a plot of axial force along the pile versus distance from pile top of each 

individual pile in a 3-dimensional pile group. If the user select Include Axial Variation along Piles, the 

variation may be displayed along depth of the pile; otherwise the plot may be constant along the pile 

and equal to the axial force at each pile head. 

 

 

   

 

Figure 4.67  Sample graphics screen of Def. z, Mom. y, Shear z vs. Distance command under the 
Graphs menu 
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4.5.28 Graphs - Resultant Deflection vs. Distance 

 

 This option provides a plot of lateral pile resultant deflection versus distance from pile top of 

each individual pile in a 3-dimensional pile group. This is calculated for every depth as the square root of 

the summation of squares from the deflections in the y and z directions. 

 

   

Figure 4.68  Sample graphics screen of Resultant Deflection vs. Distance command under the Graphs 
menu 
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4.5.29 Graphs - Resultant Moment vs. Distance 

 

 This option provides a plot of resultant bending moment versus distance from pile top of each 

individual pile in a 3-dimensional pile group. This is calculated for every depth as the square root of the 

summation of squares from the moments along the y and z directions. 

 

  

Figure 4.69  Sample graphics screen of Resultant Moment vs. Distance command under the Graphs 
menu 
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4.5.30 Graphs - Resultant Shear vs. Distance 

 

 This option provides a plot of resultant shear versus distance from pile top of each individual 

pile in a 2-dimensional pile group. This is calculated for every depth as the square root of the summation 

of squares from the shear forces in the y and z directions. 

 

  

Figure 4.70  Sample graphics screen of Resultant Shear vs. Distance command under the Graphs 
menu 
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4.5.31 Graphs - Resultant Soil Reaction vs. Distance 

 

 This option provides a plot of resultant lateral soil resistance versus distance from pile top of 

each individual pile in a 3-dimensional pile group. This is calculated for every depth as the square root of 

the summation of squares from the soil reactions in the y and z directions. 

 

  

Figure 4.71  Sample graphics screen of Resultant Soil Reaction vs. Distance command under the 
Graphs menu 
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4.5.32 Graphs – Res. Def., Mom., Shear vs. Distance 

 

 This option provides a plot (in the same graph) of the resultant lateral deflection, resultant 

bending moment and resultant shear versus distance from pile top of each individual pile in a 3-

dimensional pile group.  

 

   

 

Figure 4.72  Sample graphics screen of Def. y, Mom. z, Shear y vs. Distance command under the 
Graphs menu 
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4.5.33 Graphs - Pile Cap Vertical Load vs.  Deflection 

 

 This option provides a plot of incremental vertical load versus vertical deflection at the pile cap.  

This option is available if Generate Data for Foundation Stiffness is specified in the input for the current 

load case.  This option is available for 2D models. 

 

 

Figure 4.73  Sample graphics screen of Pile Cap Vertical Load vs.  Deflection command under the 
Graphs menu 
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4.5.34 Graphs - Pile Cap Load vs.  Lateral Deflection 

 

 This option provides a plot of incremental lateral load versus lateral deflection at the pile cap.  

This option is available if Generate Data for Foundation Stiffness is specified in the input for the current 

load case.  This option is available for 2D models. 

 

 

 

Figure 4.74  Sample graphics screen of Pile Cap Load vs.  Lateral Deflection command under the 
Graphs menu 
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4.5.35 Graphs - Pile Cap Load vs.  Rotation 

 

 This option provides a plot of incremental lateral load versus rotation of the pile cap.  This 

option is available if Generate Data for Foundation Stiffness is specified in the input for the current load 

case.  This option is available for 2D models. 

 

 

 

Figure 4.75  Sample graphics screen of Pile Cap Load vs.  Rotation command under the Graphs menu 
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4.5.36 Graphs - Pile Cap Moment vs.  Deflection 

 

 This option provides a plot of incremental moment versus lateral deflection at the pile cap.  This 

option is available if Generate Data for Foundation Stiffness is specified in the input for the current load 

case.  This option is available for 2D models. 

 

 

Figure 4.76  Sample graphics screen of Pile Cap Moment vs.  Deflection command under the Graphs 
menu 
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4.5.37 Graphs - Pile Cap Moment vs.  Rotation 

 

 This option provides a plot of incremental moment load versus rotation of the pile cap.  This 

option is available if Generate Data for Foundation Stiffness is specified in the input for the current load 

case.  This option is available for 2D models. 

  

 

Figure 4.77  Sample graphics screen of Pile Cap Moment vs.  Rotation command under the Graphs 
menu 
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4.5.38 Graphs - Pile Cap Vertical Load vs.  Deflection X 

 

 This option provides a plot of incremental vertical load versus vertical deflection at the pile cap.  

This option is available if Generate Data for Foundation Stiffness is specified in the input for the current 

load case.  This option is available for 3D models. 

 

 

 

Figure 4.78  Sample graphics screen of Pile Cap Vertical Load vs.  Deflection X command under the 
Graphs menu 
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4.5.39 Graphs - Pile Cap Lateral Load vs.  Deflection Y 

 

 This option provides a plot of incremental lateral load versus lateral deflection in the Y-direction 

at the pile cap.  This option is available if Generate Data for Foundation Stiffness is specified in the input 

for the current load case.  This option is available for 3D models. 

 

 

 

Figure 4.79  Sample graphics screen of Pile Cap Lateral Load vs.  Deflection Y command under the 
Graphs menu 
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4.5.40 Graphs - Pile Cap Lateral Load vs.  Deflection Z 

 

 This option provides a plot of incremental lateral load versus lateral deflection in the Z-direction 

at the pile cap.  This option is available if Generate Data for Foundation Stiffness is specified in the input 

for the current load case.  This option is available for 3D models. 

 

 

 

Figure 4.80  Sample graphics screen of Pile Cap Lateral Load vs.  Deflection Z command under the 
Graphs menu 
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4.5.41 Graphs - Pile Cap Moment vs.  Rotation X 

 

 This option provides a plot of incremental moment versus rotation about the X-axis at the pile 

cap.  This option is available if Generate Data for Foundation Stiffness is specified in the input for the 

current load case.  This option is available for 3D models 

  

 

Figure 4.81  Sample graphics screen of Pile Cap Moment vs.  Rotation X command under the Graphs 
menu 
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4.5.42 Graphs - Pile Cap Moment vs.  Rotation Y 

 

 This option provides a plot of incremental moment versus rotation about the Y-axis at the pile 

cap.  This option is available if Generate Data for Foundation Stiffness is specified in the input for the 

current load case.  This option is available for 3D models 

 

  

 

Figure 4.82  Sample graphics screen of Pile Cap Moment vs.  Rotation Y command under the Graphs 
menu 
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4.5.43 Graphs - Pile Cap Moment vs.  Rotation Z 

 

 This option provides a plot of incremental moment versus rotation about the Z-axis at the pile 

cap.  This option is available if Generate Data for Foundation Stiffness is specified in the input for the 

current load case.  This option is available for 3D models 

 

  

 

Figure 4.83  Sample graphics screen of Pile Cap Moment vs.  Rotation Z command under the Graphs 
menu 
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4.5.44 Graphs - Pile Cap K11 vs.  Deflection X 

 

 This option provides a plot of stiffness coefficient K11(Kxx) versus vertical deflection (X-

direction) at the pile cap.  This option is available if Generate Data for Foundation Stiffness and 

Compute Foundation Stiffness are specified in the input for the current load case.  This option is 

available for 2D and 3D models 

 

 

Figure 4.84  Sample graphics screen of Pile Cap K11 vs.  Deflection X command under the Graphs 
menu 
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4.5.45 Graphs - Pile Cap K22 vs.  Deflection Y 

 

 This option provides a plot of stiffness coefficient K22(Kyy) versus lateral deflection in the Y-

direction at the pile cap.  This option is available if Generate Data for Foundation Stiffness and 

Compute Foundation Stiffness are specified in the input for the current load case.  This option is 

available for 2D and 3D models 

 

 

Figure 4.85  Sample graphics screen of Pile Cap K22 vs.  Deflection Y command under the Graphs 
menu 
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4.5.46 Graphs - Pile Cap K33 vs.  Rotation Z 

 

 This option provides a plot of stiffness coefficient K33(Krzrz) versus rotation along the Z-axis at 

the pile cap.  This option is available if Generate Data for Foundation Stiffness and Compute 

Foundation Stiffness are specified in the input for the current load case.  This option is available for 2D 

models. 

  

 

Figure 4.86  Sample graphics screen of Pile Cap K33 vs.  Rotation Z command under the Graphs 
menu 
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4.5.47 Graphs - Pile Cap K33 vs.  Deflection Z 

 

 This option provides a plot of stiffness coefficient K33(Kzz) versus lateral deflection in the Z-

direction at the pile cap.  This option is available if Generate Data for Foundation Stiffness and 

Compute Foundation Stiffness are specified in the input for the current load case.  This option is 

available for 3D models. 

 

 

Figure 4.87  Sample graphics screen of Pile Cap K33 vs.  Deflection Z command under the Graphs 
menu 
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4.5.48 Graphs - Pile Cap K44 vs.  Rotation X 

 

 This option provides a plot of stiffness coefficient K44(Krxrx) versus rotation along the X-axis at 

the pile cap.  This option is available if Generate Data for Foundation Stiffness and Compute 

Foundation Stiffness are specified in the input for the current load case.  This option is available for 3D 

models. 

  

 

Figure 4.88  Sample graphics screen of Pile Cap K44 vs.  Rotation X command under the Graphs 
menu 
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4.5.49 Graphs - Pile Cap K55 vs.  Rotation Y 

 

 This option provides a plot of stiffness coefficient K55(Kryry) versus rotation along the Y-axis at 

the pile cap.  This option is available if Generate Data for Foundation Stiffness and Compute 

Foundation Stiffness are specified in the input for the current load case.  This option is available for 3D 

models. 

  

 

Figure 4.89  Sample graphics screen of Pile Cap K55 vs.  Rotation Y command under the Graphs 
menu 
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4.5.50 Graphs - Pile Cap K66 vs.  Rotation Z 

 

 This option provides a plot of stiffness coefficient K66(Krzrz) versus rotation along the X-axis at 

the pile cap.  This option is available if Generate Data for Foundation Stiffness and Compute 

Foundation Stiffness are specified in the input for the current load case.  This option is available for 3D 

models. 

  

 

Figure 4.90  Sample graphics screen of Pile Cap K66 vs.  Rotation Z command under the Graphs 
menu 
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4.5.51 Graphs – Export Graphs to Excel 

 

 This option allows the user to export the graphs to an excel file. After selecting this option. The 

Export To Excel Window will appear. In that window, select the graphs desired to export and then click 

on the Generate Excel File button. Please note that the user needs to save the Excel file afterwards. 

 

 

  

 

Figure 4.91  Plot to Excel Window 
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4.5.52 Graphs – Moment Curvature 

 

 This option allows the user to display the moment curvature diagrams as well as other section EI 

diagrams. After selecting this option. The Plot EI Diagrams Window will appear. In that window, select 

the diagrams desired to displayed.  

 For non-symmetric sections the program will be able to show only the positive part of the curve, 

only the negative part or the whole range. 

  

 

 

Figure 4.92  Plot EI Diagrams Window 
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4.6 3D View Results Menu 
 

 The Show 3D View menu is available when the 3D View window is displayed.  It provides to the 

user different options for display of the model. 

 

   

Figure 4.93  Options contained in the 3D View Results Menu 

 
 

    

Figure 4.94  Options contained in the 3D View Results Menu – Flexible Cap Version 

 

 

Below there is a description of the menu items related to display of results.  All other items 

are described in the previous chapter. 
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4.6.1 Show 3D View -Deformed Shape 

 

 This option allows the user to display the deflected shape for the current load case or 

combination. 

 Check on Show Deformed Shape to display the deformed shape of the model.  Check on Show 

Undeformed Model to show the non-deformed model along with the deformed one.  Enter the 

Deformed Shape Factor to be used for drawing the deformed model or use the Up or Down buttons to 

increase or decrease the current one. 

 

 

 

Figure 4.95  Sample graphics screen for Deformed Shape command 
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4.6.2 Show 3D View -Contour Plot 

 

 This option allows the user to display a contour plot for the current load case or combination. 

 Check on Show Contour Plot to display the contour plot of the current type.  Select the desired 

type from the Contour Plot Type drop-down menu.  The program will assign maximum, minimum, 

division and increments by default.  Click on the Up and Down buttons of each value to increase or 

decrease it.  Check on Show Contour Legend to display the legend of the contour. 

 

 

 

 

Figure 4.96  Sample graphics screen for Contour Plot command 
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4.6.3 Show 3D View -Pile Diagrams 

 

 This option allows the user to display the diagrams along the piles for the current load case or 

combination. 

 Check on Show Pile Diagrams to display the diagrams along the piles of the current type.  Select 

the desired type from the Pile Diagrams Type drop-down menu. 

 

  

 

Figure 4.97  Sample graphics screen for Pile Diagrams command 
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4.6.4 Show 3D View -Pile Heads Response 

 

 This option allows the user to present graphically the results at the pile head level (pile cap) for 

the current load case or combination. 

 Check on Show Cap Response to display the cap response of the current type.  Select the 

desired type from the Type drop-down menu.  Choose between local axes and global axes.  Check on 

Show Bar Plot to display the response using bars normal to the pile cap.  Enter the length and width 

factor or click on the Up and Down buttons of each value to increase or decrease it.  Check on Show 

Values to display the numerical values.  Check on Only Maximums to display only maximum and 

minimum values.  Check on Show Pile Numbers to display pile numbers.   

 

 

 

Figure 4.98  Sample graphics screen for Pile Cap Response command 
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4.6.5 Show 3D View -Pile Top Effects 

 

 This option allows the user to display the numerical results at the pile cap and at the pile heads 

for the current load case or combination. 

 Enter the pile number, desired to get the numerical results, in the Pile Group entry field or click 

on the Up and Down buttons to increase or decrease the pile number (the pile will be highlighted in 

yellow).  Choose between local axes and global axes cap response. 

Check on Cap Results to display the displacements and applied forces at the pile cap (origin of 

coordinates). Also checking this option allows the user to display the values stiffness matrix and/or 

flexibility matrix for load cases that are estimated.  

  

 

Figure 4.99  Sample graphics screen for Pile Top Effects command 
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Check on  Show Axial Demand to plot the load-displacement cir ve for the current pile along the 

axial force demanded for the current load case or combination. Please note that the Axial Demand Plot 

is only available while displaying results in local ccordinates. 

  

 

Figure 4.100  Sample screen for Pile Top Results Window including Axial Demand Plot 

 



CHAPTER 4  References for Program Execution and Output Reviews     4-104 

 

GROUP 2022 for Windows User's Manual 
 

 

4.6.6 Show 3D View -Lateral Effects in Piles 

 

 This option allows the user to display the numerical results for lateral effects along the piles for 

the current load case or combination. 

 Enter the pile number, desired to get the numerical results, in the Pile Group entry field or click 

on the Up and Down buttons to increase or decrease the pile number (the pile will be highlighted in 

yellow).  Enter the pile node number, desired to get the numerical results, in the Pile Node entry field or 

drag the horizontal Bar, right or left, to increase or decrease the pile number. The pile node will be 

highlighted in red 

  

 

 

Figure 4.101  Sample graphics screen for Pile Top Effects command 
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4.6.7 Show 3D View -Flexible Cap Contour Plot - Flexible Cap Version 

 

 This option allows the user to display a contour plot of a selected variable for plate elements 

that belong to the flexible pile cap for the current load case or combination. 

 Check on Show Contour Plot to display the contour plot of the current type.  Select the desired 

variable type from the Variable Type options and select the desired type from the Contour Plot Type 

drop-down menu.  The program will assign maximum, minimum, division and increments by default.  

Click on the Up and Down buttons of each value to increase or decrease it.  Check on Show Contour 

Legend to display the legend of the contour. 

 

  

 

 

Figure 4.102  Sample graphics screen for Flexible Cap Contour Plot command – Flexible Cap Version 
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4.6.8 Show 3D View -Flexible Cap Section Cut - Flexible Cap Version 

 

 This option allows the user to display the distribution of a selected variable on plates elements 

that belong to the flexible pile cap through a given section cut for the current load case or combination. 

 Enter the coordinates for the Start Point and End Point that define the Section Cut. Select the 

desired variable type from the Variable Type options and select the desired variable from the Variable 

Type.  

 

   

 

 

Figure 4.103  Sample  graphics  screen  for  Flexible  Cap  Section  Cut  command – Flexible Cap 
Version 
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4.6.9 Show 3D View – Flexible Cap Beam Diagrams - Flexible Cap Version 

 

 This option allows the user to display the diagrams along the beams that belong to the flexible 

pile cap for the current load case or combination. 

 Check on Show Beam Diagrams to display the diagrams along the piles of the current type.  

Select the desired type from the Beam Diagrams Type drop-down menu. 

 

  

 

 

Figure 4.104  Sample graphics screen for Beam Diagrams command – Flexible Cap Version 
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4.6.10 Show 3D View -Flexible Cap Node Results - Flexible Cap Version 

 

 This option allows the user to display values of a selected variable at nodes on the flexible pile 

for the current load case or combination. 

 Enter the Node Number to inquire. Also, the node number can be picked-up graphically by 

clicking on the node after setting Select Nodes Mode. The inquired node will be displayed with yellow 

color. 

Select the desired variable type from the Variable Type options. 

 

  

 

 

Figure 4.105  Sample graphics screen for Flexible Cap Node Results – Flexible Cap Version 
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4.6.11 Show 3D View -Flexible Cap Plate Results - Flexible Cap Version 

 

 This option allows the user to display values of a selected variable at plates on the flexible pile 

for the current load case or combination. 

 Enter the plate Number to inquire. Also, the plate number can be picked-up graphically by 

clicking on the plate after setting Select Plates Mode. The average value for the whole element will be 

displayed by default, but the user can select the values for any integration point. The inquired plate will 

be displayed with light blue color and the integration point will be displayed as dark gray.  

 Select the desired variable type from the Variable Type options. 

 

   

 

 

Figure 4.106  Sample graphics screen for Flexible Cap Plate Results – Flexible Cap Version 
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4.6.12 Show 3D View -Flexible Cap Beam Results - Flexible Cap Version 

 

 This option allows the user to display values of a selected variable at beams on the flexible pile 

for the current load case or combination. 

 Enter the beam Number to inquire. Also, the beam number can be picked-up graphically by 

clicking on the plate after setting Select Beams Mode. The average value for the whole element will be 

displayed by default, but the user can select the values for a point (from a 9 points available) along the 

length of the beam. The inquired beam will be displayed with yellow color and the point will be 

displayed as balck.  

 Select the desired variable type from the Variable Type options. 

 Check the Plot Variable Along Length to display a xy plot of any variable along length, then 

select the variable as desired.. 

 

   

 

 

Figure 4.107  Sample graphics screen for Flexible Cap Beam Results – Flexible Cap Version 
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